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Notice
While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.
Documentation disclaimer
“Documentation” means information published in varying mediums
which may include product information, operating instructions and
performance specifications that are generally made available to users
of products. Documentation does not include marketing materials.
Avaya shall not be responsible for any modifications, additions, or
deletions to the original published version of Documentation unless
such modifications, additions, or deletions were performed by or on
the express behalf of Avaya. End User agrees to indemnify and hold
harmless Avaya, Avaya's agents, servants and employees against all
claims, lawsuits, demands and judgments arising out of, or in
connection with, subsequent modifications, additions or deletions to
this documentation, to the extent made by End User.
Link disclaimer
Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or Documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.
Warranty
Avaya provides a limited warranty on Avaya hardware and software.
Refer to your sales agreement to establish the terms of the limited
warranty. In addition, Avaya’s standard warranty language, as well as
information regarding support for this product while under warranty is
available to Avaya customers and other parties through the Avaya
Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailId=C20091120112456651010 under the link
“Warranty & Product Lifecycle” or such successor site as designated
by Avaya. Please note that if You acquired the product(s) from an
authorized Avaya Channel Partner outside of the United States and
Canada, the warranty is provided to You by said Avaya Channel
Partner and not by Avaya.
“Hosted Service” means an Avaya hosted service subscription that
You acquire from either Avaya or an authorized Avaya Channel
Partner (as applicable) and which is described further in Hosted SAS
or other service description documentation regarding the applicable
hosted service. If You purchase a Hosted Service subscription, the
foregoing limited warranty may not apply but You may be entitled to
support services in connection with the Hosted Service as described
further in your service description documents for the applicable
Hosted Service. Contact Avaya or Avaya Channel Partner (as
applicable) for more information.
Hosted Service
THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN AVAYA
HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE), THE TERMS OF USE
FOR HOSTED SERVICES ARE AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO UNDER
THE LINK “Avaya Terms of Use for Hosted Services” OR SUCH
SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND ARE
APPLICABLE TO ANYONE WHO ACCESSES OR USES THE
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. IF
YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE
TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, OR IF

YOU DO NOT WISH TO ACCEPT THESE TERMS OF USE, YOU
MUST NOT ACCESS OR USE THE HOSTED SERVICE OR
AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED
SERVICE.
Licenses
THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO,
UNDER THE LINK “AVAYA SOFTWARE LICENSE TERMS (Avaya
Products)” OR SUCH SUCCESSOR SITE AS DESIGNATED BY
AVAYA, ARE APPLICABLE TO ANYONE WHO DOWNLOADS,
USES AND/OR INSTALLS AVAYA SOFTWARE, PURCHASED
FROM AVAYA INC., ANY AVAYA AFFILIATE, OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE) UNDER A COMMERCIAL
AGREEMENT WITH AVAYA OR AN AVAYA CHANNEL PARTNER.
UNLESS OTHERWISE AGREED TO BY AVAYA IN WRITING,
AVAYA DOES NOT EXTEND THIS LICENSE IF THE SOFTWARE
WAS OBTAINED FROM ANYONE OTHER THAN AVAYA, AN AVAYA
AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA
RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU
AND ANYONE ELSE USING OR SELLING THE SOFTWARE
WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR
USING THE SOFTWARE, OR AUTHORIZING OTHERS TO DO SO,
YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM
YOU ARE INSTALLING, DOWNLOADING OR USING THE
SOFTWARE (HEREINAFTER REFERRED TO
INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO
THESE TERMS AND CONDITIONS AND CREATE A BINDING
CONTRACT BETWEEN YOU AND AVAYA INC. OR THE
APPLICABLE AVAYA AFFILIATE (“AVAYA”).
Avaya grants You a license within the scope of the license types
described below, with the exception of Heritage Nortel Software, for
which the scope of the license is detailed below. Where the order
documentation does not expressly identify a license type, the
applicable license will be a Designated System License as set forth
below in the Designated System(s) License (DS) section as
applicable. The applicable number of licenses and units of capacity
for which the license is granted will be one (1), unless a different
number of licenses or units of capacity is specified in the
documentation or other materials available to You. “Software” means
computer programs in object code, provided by Avaya or an Avaya
Channel Partner, whether as stand-alone products, pre-installed on
hardware products, and any upgrades, updates, patches, bug fixes,
or modified versions thereto. “Designated Processor” means a single
stand-alone computing device. “Server” means a set of Designated
Processors that hosts (physically or virtually) a software application
to be accessed by multiple users. “Instance” means a single copy of
the Software executing at a particular time: (i) on one physical
machine; or (ii) on one deployed software virtual machine (“VM”) or
similar deployment.
License type(s)
Concurrent User License (CU). End User may install and use the
Software on multiple Designated Processors or one or more Servers,
so long as only the licensed number of Units are accessing and using
the Software at any given time. A “Unit” means the unit on which
Avaya, at its sole discretion, bases the pricing of its licenses and can
be, without limitation, an agent, port or user, an e-mail or voice mail
account in the name of a person or corporate function (e.g.,
webmaster or helpdesk), or a directory entry in the administrative
database utilized by the Software that permits one user to interface
with the Software. Units may be linked to a specific, identified Server
or an Instance of the Software.
Heritage Nortel Software
“Heritage Nortel Software” means the software that was acquired by
Avaya as part of its purchase of the Nortel Enterprise Solutions
Business in December 2009. The Heritage Nortel Software is the
software contained within the list of Heritage Nortel Products located
at https://support.avaya.com/LicenseInfo under the link “Heritage
Nortel Products” or such successor site as designated by Avaya. For
Heritage Nortel Software, Avaya grants Customer a license to use
Heritage Nortel Software provided hereunder solely to the extent of
the authorized activation or authorized usage level, solely for the
purpose specified in the Documentation, and solely as embedded in,
for execution on, or for communication with Avaya equipment.
Charges for Heritage Nortel Software may be based on extent of
activation or use authorized as specified in an order or invoice.

https://support.avaya.com/helpcenter/getGenericDetails?detailId=C20091120112456651010
https://support.avaya.com/helpcenter/getGenericDetails?detailId=C20091120112456651010
https://support.avaya.com/LicenseInfo
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Copyright
Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, Hosted Service,
or hardware provided by Avaya. All content on this site, the
documentation, Hosted Service, and the product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software
unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.
Virtualization
The following applies if the product is deployed on a virtual machine.
Each product has its own ordering code and license types. Note,
unless otherwise stated, that each Instance of a product must be
separately licensed and ordered. For example, if the end user
customer or Avaya Channel Partner would like to install two
Instances of the same type of products, then two products of that
type must be ordered.
Third Party Components
“Third Party Components” mean certain software programs or
portions thereof included in the Software or Hosted Service may
contain software (including open source software) distributed under
third party agreements (“Third Party Components”), which contain
terms regarding the rights to use certain portions of the Software
(“Third Party Terms”). As required, information regarding distributed
Linux OS source code (for those products that have distributed Linux
OS source code) and identifying the copyright holders of the Third
Party Components and the Third Party Terms that apply is available
in the products, Documentation or on Avaya’s website at: https://
support.avaya.com/Copyright or such successor site as designated
by Avaya. The open source software license terms provided as Third
Party Terms are consistent with the license rights granted in these
Software License Terms, and may contain additional rights benefiting
You, such as modification and distribution of the open source
software. The Third Party Terms shall take precedence over these
Software License Terms, solely with respect to the applicable Third
Party Components to the extent that these Software License Terms
impose greater restrictions on You than the applicable Third Party
Terms.
The following applies only if the H.264 (AVC) codec is distributed with
the product. THIS PRODUCT IS LICENSED UNDER THE AVC
PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS
GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA,
L.L.C. SEE HTTP://WWW.MPEGLA.COM.
Service Provider
THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS OR SERVICES. THE PRODUCT
OR HOSTED SERVICE MAY USE THIRD PARTY COMPONENTS
SUBJECT TO THIRD PARTY TERMS AND REQUIRE A SERVICE
PROVIDER TO BE INDEPENDENTLY LICENSED DIRECTLY FROM
THE THIRD PARTY SUPPLIER. AN AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS MUST BE AUTHORIZED IN
WRITING BY AVAYA AND IF THOSE HOSTED PRODUCTS USE
OR EMBED CERTAIN THIRD PARTY SOFTWARE, INCLUDING
BUT NOT LIMITED TO MICROSOFT SOFTWARE OR CODECS,
THE AVAYA CHANNEL PARTNER IS REQUIRED TO
INDEPENDENTLY OBTAIN ANY APPLICABLE LICENSE
AGREEMENTS, AT THE AVAYA CHANNEL PARTNER’S EXPENSE,
DIRECTLY FROM THE APPLICABLE THIRD PARTY SUPPLIER.
WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR EMBED
THE G.729 CODEC, H.264 CODEC, OR H.265 CODEC, THE

AVAYA CHANNEL PARTNER ACKNOWLEDGES AND AGREES
THE AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR ANY
AND ALL RELATED FEES AND/OR ROYALTIES. THE G.729
CODEC IS LICENSED BY SIPRO LAB TELECOM INC. SEE 
WWW.SIPRO.COM/CONTACT.HTML. THE H.264 (AVC) CODEC IS
LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR
THE PERSONAL USE OF A CONSUMER OR OTHER USES IN
WHICH IT DOES NOT RECEIVE REMUNERATION TO: (I) ENCODE
VIDEO IN COMPLIANCE WITH THE AVC STANDARD (“AVC
VIDEO”) AND/OR (II) DECODE AVC VIDEO THAT WAS ENCODED
BY A CONSUMER ENGAGED IN A PERSONAL ACTIVITY AND/OR
WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO
PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE
IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION
FOR H.264 (AVC) AND H.265 (HEVC) CODECS MAY BE
OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.
Compliance with Laws
You acknowledge and agree that it is Your responsibility for
complying with any applicable laws and regulations, including, but not
limited to laws and regulations related to call recording, data privacy,
intellectual property, trade secret, fraud, and music performance
rights, in the country or territory where the Avaya product is used.
Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.
Avaya Toll Fraud intervention
If You suspect that You are being victimized by Toll Fraud and You
need technical assistance or support, call Technical Service Center
Toll Fraud Intervention Hotline at +1-800-643-2353 for the United
States and Canada. For additional support telephone numbers, see
the Avaya Support website: https://support.avaya.com or such
successor site as designated by Avaya.
Security Vulnerabilities
Information about Avaya’s security support policies can be found in
the Security Policies and Support section of https://
support.avaya.com/security.
Suspected Avaya product security vulnerabilities are handled per the
Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).
Downloading Documentation
For the most current versions of Documentation, see the Avaya
Support website: https://support.avaya.com, or such successor site
as designated by Avaya.
Contact Avaya Support
See the Avaya Support website: https://support.avaya.com for
product or Hosted Service notices and articles, or to report a problem
with your Avaya product or Hosted Service. For a list of support
telephone numbers and contact addresses, go to the Avaya Support
website: https://support.avaya.com (or such successor site as
designated by Avaya), scroll to the bottom of the page, and select
Contact Avaya Support.
Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
affiliates, its licensors, its suppliers, or other third parties. Users are
not permitted to use such Marks without prior written consent from
Avaya or such third party which may own the Mark. Nothing
contained in this site, the Documentation, Hosted Service(s) and
product(s) should be construed as granting, by implication, estoppel,
or otherwise, any license or right in and to the Marks without the
express written permission of Avaya or the applicable third party.
Avaya is a registered trademark of Avaya Inc.

https://support.avaya.com/Copyright
https://support.avaya.com/Copyright
HTTP://WWW.MPEGLA.COM
http://www.sipro.com/contact.html
HTTP://WWW.MPEGLA.COM
HTTP://WWW.MPEGLA.COM
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Chapter 1: Introduction

This document describes how to install and un-install server software for Avaya Aura® Contact
Center Release 7.0 in an Avaya Communication Server 1000 AML-based solution.

Purpose
This document describes how to prepare a server and install Avaya Aura® Contact Center
software.

Intended audience
This document is intended for people who install Avaya Aura® Contact Center software.

Related resources

Avaya Aura® Contact Center Documentation
The following table lists the documents related to Avaya Aura® Contact Center. Download the
documents from the Avaya Support website at https://support.avaya.com.

Title Use this document to: Audience
Overview
Avaya Aura® Contact Center
Overview and Specification

This document contains technical
details you need to set up your
Contact Center suite. The document
contains the background information
you need to plan and engineer your
system (server preparation

Customers and sales,
services, and support
personnel

Table continues…
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Title Use this document to: Audience
information, routing options, licensing
configurations, and hardware
configuration). The document also
contains background information you
require to install all software
components that are part of and work
with Contact Center. General
information about considerations for
upgrading your existing suite of
Contact Center is also included. This
document contains strategies and
requirements to plan your network
configuration and prepare your servers
for Contact Center software
installations.

Avaya Aura® Contact Center and
Avaya Aura® Unified
Communications Solution
Description

This document describes the solution
architecture, suggested topologies,
and capacities for the Avaya Aura®

Unified Communications platform. This
document also describes the features
and functional limitations of certain
configurations.

Customers and sales,
services, and support
personnel

Avaya Aura® Contact Center and
Avaya Communication Server 1000
Solution Description

This document describes the solution
architecture, suggested topologies,
and capacities for the Avaya
Communication Server 1000 platform.
This document also describes the
features and functional limitations of
certain configurations.

Customers and sales,
services, and support
personnel

Avaya Aura® Contact Center
Documentation Catalog

This document describes available
Avaya Aura® Contact Center
documentation resources and
indicates the type of information in
each document.

Customers and sales,
services, and support
personnel

Avaya Aura® Contact Center
Terminology

This document contains definitions for
the technical terms specific to Contact
Center.

Customers and sales,
services, and support
personnel

Contact Center Performance
Management Data Dictionary

This document contains reference
tables that describe the statistics and
data in the historical and real-time
reports generated in Contact Center.

System administrators
and contact center
supervisors

Implementing
Avaya Aura® Contact Center and
Avaya Aura® Unified
Communications Integration

This document contains information
and procedures to integrate the Avaya
Aura® Unified Communications
platform with Contact Center.

Implementation personnel

Table continues…

Related resources
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Title Use this document to: Audience
Avaya Aura® Contact Center and
Avaya Communication Server 1000
Integration

This document contains information
and procedures to integrate the Avaya
Communication Server 1000 platform
with Contact Center.

Implementation personnel

Deploying Avaya Aura® Contact
Center DVD for Avaya Aura® Unified
Communications

This document contains information
about Contact Center DVD installation,
initial configuration, and verification for
the Avaya Aura® Unified
Communications platform.

Implementation personnel

Deploying Avaya Aura® Contact
Center DVD for Avaya
Communication Server 1000

This document contains information
about Contact Center DVD installation,
initial configuration, and verification for
the Avaya Communication Server
1000 platform.

Implementation personnel

Deploying Avaya Aura® Contact
Center Software Appliance for
Avaya Aura® Unified
Communications

This document describes how to
deploy the Avaya Aura® Contact
Center Software Appliance for the
Avaya Aura® Unified Communications
platform.

Implementation personnel

Avaya Aura® Contact Center
Commissioning for Avaya Aura®

Unified Communications

This document contains information for
Contact Center preparation, process,
initial configuration, and verification of
the installation on the Avaya Aura®

Unified Communications platform.

Implementation personnel

Avaya Aura® Contact Center
Commissioning for Avaya
Communication Server 1000

This document contains information for
Contact Center preparation, process,
initial configuration, and verification of
the installation on the Avaya
Communication Server 1000 platform.

Implementation personnel

Avaya Aura® Contact Center and
Proactive Outreach Manager
Integration

This document provides conceptual
and procedural information on the
integration between Avaya Aura®

Contact Center (AACC) and Avaya
Proactive Outreach Manager (POM); it
describes the tasks required for AACC
and POM integration.

Implementation personnel

Upgrading and patching Avaya
Aura® Contact Center

This document contains information
and procedures to upgrade from
previous releases to Contact Center,
migrating the databases, and
information and procedures to
download and install service packs.

Implementation personnel
and system administrators

Administering
Avaya Aura® Contact Center Server
Administration

This document contains information
and procedures for day-today

System administrators

Table continues…

Introduction
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Title Use this document to: Audience
maintenance of all servers in the
Contact Center suite, including server
maintenance tasks, administrative
tasks, managing data, configuring data
routing, performing archives, and
backing up data. It also describes the
optional configuration procedures for
server configuration.

Avaya Aura® Contact Center Client
Administration

This document contains information
and procedures to configure the users
and user access, skillsets, server
management, and configuration data
in the Contact Center database.

System administrators
and contact center
supervisors

Using Contact Center Orchestration
Designer

This document contains information
and procedures to configure script and
flow applications in Contact Center
Orchestration Designer.

System administrators

Maintaining
Maintaining Avaya Aura® Contact
Center

This document contains routine
maintenance procedures such as
installing service packs, and
maintaining the databases for the
Contact Center system.

System administrators
and support personnel

Troubleshooting Avaya Aura®

Contact Center
This document contains system-wide
troubleshooting information and
procedures for Contact Center
hardware, software, and network.

System administrators
and support personnel

Contact Center Event Codes This document contains a list of errors
in the Contact Center suite and
recommendations to resolve them.

This document is a Microsoft Excel
spreadsheet.

System administrators
and support personnel

Using
Using Avaya Aura® Contact Center
Reports and Displays

This document contains procedures to
generate performance reports, and to
monitor and analyze performance data
and performance measurements.

System administrators
and contact center
supervisors

Using Agent Desktop for Avaya
Aura® Contact Center

This document provides information
and procedures for agents who use
the Agent Desktop application to
accept, manage, and close contacts of
all media types in Contact Center.

Contact center agents
and supervisors

Using the Contact Center Agent
Browser application

This document provides information
and procedures for agents who use

Contact center agents

Table continues…

Related resources
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Title Use this document to: Audience
the Agent Browser application to log
on to Contact Center and perform
basic tasks.

Finding documents on the Avaya Support website
Procedure

1. Navigate to http://support.avaya.com/.

2. At the top of the screen, type your username and password and click Login.

3. Click Support by Product > Documents.

4. In Enter your Product Here, type the product name and then select the product from the
list.

5. In Choose Release, select an appropriate release number.

6. In the Content Type filter, click a document type, or click Select All to see a list of all
available documents.

For example, for user guides, click User Guides in the Content Type filter. The list
displays the documents only from the selected category.

7. Click Enter.

Viewing Avaya Mentor videos
Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot
Avaya products.

About this task
Videos are available on the Avaya Support website, listed under the video document type, and on
the Avaya-run channel on YouTube.

Procedure
• To find videos on the Avaya Support website, go to http://support.avaya.com and perform one

of the following actions:

- In Search, type Avaya Mentor Videos to see a list of the available videos.
- In Search, type the product name. On the Search Results page, select Video in the

Content Type column on the left.
• To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and

perform one of the following actions:

- Enter a key word or key words in the Search Channel to search for a specific product or
topic.

- Scroll down Playlists, and click the name of a topic to see the available list of videos
posted on the website.

Introduction
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Note:

Videos are not available for all products.

Support
Go to the Avaya Support website at http://support.avaya.com for the most up-to-date
documentation, product notices, and knowledge articles. You can also search for release notes,
downloads, and resolutions to issues. Use the online service request system to create a service
request. Chat with live agents to get answers to questions, or request an agent to connect you to a
support team if an issue requires additional expertise.

Support
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Chapter 2: Changes in this release

The following sections describe the new features and changes in Avaya Aura® Contact Center
Release 7.0.

Features
See the following sections for information about feature changes.

New features in the Release 7.0 base build
See the following sections for information about new features in the Release 7.0 base build:

• Avaya Aura Contact Center® Ignition Wizard on page 18
• Avaya Aura Contact Center® supports Microsoft Windows Server 2012 R2 on page 19
• Contact Center Manager Administration support for Caché database on page 19

New features in Release 7.0 Feature Pack 2
See the following sections for information about new features added by Feature Pack 2:

• Removal of default security configuration on page 19

Avaya Aura® Contact Center Ignition Wizard
Avaya Aura® Contact Center Release 7.0 introduces a configuration utility called the Ignition
Wizard. After you install Avaya Aura® Contact Center software, you use the Ignition Wizard to
configure the initial networking, locale, administration, and licensing solution details.

If you know the contact center solution details, you can run the Ignition Wizard directly after
installing the Avaya Aura® Contact Center software. Alternatively, you can install the Avaya Aura®

Contact Center software and then defer running the Ignition Wizard until you know the solution
details. This gives you the flexibility to install the server software and then, at a later date or
different location, configure the solution details.

You must use the Ignition Wizard to initialize Avaya Aura® Contact Center, otherwise Avaya Aura®

Contact Center is not operational.
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Avaya Aura® Contact Center supports Microsoft Windows Server
2012 R2

Avaya Aura® Contact Center Release 7.0 is supported on the Microsoft Windows Server 2012 R2
operating system. Avaya Aura® Contact Center Release 7.0 is not supported on Microsoft
Windows Server 2008 R2. Customers upgrading to Avaya Aura® Contact Center Release 7.0,
must migrate to a new Microsoft Windows Server 2012 R2 server.

Contact Center Manager Administration support for Caché
database

In Contact Center Release 7.0, Contact Center Manager Administration (CCMA) stores
information in a Caché database. Contact Center Release 7.0 stores agent, user, statistical,
scheduling, and reporting information in Caché databases. This simplifies Contact Center data
management, migration, and maintenance. This also simplifies the resiliency configuration
processes.

In Contact Center Release 7.0, Contact Center Manager Administration (CCMA) does not store
information using Active Directory Lightweight Directory Services (AD-LDS) or Microsoft Access
databases.

Removal of default security configuration
From Release 7.0 Feature Pack 2, for new installations Contact Center no longer provides a
default security store and default security certificates. At the installation stage, you can now use
the Ignition Wizard to create a security store, generate a Certificate Signing Request (CSR) and
import a Certificate Authority root certificate. Alternatively, you can choose to skip security
configuration at the installation stage and configure your security certificates later in the
commissioning process using Security Manager.

Other changes
See the following sections for information about changes that are not feature-related:

Other changes in the Release 7.0 base build
See the following sections for information about changes that are not feature-related in the
Release 7.0 base build:

• Knowledge Worker server type no longer supported on page 20
• Microsoft Windows Server 2008 is no longer supported on page 21

Other changes
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• New Avaya Aura Contact Center minimum hardware specifications on page 21
• New Avaya Aura Contact Center minimum virtual machine specifications on page 21

Other changes in Release 7.0 Feature Pack 2
See the following sections for information about changes that are not feature-related in Release
7.0 Feature Pack 2:

• Installation account for Contact Center install on page 20

Other changes in Release 7.0 Feature Pack 3
See the following sections for information about changes that are not feature-related in Release
7.0 Feature Pack 3:

• Contact Center backwards compatibility with previous version of Agent Desktop on page 20

Contact Center backwards compatibility with previous version of
Agent Desktop

From Release 7.0 Feature Pack 3, Contact Center supports backwards compatibility with the
previous Feature Pack or Service Pack version of Agent Desktop. This allows you to upgrade the
Contact Center server without the requirement to upgrade Agent Desktop in a single maintenance
window. For example, if you upgrade to Release 7.0 Feature Pack 3, you can use the Release 7.0
Feature Pack 2 version of Agent Desktop.

New Agent Desktop features added in the latest Contact Center release are not available until you
upgrade Agent Desktop to that release.

Backwards compatibility is not supported for major or minor releases. For example, if you upgrade
to Release 7.1, you cannot use the Release 7.0 version of Agent Desktop.

Installation account for Contact Center install
From Release 7.0 Feature Pack 2, you can use any account with local administrative rights to
install Contact Center, provided that you disable the Admin Approval Mode security feature on the
Contact Center server. You can also use any account with local administrative rights to upgrade
and patch Contact Center; you do not need to always use the same administrative account to
perform these tasks.

Knowledge Worker server type no longer supported
Avaya Aura® Contact Center Release 7.0 does not support the Knowledge Worker server type.
Customers with an existing Knowledge Worker solution can migrate to an Avaya Aura® Contact
Center Release 7.0 Voice and Multimedia Contact Server or a Voice Contact Server.

Changes in this release
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Microsoft Windows Server 2008 is no longer supported
Avaya Aura® Contact Center Release 7.0 is supported only on Microsoft Windows Server 2012
R2. Avaya Aura® Contact Center Release 7.0 is not supported on Microsoft Windows Server 2008
R2. Customers upgrading to Avaya Aura® Contact Center Release 7.0 must migrate to a new
Microsoft Windows Server 2012 R2 server.

New Avaya Aura® Contact Center minimum hardware
specifications

Avaya Aura® Contact Center Release 7.0 continues to support Platform Vendor Independence
(PVI) for physical server hardware deployments. Avaya Aura® Contact Center Release 7.0 defines
three new minimum levels of hardware specification; a new Entry-level, a new Mid-range, and a
new High-end server hardware specification. For Avaya Aura® Contact Center Release 7.0
installations on physical servers, only the new PVI server hardware specifications are supported.

New Avaya Aura® Contact Center minimum virtual machine
specifications

Avaya Aura® Contact Center Release 7.0 continues to support VMware and virtualization. Avaya
Aura® Contact Center Release 7.0 defines three new minimum levels of virtual machine
specification; a new Entry-level, a new Mid-range, and a new High-end virtual machine
specification. For virtualized Avaya Aura® Contact Center Release 7.0 installations on virtual
machines, only the new virtual machine specifications are supported.

Other changes
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Chapter 3: Overview

Avaya Aura® Contact Center supports a range of server types for Avaya Communication Server
1000 AML-based solutions. Each server type installs a combination of Avaya Aura® Contact Center
applications suitable for a specific contact center function. Some Contact Center servers support
only voice contacts, some Contact Center servers support only multimedia contacts, and some
Contact Center servers support both voice and multimedia.

The Contact Center solution can include one or more servers. The installation configuration you
choose depends on the hardware resources and performance demands of your contact center. To
implement the Avaya Aura® Contact Center High Availability feature, your solution requires
additional standby servers to provide resiliency and redundancy.

You can install the following Contact Center server types:

Voice and Multimedia Contact Server — Install this server to provide context sensitive and skill-
based routing for customer voice and multimedia contacts. This server provides routed contact
support for email messages, web communications, voice mail messages, scanned documents, fax
messages, and SMS text messages. A Voice and Multimedia Contact Server has the following
software components:

• Contact Center Manager Server (CCMS)

• Contact Center License Manager (LM)

• Contact Center Manager Server Utility (SU)

• Contact Center Manager Administration (CCMA)

• Communication Control Toolkit (CCT)

• Contact Center Multimedia (CCMM)

In a small to medium solution using a Voice and Multimedia Contact Server, agents download and
install Agent Desktop software from the Voice and Multimedia Contact Server.

Voice Contact Server Only — Install this server to provide context sensitive and skill-based routing
for customer voice contacts in a large contact center solution. A Voice Contact Server has the
following software components:

• Contact Center Manager Server

• Contact Center License Manager

• Contact Center Manager Server Utility

• Contact Center Manager Administration
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• Communication Control Toolkit

In a solution where agents use Agent Desktop to log on and handle customer calls, each Voice
Contact Server requires one Multimedia Contact Server. In an Avaya Communication Server 1000
AML-based voice-only solution, where agents use Agent Desktop to log on and handle customer
calls, each Voice Contact Server requires one Multimedia Contact Server. In an Avaya
Communication Server 1000 AML-based voice-only solution, where agents use their desk phones to
log on and handle customer calls, and where the agents do not use Agent Desktop, a Multimedia
Contact Server is not required.

Multimedia Contact Server Only — Install this server to increase the number of contact center
agents in your enterprise solution. When installed, this server provides the multimedia contact
processing capabilities and the Voice Contact Server processes only voice contacts. In a solution
using a Multimedia Contact Server, agents download and install Agent Desktop software from the
Multimedia Contact Server. Administrators configure Agent Desktop features and functions using the
CCMM Administration utility installed on the Multimedia Contact Server.

A Multimedia Contact Server has the following software components:

• Contact Center Multimedia

Network Control Center Server Only — Install this server to add networking, network skill-based
routing, and consolidated reporting support for a number of Voice and Multimedia Contact Servers
operating as a single distributed contact center. Use this server to configure contact routing between
the Voice and Multimedia Contact Server nodes of a distributed contact center solution. A Network
Control Center Server has the following software components:

• Contact Center Manager Server — Network Control Center

• Contact Center Manager Administration

• Contact Center License Manager

Server Operating Systems
The workflows in this book include installing the server Operating Systems (OS) required by Avaya
Aura® Contact Center software applications. You must complete a fresh install of the OS for each
Contact Center installation. Do not install Contact Center applications on an existing OS from which
you uninstalled either Contact Center or other software applications.

Platform Vendor Independence checking utility
You can purchase your choice of server hardware as long as it complies with the Platform Vendor
Independence (PVI) specification for Avaya Aura® Contact Center software. You have the flexibility
to purchase a hardware specification that conforms to your corporate standard. For more
information about the Avaya Aura® Contact Center PVI server specifications, see Avaya Aura®

Contact Center Overview and Specification.

The Platform Vendor Independence utility is included in the Contact Center product installation
DVD. The utility runs automatically before the software is installed to verify the system.

Platform Vendor Independence checking utility
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Free open source software licensing
Avaya Aura® Contact Center contains a number of open source software packages, which are
embedded and delivered as part of the installation.

For details of the suppliers of these packages and the associated public licenses, see the Third
Party terms for Avaya Aura® Contact Center in the Policies & Legal, License Terms section on 
http://support.avaya.com.

Prerequisites for Contact Center installation
Procedure

• Ensure all your server hardware meets the requirements described in Avaya Aura® Contact
Center Overview and Specification.

• Know the installation configuration you plan to use in your contact center. For more
information see Avaya Aura® Contact Center Overview and Specification.

• Ensure that your PABX is configured. For more information about configuring the PABX, see
Avaya Aura® Contact Center and Avaya Communication Server 1000 Integration.

• If you want to enable security on the Contact Center server, and complete security
configuration when installing Contact Center software, you must ensure that a shared
network location exists on the Contact Center server before running the Contact Center
Ignition Wizard.

Overview
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Chapter 4: Deployment process

Install Avaya Aura® Contact Center for an Avaya Communication Server 1000 AML-based contact
center solution.

For more information, see the following:

• Installation checklist on page 27

• Voice and Multimedia Contact Server for CS1000 installation on page 32

• Primary Voice and Multimedia Contact Server for CS1000 software installation in a domain on
page 61

• Standby Voice and Multimedia Contact Server for CS1000 software installation in a domain on
page 89

• RGN Voice and Multimedia Contact Server for CS1000 installation in a domain on page 112

• Voice Contact Server for CS1000 installation on page 135

• Primary Voice Contact Server for CS1000 installation in a domain on page 162

• Standby Voice Contact Server for CS1000 installation in a domain on page 190

• RGN Voice Contact Server for CS1000 installation in a domain on page 213

• Multimedia Contact Server software installation on page 237

The following additional and optional server type is also supported in Avaya Communication Server
1000 AML-based contact center solutions:

• Network Control Center Server software installation on page 265

This work flow shows the sequence of tasks you perform to install one or more Contact Center
servers in an AML-based Avaya Communication Server 1000 contact center solution.
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Figure 1: Contact Center installation for Avaya Communication Server 1000 based solutions

Deployment process
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Chapter 5: Installation checklist

The following checklists describe the main Avaya Aura® Contact Center configuration and
deployment details. You must know these configuration details before you can deploy and
commission an Avaya Aura® Contact Center solution.

Complete these checklists before continuing.

Avaya Communication Server 1000 configuration checklist
Before you install Avaya Aura® Contact Center, complete the following Avaya Communication
Server 1000 checklist.

Task Description Notes

Avaya Communication
Server 1000 Release

Note the version of Avaya
Communication Server 1000
you are using in your solution.

Avaya Aura® Contact Center
supports Avaya
Communication Server 1000
7.6.

Avaya Communication
Server 1000 name

Note the name of your Avaya
Communication Server 1000.

Avaya Communication
Server 1000 CLAN IP
address

Note the CLAN IP address of
your Avaya Communication
Server 1000.

Avaya Communication
Server 1000 ELAN IP
address

Note the ELAN IP address of
your Avaya Communication
Server 1000.

Avaya Communication
Server 1000 serial number

Note the serial number of
your Avaya Communication
Server 1000.

Avaya Communication
Server 1000 user ID

The user ID that you use to
log on to the Avaya
Communication Server 1000
PABX administration terminal.

Avaya Communication
Server 1000 password

The password that you use to
log on to the Avaya

Table continues…
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Task Description Notes

Communication Server 1000
PABX administration terminal.

Avaya Communication
Server 1000 packages and
patches

Ensure that you have applied
the required packages and
patches on your Avaya
Communication Server 1000.

Some Contact Center
features are supported only
when you apply certain
Avaya Communication
Server 1000 packages and
patches. For more
information, see Avaya Aura®

Contact Center and Avaya
Communication Server 1000
Integration.

ACD numbers or range Note the ACD numbers, or
range of ACD numbers,
defined on the Avaya
Communication Server 1000
platform.

CDN numbers or range Note the CDN numbers, or
range of CDN numbers,
defined on the Avaya
Communication Server 1000
platform.

Home Location Code
(HLOC)

Note the HLOC configured on
the Avaya Communication
Server 1000 platform.

HLOC valid values: 0–3999.

Agent phone type Note the phone types used by
your Contact Center agents.

DN AST keys defined To enable CTI call control for
each agent phone, configure
Associate Set Assignment
(AST) on the SCR and ACD
keys, and then set IAPG
(ISDN/AP status message
group) for that phone.

Avaya Aura® Contact Center installation checklist
The following tables list and describe the configuration details required by Avaya Aura® Contact
Center.

The following table lists the main Microsoft Windows Server 2012 R2 configuration questions.
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Configuration Item Your value Description
Server hostname The host name of the Avaya Aura® Contact Center

server.

Server names must adhere to RFC1123. For more
information, see Avaya Aura® Contact Center
Overview and Specification.

Avaya recommends that you configure the server
final production name when installing Avaya Aura®

Contact Center.
Server IP address The IP address of the Avaya Aura® Contact Center

server.
Server ELAN IP
address

The ELAN IP address of the Avaya Aura® Contact
Center server.

Server mask The network mask of the Avaya Aura® Contact
Center server.

Server default gateway The default gateway used by the Avaya Aura®

Contact Center server.
MAC address of Avaya
Aura® Contact Center
server

You use this unique MAC address to obtain a
Contact Center WebLM license from the Avaya
Product Licensing and Delivery System (PLDS).

DNS server IP address The IP address of the DNS server used by Avaya
Aura® Contact Center.

Domain name The Avaya Aura® Contact Center server Windows
domain.

Country or region The Microsoft Windows Server 2012 country or
region server setting.

Time and currency The Microsoft Windows Server 2012 time and
currency server setting.

Keyboard layout The Microsoft Windows Server 2012 keyboard layout
server setting.

Microsoft Windows
Server 2012 R2 SP1
product key

The Microsoft Windows Server 2012 R2 SP1 product
key used to activate the Operating System.

Administrator password A password for the Avaya Aura® Contact Center
server Administrator account.

The following table lists the main Avaya Aura® Contact Center configuration questions.

Configuration Item Your value Description
Site Name The site name for the Contact Center server.
RSM IP address The Real-time Statistics Multicast IP address of the

server to associate with sending real-time data.
System Account
Configuration

The password for the CCMA System Account user
account.
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The following table lists the main Avaya Aura® Contact Center Licensing configuration questions.

Configuration Item Your value Description
License File Location The folder on the server which contains the license

file.
License Manager IP
address

The IP address of the License Manager.

Licensing Package The licenses that you have purchased
Optional Packages

The following table lists the main Avaya Aura® Contact Center and Avaya Communication Server
1000 configuration questions.

Configuration Item Your value Description
Switch Name The name of the Avaya Communication Server 1000

PABX.
CS1000 IP address The IP address of the Avaya Communication Server

1000 PABX.
CS1000 Customer
Number

The number of the customer on the Avaya
Communication Server 1000 PABX that integrates
with Avaya Aura® Contact Center.

CallPilot IP address The ELAN IP address of the CallPilot server.

The following table lists the main Avaya Aura® Contact Center multimedia configuration questions.

Configuration Item Your value. Description
Inbound Mail Server
(POP3)

The name of the server on which email messages
are received in your network.

Outbound Mail Server
(SMTP)

The name of the server from on which email
messages are sent. Your inbound and outbound mail
servers can have the same name.

Installation checklist
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Part 1: Avaya Communication
Server 1000
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Chapter 6: Voice and Multimedia Contact
Server for CS1000 installation

This chapter describes how to install a Voice and Multimedia Contact Server in a solution with an
Avaya Communication Server 1000 (CS1000) platform. A Voice and Multimedia Contact Server
includes the following server software:

• Contact Center Manager Server (CCMS)

• Contact Center Manager Server Utility

• Contact Center License Manager

• Contact Center Manager Administration (CCMA)

• Communication Control Toolkit (CCT)

• Contact Center Multimedia (CCMM)

Install this server to provide context‐sensitive and skill-based routing for customer voice and
multimedia contacts. This server provides routed contact support for voice calls, email messages,
Web communications, voice mail messages, scanned documents, fax messages, and SMS text
messages. This server provides extensive tools for agent management, real-time and historical
reporting, and graphical tools to create contact flows and treatment rules. Use this server for license
management, High Availability configuration, networking, Open Interfaces Web Service and third-
party application interfaces integration.

If the server is to be used in a domain, Avaya recommends that you add the server to the domain
before installing Contact Center software.

You can change the name of a Contact Center server, but because this is time consuming, Avaya
recommends that you configure the server final production name before installing Contact Center
software.

If you plan to follow the Microsoft server hardening guidelines, complete those procedures before
installing Avaya Aura® Contact Center.

You can use any account with local administrative rights to install Avaya Aura® Contact Center. You
can use any account with local administrative rights to upgrade and patch Avaya Aura® Contact
Center; you do not need to always use the same account to perform these tasks.
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Important:

You must disable the Admin Approval Mode security feature on the Contact Center server. This
ensures that accounts with local administrative rights get full privileges for running applications
on the Contact Center server.

Voice and Multimedia Contact Server supports two Network Interface Cards (NICs) and two subnets
(one contact center subnet and one ELAN subnet). The Voice and Multimedia Contact Server ELAN
NIC and ELAN subnet are optional.

Complete all the procedures in this section in sequential order.

Voice and Multimedia Contact Server installation
prerequisites

Procedure
• Copy the most recent patches for the Contact Center software.

• Ensure that your new Contact Center license file is available.

Important:

For the system to correctly handle backup and restore SNMP events, you must install
Windows SNMP Service before you install Contact Center server software.

Downloading the most recent documentation
Before you begin

• Download the most recent version of Acrobat Reader.
• Access the Avaya website at http://support.avaya.com.

About this task
Download the most recent documentation to ensure you have the most recent updates. Updates
in the documentation accurately reflect the most recent changes in the software.

Procedure
1. Log on to the Avaya website.

2. Compare the versions of the documentation on the site with the versions you have.

3. If the version number on http://support.avaya.com is higher than your version, download
the latest version of the document.

4. Review the Avaya website for release notes and readme files.

Voice and Multimedia Contact Server installation prerequisites
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Installing Microsoft Windows Server 2012 R2
Before you begin

• Ensure that you have a newly formatted server that meets the specifications in Avaya Aura®

Contact Center Overview and Specification on which to install Microsoft Windows Server
2012 R2.
Do not upgrade your operating system from a previous release. Contact Center is not
supported on an upgraded operating system.

• Configure all servers for RAID as described in Avaya Aura® Contact Center Overview and
Specification.

• Ensure that you have a DVD for Microsoft Windows Server 2012 R2 Standard or Data
Center. Ensure that your DVD is the R2 version of Windows Server 2012 Standard or Data
Center.

• Ensure that you have a Microsoft Windows Server 2012 R2 operating system product key.
• Know the IP addresses for the contact center subnet.

About this task
Install the Microsoft Windows Server 2012 R2 Standard or Data Center operating system and
configure it to support Contact Center server software.
The following table lists the main inputs to consider while installing the operating system.

Name Description
Computer name Do not use spaces or underscores or exceed 15 characters. The name must start

with an alphabetic character. Server names must adhere to RFC1123. Avaya
recommends that you configure the server final production name before installing
Contact Center software.

The computer name must match (including case sensitivity) the DNS name.
Disk drives Format the partitions as required for the server. For more information, see Avaya

Aura® Contact Center Overview and Specification.
Domain name Configure as required for your site.

You must check to ensure the DNS Domain name (including case) matches the
server name if the server is added to a domain after configuration.

Licensing modes Select Per server licensing mode.

Accept the default five concurrent connections.
Network components Configure IP Address, WINS, DNS for one or two network cards as per

configuration. Contact Center does not support IPv6.
Network connections If the server has more than one NIC/adapter, ensure contact center subnet

appears first in the network adapter binding order.
Hard Disk Partitions Configure C: drive to be a primary drive. Configure the other drives on your server

to meet the requirements according to Avaya Aura® Contact Center Overview and
Specification for the server.

Perform this procedure on each server before you install Contact Center server software on the
server.
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Procedure
1. Insert the Microsoft Windows Server 2012 R2 Standard or Data Center DVD into the DVD

drive.

2. Turn on the power to the server.

The server begins to boot up.

3. On the Windows Setup screen, select a Language to install from the list.

4. Select a Time and currency format from the list.

5. Select Keyboard or input method from the list.

6. Click Next.
7. Click Install now.

8. Depending on the DVD image that you use, you might need to select an operating system
from a list. Select a version of Windows Server 2012 R2 Standard or Data Center that
includes a Graphical User Interface (GUI). Install a version that includes “(Server with a
GUI)”.

9. Click Next.
10. On the Enter the product key to activate Windows window, enter the operating system

product key.

11. Click Next.
12. On the Windows Setup screen, read the terms of the license agreement and select I

accept the license terms.

13. Click Next.
14. Select Custom: Install Windows only (advanced) to install a clean new installation of the

operating system.

15. Select the disk partition on which you want to install Windows Server 2012 R2.

Important:

You can use the partition management options to configure the partitions on your
server.

16. Click Next.

The installation proceeds and automatically restarts the server several times.

17. After completing the installation, log on to the server as Administrator. Enter and confirm
the Administrator password.

18. Select Set time zone and complete the information as required for your system.

19. Select Configure Networking and complete the information for your Network Interface
Card (NIC) with the server IP address.

Installing Microsoft Windows Server 2012 R2

July 2018 Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000 35
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000


20. Select Provide computer name and domain and complete the information for your server
name and network settings.

21. Change the DVD drive letter to E: to ensure the correct drive letters are free for the
Contact Center application and database hard disk drives and partitions.

22. Configure the hard disk drives and partitions for this server using the Windows Server
2012 R2 Computer Management - Disk Management utility. For more information about
hard disk drives and partitions, see Avaya Aura® Contact Center Overview and
Specification.

23. Install other required drivers for your hardware configuration.

Job aid: Hard disk drive partitions
Configure the hard disk drives and partitions. These are the minimum hard disk partition sizes. For
more information about hard disk requirements, including the recommended partition sizes, see
Avaya Aura® Contact Center Overview and Specification.

For each partition, specify a volume size in MBs that when formatted results in a disk partition that
is equal to or greater than the required minimum partition size.

Hard disk drive Drive letter Minimum size
partition

Operating System drive

Including the 350 MB Windows boot loader System Reserved
partition.

C: 80 GB NTFS

Application drive D: 120 GB NTFS
DVD drive.

For continuity and consistency, Avaya recommends using Drive
letter E: for the DVD drive. However, Contact Center supports any
DVD Drive letter, other than the Drive letters listed here for the
hard disk partitions.

E: —

Voice Contact Server database drive F: 200 GB NTFS
Multimedia Contact Server database drive G: 300 GB NTFS
Database journal H: 100 GB NTFS

Navigating the Microsoft Windows Server 2012 R2 User
Interface

This section describes how to navigate between the main user interface screens of the Windows
Server 2012 R2 operating system.
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The following table describes some of the main Microsoft Windows Server 2012 R2 user interface
screens.

Screen name Description
Start The Start screen contains shortcuts to the main administration interfaces of the

server. If you have an application that you access on a regular basis, you can
add it to the Start screen so that it's more immediately accessible. The Start
screen displays the currently logged on user and provides some basic server log
out and locking functions. This is the operating system default screen.

Apps The Apps screen contains shortcuts to the applications and utilities installed on
the server. The server applications and utilities are grouped into categories.
Third-party vendors and applications can also add custom, vendor or product
specific, categories to the Apps screen.

Desktop The Desktop screen contains the Windows start button, the Windows Taskbar,
Recycle Bin, and shortcuts to the Windows Explorer utility, among others. The
Taskbar displays the Windows Notification Area and System Tray. The
notification area is located on the right portion of the Taskbar next to the time.

Navigation tips:

• Use the up  and down  arrow icons to navigate between the Start and Apps screens.

• To display the Start screen, on the Desktop screen, click the Windows start button.

• To display the Desktop screen, on the Start screen select the Desktop tile.

• To display the Desktop screen, on the Apps screen select the Desktop tile.

• To switch between the Start screen and the Desktop screen press the Windows start button
on your keyboard.

• To access the Control Panel, on the Apps or Start screen click on the Control Panel tile.

• To access the Administration Tools, on the Apps or Start screen click on the Administrative
Tools tile.

These screen navigation methods work when you are using the server’s keyboard and mouse
directly, or when you are using Remote Desktop to access the server.

Navigating the Microsoft Windows Server 2012 R2 User Interface
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Figure 2: Example of the Start screen, with the down arrow icon highlighted in a red box.
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Figure 3: Example of the Apps screen, with the up arrow icon highlighted in a red box.
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Figure 4: Example of the Desktop screen, with the Windows start button highlighted in a red box.

The following table describes some of the Taskbar sections of the Desktop screen.

Icon Name Description
Windows start button Use the Windows start button to navigate to the Start screen. Use this

button to switch between the Start screen and the Desktop screen.

Server Manager Use this button to access the Server Manager to configure the roles and
features to the server.

PowerShell Use the PowerShell button to start the Windows PowerShell console.
Windows PowerShell is a command-line shell that provides cmdlets
(pronounced command-lets) for server configuration and management.
PowerShell also provides scripting functions for task automation.

This PC Use this button to start the This PC Windows Explorer. Use this to
access and navigate the folders, files, and storage devices on the
server.

Voice and Multimedia Contact Server for CS1000 installation

July 2018 Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000 40
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000


The contents of your screens can vary depending on the roles, features, and applications installed
on your server.

For more information about the Windows Server 2012 R2 operating system, refer to the Microsoft
support website and Microsoft product documentation.

Installing the most recent supported operating system
service packs

Before you begin
• Access the Avaya hotfixes list on the website http://support.avaya.com.
• Install and configure Microsoft Windows Server 2012 R2 on your server.
• Review the specifications on operating system service updates in Avaya Aura® Contact

Center Overview and Specification.

About this task
Avaya recommends that you install the most recent supported operating system service packs.
You must download the supported operating system service pack from the Avaya hotfixes list to
ensure your Contact Center server software functions correctly with the supported operating
system patches.

Procedure
1. Review the Contact Center Service Packs Compatibility and Security Hotfixes Applicability

List to determine the most recent Avaya Aura® Contact Center supported patches or
service packs.

2. Download the appropriate Microsoft Windows Server 2012 R2 patches for the Avaya Aura®

Contact Center software installed on this server.

3. Install the most recent Windows Server 2012 R2 service pack that is validated with Avaya
Aura® Contact Center by following the Microsoft Installation instructions.

Connecting to the contact center subnet
About this task
Connect the Contact Center server to the contact center subnet. The contact center subnet is the
network on which the server software applications work together to route contacts and generate
reports.

Procedure
1. Locate the slot assigned to the contact center subnet network interface card for the server.

Make a note of the slot.
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2. Connect the cable from the contact center subnet to the contact center subnet network
interface card in the server in accordance with customer site networking guidelines.

3. Use the ping command to test the contact center subnet.

Adding the server to a domain or workgroup
About this task
Add the server to a domain or workgroup. Avaya recommends that you add the server to the
domain or workgroup before installing Contact Center software.
If you are using a domain:

• Add the server to a Windows domain before installing Contact Center software. When joining
the domain, ensure the server time and domain controller time are synchronized to the same
time.

• On the server, configure a preferred Domain Name System (DNS) server on the Network
Interface Card (NIC).

• Ask your System Administrator to add a Domain Name System (DNS) static entry for this
server. Each Contact Center server in a domain requires a DNS static entry.

Procedure
1. Log on to the server.

2. On the Start screen, select Administrative Tools  > Server Manager.
3. In the left pane, select Local Server.
4. In the right pane, in the Properties section, double-click on the Domain or Workgroup

value.

The System Properties dialog box appears.

5. In the System Properties dialog box, click the Computer Name tab.

6. Click Change.

7. To add the server to a workgroup, skip to step 9.

8. To add the server to a domain, in the Member of dialog box, click the Domain option.

a. Type the domain name (you must provide the fully qualified domain name, which
includes the prefix and suffix).

b. Click OK.

c. Type the domain administrator User name and Password.

d. Click OK.

e. Skip to step 10.
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9. To add the server to a workgroup, in the Member of dialog box, click the Workgroup
option.

a. Type the workgroup name.

b. Click OK.

c. Type the workgroup administrator User name and Password.

d. Click OK.

10. Restart the server when you are prompted to do so.

Downloading the most recent Contact Center patches to
the server

Before you begin
• Download and install the most recent and supported updates for Microsoft Windows Server

2012 R2.
• Know the location at which you plan to install each Contact Center server software package.
• Ensure that you use one administrator account on your server to un-install and install

software updates.

About this task
To ensure that you have the most current software, download the most recent Contact Center
patches from http://support.avaya.com to the server you plan to install.

Procedure
1. Log on to the server using the administrator account.

2. Create a folder <Drive>:\Avaya-ProductUpdates\ to save the software updates. Where
<Drive> is the drive letter on which you want to save the Contact Center software updates.

3. Download the most recent service pack file. Save and unzip the file on the Contact Center
server in the Avaya-ProductUpdates folder.

4. If new patches are available for the latest service pack, download and save the patches on
the Contact Center server in the Avaya-ProductUpdates folder.

5. Read the Contact Center Release Notes for the most recent instructions.

Downloading the most recent Contact Center patches to the server
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Disabling unused Network Adapters
About this task
Disable all unused Network Adapters or Network Interface Cards (NICs) to improve network
communications and prevent the erroneous configuration of unused NICs during Contact Center
server commissioning.

Procedure
1. Log on to the server.

2. On the Start screen, select Control Panel  > Network and Internet  > Network and
Sharing Center  > Change adapter settings.

3. Right-click on the unused Network Adapter, and select Disable.

4. Repeat this procedure for all unused Network Adapters.

Enabling Microsoft Remote Desktop connection
About this task
Enable Microsoft Remote Desktop connection as your remote access tool. Microsoft Remote
Desktop provides remote access for support on the server.

Procedure
1. Log on to the server with administrator privileges.

2. On the Start screen, select Control Panel  > System and Security.

3. In the System section, select Allow remote access.

4. Click the Remote tab.

5. Select Allow remote connections to this computer.
6. Click Apply.

7. Click OK.

Disabling NetBIOS
About this task
If the Contact Center server uses two Network Interface Cards (NICs), disable NetBIOS on the
Embedded LAN (ELAN) network interface card (NIC) to avoid NetBIOS conflicts.
Contact Center supports two Network Interface Cards (NICs) and two subnets (one contact center
subnet and one ELAN subnet). The Contact Center ELAN NIC and ELAN subnet are optional.
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Procedure
1. Log on to the server.

2. On the Start screen, select Control Panel  > Network and Internet.
3. Click Network and Sharing Center.
4. Click Change adapter settings.

5. Right-click the ELAN Network Interface Card (NIC).

6. Click Properties.

7. Select Internet Protocol Version 4 (TCP/IPv4).
8. Click Properties.

9. Click Advanced.

10. Click the WINS tab.

11. Select the Disable NetBIOS over TCP/IP check box.

12. Click OK.

Connecting the Embedded LAN subnet
Before you begin

• Install two network cards on the Contact Center server.
• Disable the NetBIOS on the ELAN network interface card.
• Connect the contact center subnet network interface card.

About this task
If your server uses two NICs, connect the Embedded LAN (ELAN) NIC to the ELAN subnet.
Contact Center supports two network interface cards (NICs) and two subnets (one contact center
subnet and one ELAN subnet). The Contact Center ELAN NIC and ELAN subnet are optional.

Procedure
1. Locate the slot assigned to the ELAN network interface card for the server.

2. Write the MAC address of the card on a small label. Attach the label to the back of the card
or the chassis slot position.

3. Connect the ELAN subnet from the Avaya equipment to the Ethernet hub.

4. Connect the network cable from the ELAN network interface card in the server to the hub.

5. Plug in the power cord for the hub.

6. If you have an ELAN subnet network connection, use the ping command to test it.

Connecting the Embedded LAN subnet
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Configuring the binding order
Before you begin

• Install two network interface cards on the Contact Center server.
• Disable the NetBIOS on the ELAN network interface card.
• Connect the Contact Center server network interface card to the contact center subnet.
• Connect the Contact Center server ELAN network interface card to the ELAN subnet.

About this task
Configure the binding order of the network cards. The contact center subnet network interface
card must be bound first and then the ELAN network interface card.

Procedure
1. On the Start screen, select Control Panel  > Network and Internet  > Network and

Sharing Center.
2. Click Change adapter settings.

3. In the Network Connections window, press the ALT key.

A hidden menu appears.

4. Choose Advanced  > Advanced Settings.

5. In the Connections box, ensure that the contact center subnet connection is listed first. If
it is not listed first, adjust the order.

Disabling Admin Approval Mode for Windows Server
administrators

About this task
Windows Server 2012 implements a security feature known as User Account Control (UAC). By
default, this feature causes applications run by local non built-in administrators to behave as if the
applications had been run by standard users. Perform this procedure to ensure that local
administrators get full privileges for running applications.

Note:
This procedure describes how to disable Admin Approval Mode on the Contact Center server
using one method only; there are additional methods available. For example, you can also
administer User Account Control settings for the Contact Center server using a group policy.

Procedure
1. On the Start screen, select Administrative Tools  > Local Security Policy.

2. Under Security Settings, expand Local Policies.
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3. Select Security Options.

4. In the policy pane on the right, double-click on User Account Control: Run all
administrators in Admin Approval Mode.

5. Click the Local Security Setting tab, and select Disabled.

6. Click OK.

If prompted, restart the server.

Disabling Windows Server 2012 Automatic Maintenance
About this task
Disable Windows Server 2012 R2 Automatic Maintenance while installing Contact Center
software. Windows Server 2012 Automatic Maintenance can occasionally interfere with the real-
time requirements for Contact Center deployment and configuration. You must therefore
temporarily disable Automatic Maintenance to install and configure Contact Center software. You
re-enable Automatic Maintenance after deploying and configuring Contact Center.

Disabling Windows Server 2012 Automatic Maintenance
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Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.

5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows  > TaskScheduler.

6. In the Name column, right-click Idle Maintenance and select Disable.

7. In the Name column, right-click Regular Maintenance and select Disable.

8. From the File menu, select Exit.

Installing the Voice and Multimedia Contact Server
software for CS1000

Before you begin
• Ensure the Avaya Communication Server 1000 is configured. For more information see

Avaya Aura® Contact Center and Avaya Communication Server 1000 Integration.
• Download the most recent Contact Center and Common Components patches to the server.
• Read the Contact Center Release Notes for the most recent instructions.

About this task
Install the Contact Center Voice and Multimedia Contact Server software on the server.

Procedure
1. Insert the Contact Center DVD into the DVD drive of your server.
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2. If the installation does not automatically start, double-click Setup.exe.

3. Click Accept to install the Microsoft .NET Framework on the server.

If you are prompted to accept the Microsoft .NET Framework license agreement, click
Accept. If you are prompted to restart the server, click Yes and repeat step 2.

4. Contact Center software installer runs Operating System and hardware checks on the
server. If the installer returns a Fail, the software installation cannot proceed until you
correct the problem. Review any failures returned by the System Readiness Check and
consult Avaya Aura® Contact Center Overview and Specification to determine the actions
to resolve the issue.

You can ignore warnings if the potential impact to the operation of the contact center is
understood and not applicable.

5. The Contact Center software installer platform and server selection screen appears.

6. In the Select Voice Platform section, select Avaya Communication Server 1000 - AML.

7. In the Select Server Installation Option section, select Voice and Multimedia Contact
Server without Avaya Aura Media Server.

8. Click Next.
9. Under Journal Database Drive, select the drive for the database journal. The default drive

partition is H:.

10. Under Voice Contact Server Database Drive, select the drive for the Contact Center
Manager Server, Communication Control Toolkit, and Contact Center Manager
Administration databases. The default drive partition is F:.
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11. Under Multimedia Contact Server Database Drive, select the drive for the Contact
Center Multimedia database. The default drive partition is G:.

12. In the Service Packs section, browse to and select the Service Pack.

13. Click Install.
14. The AVAYA GLOBAL SOFTWARE LICENSE TERMS window appears.

15. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
16. The MICROSOFT SOFTWARE LICENSE TERMS window appears.

17. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.
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• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
18. The Progress window appears and displays the installation progress.

19. When the software is installed, you have the following options.

• To continue configuring the server installation data:

a. Select Launch Avaya Aura Contact Center Ignition Wizard.

b. Click Configure. This starts the Avaya Aura® Contact Center Ignition Wizard.

• To defer configuring the server installation data:

a. Clear Launch Avaya Aura Contact Center Ignition Wizard.

b. On the message box, click Yes.

c. On the main installer screen, click Close.

d. Follow the on-screen instructions and shut down the Contact Center server.

You must use the Ignition Wizard to initialize Avaya Aura® Contact Center, otherwise
Avaya Aura® Contact Center is not operational. For more information about the Ignition
Wizard, see the following procedures.

Configuring Voice and Multimedia Contact Server software
for CS1000

Before you begin
• Ensure the Avaya Communication Server 1000 is configured. For more information see

Avaya Aura® Contact Center and Avaya Communication Server 1000 Integration.
• You must configure the required language and locale of the Contact Center server operating

system, if it is not a Latin-1 language, before configuring the Contact Center server using the
Contact Center Ignition Wizard. For more information about configuring language and locale
settings on the Contact Center server, see Avaya Aura® Contact Center Server
Administration.

• Download the most recent Contact Center and Common Components patches to the server.
• Read the Contact Center Release Notes for the most recent instructions.

About this task
Configure the Contact Center Voice and Multimedia Contact Server software and enable your
contact center to route contacts to the agents that can answer the call with the correct skills.

Procedure
1. Log on to the Contact Center server using the Administrator account details.
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2. On the Contact Center Ignition Wizard screen, click Next. If the Contact Center Ignition
Wizard is not visible, click the Ignition Wizard shortcut on the desktop.

3. On the End-User License Agreement screen, read the license agreement. Optionally,
click Print to generate a local soft copy (in OpenXPS Document format) of the license
agreement.

4. Select I Accept the Terms of the End-User License Agreement and click Next.
5. On the Configuration Data window, type the configuration details for each tab.

6. Select the Core tab, and configure the server details.

7. In the Site Name box, type the site name for the Contact Center server. The site name
must not contain spaces or non-alphabetical characters except hyphen (-) and underscore
(_). The first character must be a letter. The site name must be unique and can consist of 6
to 15 characters.

8. In the Real-Time Statistics Multicast IP Address box, type the Real-time Statistics
Multicast IP Address of the server to associate with sending real-time data. The IP
Address must be from 224.0.1.0 to 239.255.255.255. The default is 234.5.6.10.

9. In the Network Configuration section, in the ELAN IP Address box, type the IP Address
of the embedded local area network. The embedded local area network (ELAN) is a
dedicated Ethernet LAN that connects Contact Center to the PABX.
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10. In the CLAN IP Address box, type the IP Address of the Contact Center server. This is the
Contact Center server IP address on the subnet that connects to the other servers and
agent client computers in the contact center solution.

11. In the System Account Configuration section, in the Password box, type a password for
the Contact Center administration account. The password is checked against the server
security policy for minimum password requirements. Avaya recommends that you enter a
password that conforms to your corporate password policy.

12. In the Confirm Password box, type the password.

13. Select the Licensing tab, and configure the licensing details.

14. From the License Type list, select Standard KRS.

15. Click Browse to locate and load your license file.

16. From the Licensing Package list, select the license type that you have purchased. Select
Nodal Enterprise for single-site contact centers.

17. From the list of Optional Packages, enable the licensed features that you have
purchased.

18. Select the Open Queue check box.

19. Select the Multimedia tab, and configure the Contact Center Multimedia details.
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20. In the Incoming Mail Server box, type the name of the server on which email messages
are received in your network.

21. From the Protocol list, select the communication protocol for the inbound email server.
Select POP3 or IMAP. The default protocol is POP3.

22. In the Outgoing Mail Server box, type the name of the server from on which email
messages are sent. Your inbound and outbound mail servers can have the same name.

23. Select the CS1000 tab.

24. In the Switch Name box, type the name of the AML Avaya Communication Server 1000
telephone switch. Valid characters for Avaya Communication Server 1000 names are A–Z,
a–z, 0–9, underscore (_), and period (.). Names must begin with an alphabetical character
and cannot contain spaces. The last character must not be an underscore or a period.
Names must not exceed 80 characters in length.

25. In the Switch IP Address box, type the IP address of the Avaya Communication Server
1000.

26. In the Switch Customer Number box, type the customer number for the Avaya
Communication Server 1000.

27. In the Alternative Switch IP Address box, type the IP address of an alternate Avaya
Communication Server 1000, if you have one.
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28. In the Alternative Switch Customer Number box, type the customer number of the
alternate Avaya Communication Server 1000, if you have one.

29. In the Alternative Switch Serial ID box, type the serial number of the alternate Avaya
Communication Server 1000, if you have one.

30. In the Voice Connection Type section, select the method used to connect to the PABX.
Select None, Avaya Aura Experience Portal, or CallPilot.

31. If you are using an Avaya CallPilot® server, enter the Avaya CallPilot® server ELAN IP
Address and then configure the Port to 10008.

32. If you are using Avaya CallPilot® High Availability, in the CPHA Managed CLAN IP
Address box, type the Avaya CallPilot® Managed CLAN IP address.

33. If you are using an Avaya CallPilot® server, in the CLAN IP Address box, type the CLAN
IP address of the Avaya CallPilot® server.

34. Select the Security Configuration tab, and configure the security details in the Security
Store Details section.

35. If you do not want to enable security, select the Skip Security Configuration checkbox
and skip to step 54 on page 58.
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Important:

A warning message appears.

36. In the Full Computer Name (FQDN) box, type the full FQDN of the server on which you
are creating the security store.

Important:

The FQDN must be the full machine name of the server that the Security Store resides
on. The FQDN name is case-sensitive.

37. In the Name of Organizational unit box, type the name of the department or division
within the company.

38. In the Name of Organization box, type the company name.

39. In the City or Locality box, type the name of the city or district in which the contact center
is located.

40. In the State or Province box, type the state or province in which the contact center is
located.

41. In the Two Letter Country Code box, type the country code in which the contact center is
located.

42. In the Security Store password box, type a password for accessing the new security
store.

43. In the Confirm Store password box, confirm the password for accessing the new security
store.

Important:

Ensure you remember this password, because you need it when you log on to Security
Manager after install. If you forget the password, you cannot access Security Manager.

44. If you are implementing High Availability in the contact center, generate the security store
using Subject Alternative Names (SANs). In the Subject Alternative Name section, for
each SAN you want to add:

a. From the Type drop-down list, select DNS.

b. In the Value field, type the FQDN for the server.

c. Click Add.

For a High Availability system, add the current server FQDN and the Managed name for
the HA pair.

45. If you want to change the encryption setting, select the required encryption settings from
the Encryption Algorithm Level and Key Size drop-down lists.

The default value for Encryption Algorithm is SHA256 and the default value for Key Size
is 2048.
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Contact Center displays a warning message if you select SHA1 or 1024. Contact Center
includes these values for backward-compatibility only, because these settings do not meet
the industry-recommended level of encryption.

46. Click Create Store.

47. You can now use the Security Configuration tab to create and save a Certificate Signing
Request (CSR) file.

48. Click Create CSR File.

49. From the Save In drop-down list, select a shared location in which to save the CSR file
and click Save.

You must now send the Certificate Signing Request file to a Certificate Authority and
receive a signed certificate and root certificate to import to the security store.

50. In the Imported Trusted Certificate Authority Root Certificate(s) section, click Add to
import the Certificate Authority root certificate.

51. In the Open dialog box, browse to the location of the certificate and click Open.

52. In the Imported Identity Security Certificate section, click Add to import the Certificate
Authority signed certificate.

53. In the Open dialog box, browse to the location of the certificate and click Open.
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54. Click Next.
55. Review and verify the summary information, and click Configure.

56. After the installation is complete, click Finish.

57. If prompted, restart the server.

Enabling Windows Server 2012 Automatic Maintenance
About this task
Enable Windows Server 2012 R2 Automatic Maintenance after deploying and configuring Contact
Center software.

Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.

5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows > TaskScheduler.

6. In the Name column, right-click Idle Maintenance and select Enable.

7. In the Name column, right-click Regular Maintenance and select Enable.

8. From the File menu, select Exit.
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Securing the Windows server
About this task
Apply optional security measures to your operating system to further secure your server.

Important:
Scanning software can degrade the performance and decrease the reliability of the system.
Install virus scanning software only if the system connects to an exposed network or to the
Internet.

Important:
To maintain server performance, you must schedule virus scans during maintenance periods
or low usage hours only.

Procedure
1. Harden the operating system using defined site procedures.

2. Install antivirus software. If you install antivirus software, Avaya recommends that you
exclude some contact center files and folders from real-time and scheduled scans. For
more information, and for a list of files and folders to exclude, see Avaya Aura® Contact
Center Overview and Specification.

Installing the external Web communication server software
Before you begin

• Install Contact Center Multimedia software.

About this task
If you use Web communications in your contact center, you can use the Sample Customer
Interface (CI) website implementation to help you develop pages for your corporate website. The
Web services architecture is a platform-independent interface that customers can access from
both Microsoft .NET and Java applications. Customer websites or third-party applications use the
open interface for integration with the Contact Center Multimedia system.
The Customer Interface Web services provide a range of methods to perform the following
functions:

• Register new customers in the Contact Center Multimedia database
• Log on or log off existing customers
• Update customer logon credentials
• Create customer contacts
• Update customer details
• Read customer information
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• Review a customer contact history
• Request immediate or scheduled callback requests
• Read a contact
• Create and maintain a Web communications chat session

To integrate Web Communications with the Contact Center Multimedia system, download the
Avaya Aura® Contact Center Web Communications SDK package and Reference Implementation
from www.avaya.com/devconnect. The Web Communications Reference Implementation contains
information about customizing the Web communication application to your solution.

Important:
Do not install the Web Communications Reference Implementation on an Avaya Aura®

Contact Center server. Install the Web Communications Reference Implementation on your
own server in the contact center solution.

Procedure
1. Locate and download the Web Communications Reference Implementation software from 

www.avaya.com/devconnect.

2. Copy the Web Communications Reference Implementation software to the external Web
server.

3. Follow the Reference Implementation instructions to install and commission the Web
Communications server.

Commissioning the Contact Center server
About this task
Commission the installed Contact Center software.

Procedure
Commission the installed Contact Center software.

For information about commissioning the installed server software, see Avaya Aura® Contact
Center Commissioning for Avaya Communication Server 1000.
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Chapter 7: Primary Voice and Multimedia
Contact Server for CS1000
software installation in a domain

This chapter describes how to install a primary Voice and Multimedia Contact Server in a solution
that supports High Availability and has an Avaya Communication Server 1000 (CS1000) platform. A
Voice and Multimedia Contact Server includes the following server software:

• Contact Center Manager Server (CCMS)

• Contact Center Manager Server Utility

• Contact Center License Manager

• Contact Center Manager Administration (CCMA)

• Communication Control Toolkit (CCT)

• Contact Center Multimedia (CCMM)

Install this server to provide context‐sensitive and skill-based routing for customer voice and
multimedia contacts. This server provides routed contact support for voice calls, email messages,
Web communications, voice mail messages, scanned documents, fax messages, and SMS text
messages. This server provides extensive tools for agent management, real-time and historical
reporting, and graphical tools to create contact flows and treatment rules. Use this server for license
management, High Availability configuration, networking, Open Interfaces Web Service and third-
party application interfaces integration.

You can change the name of a Contact Center server, but because this is time consuming, Avaya
recommends that you configure the server final production name before installing Contact Center
software.

If you plan to follow the Microsoft server hardening guidelines, complete those procedures before
installing Avaya Aura® Contact Center.

You can use any account with local administrative rights to install Avaya Aura® Contact Center. You
can use any account with local administrative rights to upgrade and patch Avaya Aura® Contact
Center; you do not need to always use the same account to perform these tasks.
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Important:

You must disable the Admin Approval Mode security feature on the Contact Center server. This
ensures that accounts with local administrative rights get full privileges for running applications
on the Contact Center server.

Voice and Multimedia Contact Server supports two Network Interface Cards (NICs) and two subnets
(one contact center subnet and one ELAN subnet). The Voice and Multimedia Contact Server ELAN
NIC and ELAN subnet are optional.

You must complete all the procedures in this section in sequential order.

Voice and Multimedia Contact Server installation
prerequisites

Procedure
• Copy the most recent patches for the Contact Center software.

• Ensure that your new Contact Center license file is available.

Important:

For the system to correctly handle backup and restore SNMP events, you must install
Windows SNMP Service before you install Contact Center server software.

Downloading the most recent documentation
Before you begin

• Download the most recent version of Acrobat Reader.
• Access the Avaya website at http://support.avaya.com.

About this task
Download the most recent documentation to ensure you have the most recent updates. Updates
in the documentation accurately reflect the most recent changes in the software.

Procedure
1. Log on to the Avaya website.

2. Compare the versions of the documentation on the site with the versions you have.

3. If the version number on http://support.avaya.com is higher than your version, download
the latest version of the document.

4. Review the Avaya website for release notes and readme files.
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Installing Microsoft Windows Server 2012 R2
Before you begin

• Ensure that you have a newly formatted server that meets the specifications in Avaya Aura®

Contact Center Overview and Specification on which to install Microsoft Windows Server
2012 R2.
Do not upgrade your operating system from a previous release. Contact Center is not
supported on an upgraded operating system.

• Configure all servers for RAID as described in Avaya Aura® Contact Center Overview and
Specification.

• Ensure that you have a DVD for Microsoft Windows Server 2012 R2 Standard or Data
Center. Ensure that your DVD is the R2 version of Windows Server 2012 Standard or Data
Center.

• Ensure that you have a Microsoft Windows Server 2012 R2 operating system product key.
• Know the IP addresses for the contact center subnet.

About this task
Install the Microsoft Windows Server 2012 R2 Standard or Data Center operating system and
configure it to support Contact Center server software.
The following table lists the main inputs to consider while installing the operating system.

Name Description
Computer name Do not use spaces or underscores or exceed 15 characters. The name must start

with an alphabetic character. Server names must adhere to RFC1123. Avaya
recommends that you configure the server final production name before installing
Contact Center software.

The computer name must match (including case sensitivity) the DNS name.
Disk drives Format the partitions as required for the server. For more information, see Avaya

Aura® Contact Center Overview and Specification.
Domain name Configure as required for your site.

You must check to ensure the DNS Domain name (including case) matches the
server name if the server is added to a domain after configuration.

Licensing modes Select Per server licensing mode.

Accept the default five concurrent connections.
Network components Configure IP Address, WINS, DNS for one or two network cards as per

configuration. Contact Center does not support IPv6.
Network connections If the server has more than one NIC/adapter, ensure contact center subnet

appears first in the network adapter binding order.
Hard Disk Partitions Configure C: drive to be a primary drive. Configure the other drives on your server

to meet the requirements according to Avaya Aura® Contact Center Overview and
Specification for the server.

Perform this procedure on each server before you install Contact Center server software on the
server.
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Procedure
1. Insert the Microsoft Windows Server 2012 R2 Standard or Data Center DVD into the DVD

drive.

2. Turn on the power to the server.

The server begins to boot up.

3. On the Windows Setup screen, select a Language to install from the list.

4. Select a Time and currency format from the list.

5. Select Keyboard or input method from the list.

6. Click Next.
7. Click Install now.

8. Depending on the DVD image that you use, you might need to select an operating system
from a list. Select a version of Windows Server 2012 R2 Standard or Data Center that
includes a Graphical User Interface (GUI). Install a version that includes “(Server with a
GUI)”.

9. Click Next.
10. On the Enter the product key to activate Windows window, enter the operating system

product key.

11. Click Next.
12. On the Windows Setup screen, read the terms of the license agreement and select I

accept the license terms.

13. Click Next.
14. Select Custom: Install Windows only (advanced) to install a clean new installation of the

operating system.

15. Select the disk partition on which you want to install Windows Server 2012 R2.

Important:

You can use the partition management options to configure the partitions on your
server.

16. Click Next.

The installation proceeds and automatically restarts the server several times.

17. After completing the installation, log on to the server as Administrator. Enter and confirm
the Administrator password.

18. Select Set time zone and complete the information as required for your system.

19. Select Configure Networking and complete the information for your Network Interface
Card (NIC) with the server IP address.
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20. Select Provide computer name and domain and complete the information for your server
name and network settings.

21. Change the DVD drive letter to E: to ensure the correct drive letters are free for the
Contact Center application and database hard disk drives and partitions.

22. Configure the hard disk drives and partitions for this server using the Windows Server
2012 R2 Computer Management - Disk Management utility. For more information about
hard disk drives and partitions, see Avaya Aura® Contact Center Overview and
Specification.

23. Install other required drivers for your hardware configuration.

Job aid: Hard disk drive partitions
Configure the hard disk drives and partitions. These are the minimum hard disk partition sizes. For
more information about hard disk requirements, including the recommended partition sizes, see
Avaya Aura® Contact Center Overview and Specification.

For each partition, specify a volume size in MBs that when formatted results in a disk partition that
is equal to or greater than the required minimum partition size.

Hard disk drive Drive letter Minimum size
partition

Operating System drive

Including the 350 MB Windows boot loader System Reserved
partition.

C: 80 GB NTFS

Application drive D: 120 GB NTFS
DVD drive.

For continuity and consistency, Avaya recommends using Drive
letter E: for the DVD drive. However, Contact Center supports any
DVD Drive letter, other than the Drive letters listed here for the
hard disk partitions.

E: —

Voice Contact Server database drive F: 200 GB NTFS
Multimedia Contact Server database drive G: 300 GB NTFS
Database journal H: 100 GB NTFS

Navigating the Microsoft Windows Server 2012 R2 User
Interface

This section describes how to navigate between the main user interface screens of the Windows
Server 2012 R2 operating system.

Navigating the Microsoft Windows Server 2012 R2 User Interface
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The following table describes some of the main Microsoft Windows Server 2012 R2 user interface
screens.

Screen name Description
Start The Start screen contains shortcuts to the main administration interfaces of the

server. If you have an application that you access on a regular basis, you can
add it to the Start screen so that it's more immediately accessible. The Start
screen displays the currently logged on user and provides some basic server log
out and locking functions. This is the operating system default screen.

Apps The Apps screen contains shortcuts to the applications and utilities installed on
the server. The server applications and utilities are grouped into categories.
Third-party vendors and applications can also add custom, vendor or product
specific, categories to the Apps screen.

Desktop The Desktop screen contains the Windows start button, the Windows Taskbar,
Recycle Bin, and shortcuts to the Windows Explorer utility, among others. The
Taskbar displays the Windows Notification Area and System Tray. The
notification area is located on the right portion of the Taskbar next to the time.

Navigation tips:

• Use the up  and down  arrow icons to navigate between the Start and Apps screens.

• To display the Start screen, on the Desktop screen, click the Windows start button.

• To display the Desktop screen, on the Start screen select the Desktop tile.

• To display the Desktop screen, on the Apps screen select the Desktop tile.

• To switch between the Start screen and the Desktop screen press the Windows start button
on your keyboard.

• To access the Control Panel, on the Apps or Start screen click on the Control Panel tile.

• To access the Administration Tools, on the Apps or Start screen click on the Administrative
Tools tile.

These screen navigation methods work when you are using the server’s keyboard and mouse
directly, or when you are using Remote Desktop to access the server.
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Figure 5: Example of the Start screen, with the down arrow icon highlighted in a red box.
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Figure 6: Example of the Apps screen, with the up arrow icon highlighted in a red box.
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Figure 7: Example of the Desktop screen, with the Windows start button highlighted in a red box.

The following table describes some of the Taskbar sections of the Desktop screen.

Icon Name Description
Windows start button Use the Windows start button to navigate to the Start screen. Use this

button to switch between the Start screen and the Desktop screen.

Server Manager Use this button to access the Server Manager to configure the roles and
features to the server.

PowerShell Use the PowerShell button to start the Windows PowerShell console.
Windows PowerShell is a command-line shell that provides cmdlets
(pronounced command-lets) for server configuration and management.
PowerShell also provides scripting functions for task automation.

This PC Use this button to start the This PC Windows Explorer. Use this to
access and navigate the folders, files, and storage devices on the
server.
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The contents of your screens can vary depending on the roles, features, and applications installed
on your server.

For more information about the Windows Server 2012 R2 operating system, refer to the Microsoft
support website and Microsoft product documentation.

Installing the most recent supported operating system
service packs

Before you begin
• Access the Avaya hotfixes list on the website http://support.avaya.com.
• Install and configure Microsoft Windows Server 2012 R2 on your server.
• Review the specifications on operating system service updates in Avaya Aura® Contact

Center Overview and Specification.

About this task
Avaya recommends that you install the most recent supported operating system service packs.
You must download the supported operating system service pack from the Avaya hotfixes list to
ensure your Contact Center server software functions correctly with the supported operating
system patches.

Procedure
1. Review the Contact Center Service Packs Compatibility and Security Hotfixes Applicability

List to determine the most recent Avaya Aura® Contact Center supported patches or
service packs.

2. Download the appropriate Microsoft Windows Server 2012 R2 patches for the Avaya Aura®

Contact Center software installed on this server.

3. Install the most recent Windows Server 2012 R2 service pack that is validated with Avaya
Aura® Contact Center by following the Microsoft Installation instructions.

Connecting to the contact center subnet
About this task
Connect the Contact Center server to the contact center subnet. The contact center subnet is the
network on which the server software applications work together to route contacts and generate
reports.

Procedure
1. Locate the slot assigned to the contact center subnet network interface card for the server.

Make a note of the slot.
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2. Connect the cable from the contact center subnet to the contact center subnet network
interface card in the server in accordance with customer site networking guidelines.

3. Use the ping command to test the contact center subnet.

Adding a server to a domain
Before you begin

• Ensure that you have domain administrator privileges, or ask the Domain Administrator to
assign you a domain user account for remote access.

• On the server, configure a preferred Domain Name System (DNS) server on the Network
Interface Card (NIC).

About this task
Add the server to an existing domain.

Note:
Add the server to a Windows domain before installing Contact Center software. When joining
the domain, ensure the server time and domain controller time are synchronized to the same
time.

Ask your System Administrator to add a Domain Name System (DNS) static entry for this server.
Each Contact Center server in a domain requires a DNS static entry.
If your solution is going to use High Availability, ask your System Administrator to add one DNS
static entry for each managed name and associated managed IP address. A typical High
Availability campus solution with a pair of servers requires three DNS static entries; one DNS
static entry for the active server, one DNS static entry for the standby server, and one DNS static
entry for the managed name and associated IP address. Avaya Aura® Contact Center High
Availability solutions do not support Windows Server Dynamic DNS.

Procedure
1. Log on to the server.

2. On the Start screen, select Administrative Tools  > Server Manager.
3. In the left pane, select Local Server.
4. In the right pane, in the Properties section, double-click on the Domain value.

The System Properties dialog box appears.

5. In the System Properties dialog box, click the Computer Name tab.

6. Click Change.

7. In the Member of section, click the Domain option.

8. Type the domain name (you must provide the fully qualified domain name, which includes
the prefix and suffix).
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9. Click OK.

10. Type the domain administrator User name and Password.

11. Click OK.

12. Restart the server when you are prompted to do so.

Downloading the most recent Contact Center patches to
the server

Before you begin
• Download and install the most recent and supported updates for Microsoft Windows Server

2012 R2.
• Know the location at which you plan to install each Contact Center server software package.
• Ensure that you use one administrator account on your server to un-install and install

software updates.

About this task
To ensure that you have the most current software, download the most recent Contact Center
patches from http://support.avaya.com to the server you plan to install.

Procedure
1. Log on to the server using the administrator account.

2. Create a folder <Drive>:\Avaya-ProductUpdates\ to save the software updates. Where
<Drive> is the drive letter on which you want to save the Contact Center software updates.

3. Download the most recent service pack file. Save and unzip the file on the Contact Center
server in the Avaya-ProductUpdates folder.

4. If new patches are available for the latest service pack, download and save the patches on
the Contact Center server in the Avaya-ProductUpdates folder.

5. Read the Contact Center Release Notes for the most recent instructions.

Disabling unused Network Adapters
About this task
Disable all unused Network Adapters or Network Interface Cards (NICs) to improve network
communications and prevent the erroneous configuration of unused NICs during Contact Center
server commissioning.
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Procedure
1. Log on to the server.

2. On the Start screen, select Control Panel  > Network and Internet  > Network and
Sharing Center  > Change adapter settings.

3. Right-click on the unused Network Adapter, and select Disable.

4. Repeat this procedure for all unused Network Adapters.

Enabling Microsoft Remote Desktop connection
About this task
Enable Microsoft Remote Desktop connection as your remote access tool. Microsoft Remote
Desktop provides remote access for support on the server.

Procedure
1. Log on to the server with administrator privileges.

2. On the Start screen, select Control Panel  > System and Security.

3. In the System section, select Allow remote access.

4. Click the Remote tab.

5. Select Allow remote connections to this computer.
6. Click Apply.

7. Click OK.

Disabling NetBIOS
About this task
If the Contact Center server uses two Network Interface Cards (NICs), disable NetBIOS on the
Embedded LAN (ELAN) network interface card (NIC) to avoid NetBIOS conflicts.
Contact Center supports two Network Interface Cards (NICs) and two subnets (one contact center
subnet and one ELAN subnet). The Contact Center ELAN NIC and ELAN subnet are optional.

Procedure
1. Log on to the server.

2. On the Start screen, select Control Panel  > Network and Internet.
3. Click Network and Sharing Center.
4. Click Change adapter settings.
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5. Right-click the ELAN Network Interface Card (NIC).

6. Click Properties.

7. Select Internet Protocol Version 4 (TCP/IPv4).
8. Click Properties.

9. Click Advanced.

10. Click the WINS tab.

11. Select the Disable NetBIOS over TCP/IP check box.

12. Click OK.

Connecting the Embedded LAN subnet
Before you begin

• Install two network cards on the Contact Center server.
• Disable the NetBIOS on the ELAN network interface card.
• Connect the contact center subnet network interface card.

About this task
If your server uses two NICs, connect the Embedded LAN (ELAN) NIC to the ELAN subnet.
Contact Center supports two network interface cards (NICs) and two subnets (one contact center
subnet and one ELAN subnet). The Contact Center ELAN NIC and ELAN subnet are optional.

Procedure
1. Locate the slot assigned to the ELAN network interface card for the server.

2. Write the MAC address of the card on a small label. Attach the label to the back of the card
or the chassis slot position.

3. Connect the ELAN subnet from the Avaya equipment to the Ethernet hub.

4. Connect the network cable from the ELAN network interface card in the server to the hub.

5. Plug in the power cord for the hub.

6. If you have an ELAN subnet network connection, use the ping command to test it.

Configuring the binding order
Before you begin

• Install two network interface cards on the Contact Center server.
• Disable the NetBIOS on the ELAN network interface card.
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• Connect the Contact Center server network interface card to the contact center subnet.
• Connect the Contact Center server ELAN network interface card to the ELAN subnet.

About this task
Configure the binding order of the network cards. The contact center subnet network interface
card must be bound first and then the ELAN network interface card.

Procedure
1. On the Start screen, select Control Panel  > Network and Internet  > Network and

Sharing Center.
2. Click Change adapter settings.

3. In the Network Connections window, press the ALT key.

A hidden menu appears.

4. Choose Advanced  > Advanced Settings.

5. In the Connections box, ensure that the contact center subnet connection is listed first. If
it is not listed first, adjust the order.

Disabling Admin Approval Mode for Windows Server
administrators

About this task
Windows Server 2012 implements a security feature known as User Account Control (UAC). By
default, this feature causes applications run by local non built-in administrators to behave as if the
applications had been run by standard users. Perform this procedure to ensure that local
administrators get full privileges for running applications.

Note:
This procedure describes how to disable Admin Approval Mode on the Contact Center server
using one method only; there are additional methods available. For example, you can also
administer User Account Control settings for the Contact Center server using a group policy.

Procedure
1. On the Start screen, select Administrative Tools  > Local Security Policy.

2. Under Security Settings, expand Local Policies.

3. Select Security Options.

4. In the policy pane on the right, double-click on User Account Control: Run all
administrators in Admin Approval Mode.

5. Click the Local Security Setting tab, and select Disabled.

6. Click OK.
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If prompted, restart the server.

Disabling Windows Server 2012 Automatic Maintenance
About this task
Disable Windows Server 2012 R2 Automatic Maintenance while installing Contact Center
software. Windows Server 2012 Automatic Maintenance can occasionally interfere with the real-
time requirements for Contact Center deployment and configuration. You must therefore
temporarily disable Automatic Maintenance to install and configure Contact Center software. You
re-enable Automatic Maintenance after deploying and configuring Contact Center.

Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.
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5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows  > TaskScheduler.

6. In the Name column, right-click Idle Maintenance and select Disable.

7. In the Name column, right-click Regular Maintenance and select Disable.

8. From the File menu, select Exit.

Installing the Voice and Multimedia Contact Server
software for CS1000

Before you begin
• Ensure the Avaya Communication Server 1000 is configured. For more information see

Avaya Aura® Contact Center and Avaya Communication Server 1000 Integration.
• Download the most recent Contact Center and Common Components patches to the server.
• Read the Contact Center Release Notes for the most recent instructions.

About this task
Install the Contact Center Voice and Multimedia Contact Server software on the server.

Procedure
1. Insert the Contact Center DVD into the DVD drive of your server.

2. If the installation does not automatically start, double-click Setup.exe.

3. Click Accept to install the Microsoft .NET Framework on the server.

If you are prompted to accept the Microsoft .NET Framework license agreement, click
Accept. If you are prompted to restart the server, click Yes and repeat step 2.

4. Contact Center software installer runs Operating System and hardware checks on the
server. If the installer returns a Fail, the software installation cannot proceed until you
correct the problem. Review any failures returned by the System Readiness Check and
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consult Avaya Aura® Contact Center Overview and Specification to determine the actions
to resolve the issue.

You can ignore warnings if the potential impact to the operation of the contact center is
understood and not applicable.

5. The Contact Center software installer platform and server selection screen appears.

6. In the Select Voice Platform section, select Avaya Communication Server 1000 - AML.

7. In the Select Server Installation Option section, select Voice and Multimedia Contact
Server without Avaya Aura Media Server.

8. Click Next.
9. Under Journal Database Drive, select the drive for the database journal. The default drive

partition is H:.

10. Under Voice Contact Server Database Drive, select the drive for the Contact Center
Manager Server, Communication Control Toolkit, and Contact Center Manager
Administration databases. The default drive partition is F:.

11. Under Multimedia Contact Server Database Drive, select the drive for the Contact
Center Multimedia database. The default drive partition is G:.

12. In the Service Packs section, browse to and select the Service Pack.
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13. Click Install.
14. The AVAYA GLOBAL SOFTWARE LICENSE TERMS window appears.

15. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
16. The MICROSOFT SOFTWARE LICENSE TERMS window appears.

17. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
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18. The Progress window appears and displays the installation progress.

19. When the software is installed, you have the following options.

• To continue configuring the server installation data:

a. Select Launch Avaya Aura Contact Center Ignition Wizard.

b. Click Configure. This starts the Avaya Aura® Contact Center Ignition Wizard.

• To defer configuring the server installation data:

a. Clear Launch Avaya Aura Contact Center Ignition Wizard.

b. On the message box, click Yes.

c. On the main installer screen, click Close.

d. Follow the on-screen instructions and shut down the Contact Center server.

You must use the Ignition Wizard to initialize Avaya Aura® Contact Center, otherwise
Avaya Aura® Contact Center is not operational. For more information about the Ignition
Wizard, see the following procedures.

Configuring Voice and Multimedia Contact Server software
for CS1000

Before you begin
• Ensure the Avaya Communication Server 1000 is configured. For more information see

Avaya Aura® Contact Center and Avaya Communication Server 1000 Integration.
• You must configure the required language and locale of the Contact Center server operating

system, if it is not a Latin-1 language, before configuring the Contact Center server using the
Contact Center Ignition Wizard. For more information about configuring language and locale
settings on the Contact Center server, see Avaya Aura® Contact Center Server
Administration.

• Download the most recent Contact Center and Common Components patches to the server.
• Read the Contact Center Release Notes for the most recent instructions.

About this task
Configure the Contact Center Voice and Multimedia Contact Server software and enable your
contact center to route contacts to the agents that can answer the call with the correct skills.

Procedure
1. Log on to the Contact Center server using the Administrator account details.

2. On the Contact Center Ignition Wizard screen, click Next. If the Contact Center Ignition
Wizard is not visible, click the Ignition Wizard shortcut on the desktop.
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3. On the End-User License Agreement screen, read the license agreement. Optionally,
click Print to generate a local soft copy (in OpenXPS Document format) of the license
agreement.

4. Select I Accept the Terms of the End-User License Agreement and click Next.
5. On the Configuration Data window, type the configuration details for each tab.

6. Select the Core tab, and configure the server details.

7. In the Site Name box, type the site name for the Contact Center server. The site name
must not contain spaces or non-alphabetical characters except hyphen (-) and underscore
(_). The first character must be a letter. The site name must be unique and can consist of 6
to 15 characters.

8. In the Real-Time Statistics Multicast IP Address box, type the Real-time Statistics
Multicast IP Address of the server to associate with sending real-time data. The IP
Address must be from 224.0.1.0 to 239.255.255.255. The default is 234.5.6.10.

9. In the Network Configuration section, in the ELAN IP Address box, type the IP Address
of the embedded local area network. The embedded local area network (ELAN) is a
dedicated Ethernet LAN that connects Contact Center to the PABX.
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10. In the CLAN IP Address box, type the IP Address of the Contact Center server. This is the
Contact Center server IP address on the subnet that connects to the other servers and
agent client computers in the contact center solution.

11. In the System Account Configuration section, in the Password box, type a password for
the Contact Center administration account. The password is checked against the server
security policy for minimum password requirements. Avaya recommends that you enter a
password that conforms to your corporate password policy.

12. In the Confirm Password box, type the password.

13. Select the Licensing tab, and configure the licensing details.

14. From the License Type list, select Standard KRS.

15. Click Browse to locate and load your license file.

16. From the Licensing Package list, select the license type that you have purchased. Select
Nodal Enterprise for single-site contact centers.

17. From the list of Optional Packages, enable the licensed features that you have
purchased.

18. Select the Open Queue check box.

19. Select the Multimedia tab, and configure the Contact Center Multimedia details.
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20. In the Incoming Mail Server box, type the name of the server on which email messages
are received in your network.

21. From the Protocol list, select the communication protocol for the inbound email server.
Select POP3 or IMAP. The default protocol is POP3.

22. In the Outgoing Mail Server box, type the name of the server from on which email
messages are sent. Your inbound and outbound mail servers can have the same name.

23. Select the CS1000 tab.

24. In the Switch Name box, type the name of the AML Avaya Communication Server 1000
telephone switch. Valid characters for Avaya Communication Server 1000 names are A–Z,
a–z, 0–9, underscore (_), and period (.). Names must begin with an alphabetical character
and cannot contain spaces. The last character must not be an underscore or a period.
Names must not exceed 80 characters in length.

25. In the Switch IP Address box, type the IP address of the Avaya Communication Server
1000.

26. In the Switch Customer Number box, type the customer number for the Avaya
Communication Server 1000.

27. In the Alternative Switch IP Address box, type the IP address of an alternate Avaya
Communication Server 1000, if you have one.
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28. In the Alternative Switch Customer Number box, type the customer number of the
alternate Avaya Communication Server 1000, if you have one.

29. In the Alternative Switch Serial ID box, type the serial number of the alternate Avaya
Communication Server 1000, if you have one.

30. In the Voice Connection Type section, select the method used to connect to the PABX.
Select None, Avaya Aura Experience Portal, or CallPilot.

31. If you are using an Avaya CallPilot® server, enter the Avaya CallPilot® server ELAN IP
Address and then configure the Port to 10008.

32. If you are using Avaya CallPilot® High Availability, in the CPHA Managed CLAN IP
Address box, type the Avaya CallPilot® Managed CLAN IP address.

33. If you are using an Avaya CallPilot® server, in the CLAN IP Address box, type the CLAN
IP address of the Avaya CallPilot® server.

34. Select the Security Configuration tab, and configure the security details in the Security
Store Details section.

35. If you do not want to enable security, select the Skip Security Configuration checkbox
and skip to step 54 on page 87.
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Important:

A warning message appears.

36. In the Full Computer Name (FQDN) box, type the full FQDN of the server on which you
are creating the security store.

Important:

The FQDN must be the full machine name of the server that the Security Store resides
on. The FQDN name is case-sensitive.

37. In the Name of Organizational unit box, type the name of the department or division
within the company.

38. In the Name of Organization box, type the company name.

39. In the City or Locality box, type the name of the city or district in which the contact center
is located.

40. In the State or Province box, type the state or province in which the contact center is
located.

41. In the Two Letter Country Code box, type the country code in which the contact center is
located.

42. In the Security Store password box, type a password for accessing the new security
store.

43. In the Confirm Store password box, confirm the password for accessing the new security
store.

Important:

Ensure you remember this password, because you need it when you log on to Security
Manager after install. If you forget the password, you cannot access Security Manager.

44. If you are implementing High Availability in the contact center, generate the security store
using Subject Alternative Names (SANs). In the Subject Alternative Name section, for
each SAN you want to add:

a. From the Type drop-down list, select DNS.

b. In the Value field, type the FQDN for the server.

c. Click Add.

For a High Availability system, add the current server FQDN and the Managed name for
the HA pair.

45. If you want to change the encryption setting, select the required encryption settings from
the Encryption Algorithm Level and Key Size drop-down lists.

The default value for Encryption Algorithm is SHA256 and the default value for Key Size
is 2048.
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Contact Center displays a warning message if you select SHA1 or 1024. Contact Center
includes these values for backward-compatibility only, because these settings do not meet
the industry-recommended level of encryption.

46. Click Create Store.

47. You can now use the Security Configuration tab to create and save a Certificate Signing
Request (CSR) file.

48. Click Create CSR File.

49. From the Save In drop-down list, select a shared location in which to save the CSR file
and click Save.

You must now send the Certificate Signing Request file to a Certificate Authority and
receive a signed certificate and root certificate to import to the security store.

50. In the Imported Trusted Certificate Authority Root Certificate(s) section, click Add to
import the Certificate Authority root certificate.

51. In the Open dialog box, browse to the location of the certificate and click Open.

52. In the Imported Identity Security Certificate section, click Add to import the Certificate
Authority signed certificate.

53. In the Open dialog box, browse to the location of the certificate and click Open.
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54. Click Next.
55. Review and verify the summary information, and click Configure.

56. After the installation is complete, click Finish.

57. If prompted, restart the server.

Enabling Windows Server 2012 Automatic Maintenance
About this task
Enable Windows Server 2012 R2 Automatic Maintenance after deploying and configuring Contact
Center software.

Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.

5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows > TaskScheduler.

6. In the Name column, right-click Idle Maintenance and select Enable.

7. In the Name column, right-click Regular Maintenance and select Enable.

8. From the File menu, select Exit.
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Securing the Windows server
About this task
Apply optional security measures to your operating system to further secure your server.

Important:
Scanning software can degrade the performance and decrease the reliability of the system.
Install virus scanning software only if the system connects to an exposed network or to the
Internet.

Important:
To maintain server performance, you must schedule virus scans during maintenance periods
or low usage hours only.

Procedure
1. Harden the operating system using defined site procedures.

2. Install antivirus software. If you install antivirus software, Avaya recommends that you
exclude some contact center files and folders from real-time and scheduled scans. For
more information, and for a list of files and folders to exclude, see Avaya Aura® Contact
Center Overview and Specification.

Commissioning the Contact Center server
About this task
Commission the installed Contact Center software.

Procedure
Commission the installed Contact Center software.

For information about commissioning the installed server software, see Avaya Aura® Contact
Center Commissioning for Avaya Communication Server 1000.
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Chapter 8: Standby Voice and Multimedia
Contact Server for CS1000
software installation in a domain

This chapter describes how to install a standby Voice and Multimedia Contact Server for Avaya
Communication Server 1000 (CS1000). This chapter describes how to install a Voice and
Multimedia Contact Server in a solution using a Windows domain. A standby Voice and Multimedia
Contact Server includes the following server software:

• Contact Center Manager Server (CCMS)

• Contact Center Manager Server Utility

• Contact Center License Manager

• Contact Center Manager Administration (CCMA)

• Communication Control Toolkit (CCT)

• Contact Center Multimedia (CCMM)

Contact Center Manager Server supports two Network Interface Cards (NICs) and two subnets (one
contact center subnet and one ELAN subnet). The Contact Center Manager Server ELAN NIC and
ELAN subnet are optional.

You can install a standby Voice and Multimedia Contact Server and commission it to be the standby
Voice and Multimedia Contact Server in a campus High Availability solution. The standby server
takes over contact processing and becomes the active server if the existing active server fails. The
standby server provides High Availability redundancy and resiliency. The standby and active servers
must be at the same patch level and have the same hard disk drive partitions.

You must complete the procedures in this section in sequential order.

Standby Voice and Multimedia Contact Server installation
prerequisites

Procedure
• Copy the most recent patches for the Contact Center software.
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• Ensure that your new Contact Center license file with a High Availability standby server
license is available.

Important:

For the system to correctly handle backup and restore SNMP events, you must install
Windows SNMP Service before you install Contact Center server software.

Installing Microsoft Windows Server 2012 R2
Before you begin

• Ensure that you have a newly formatted server that meets the specifications in Avaya Aura®

Contact Center Overview and Specification on which to install Microsoft Windows Server
2012 R2.
Do not upgrade your operating system from a previous release. Contact Center is not
supported on an upgraded operating system.

• Configure all servers for RAID as described in Avaya Aura® Contact Center Overview and
Specification.

• Ensure that you have a DVD for Microsoft Windows Server 2012 R2 Standard or Data
Center. Ensure that your DVD is the R2 version of Windows Server 2012 Standard or Data
Center.

• Ensure that you have a Microsoft Windows Server 2012 R2 operating system product key.
• Know the IP addresses for the contact center subnet.

About this task
Install the Microsoft Windows Server 2012 R2 Standard or Data Center operating system and
configure it to support Contact Center server software.
The following table lists the main inputs to consider while installing the operating system.

Name Description
Computer name Do not use spaces or underscores or exceed 15 characters. The name must start

with an alphabetic character. Server names must adhere to RFC1123. Avaya
recommends that you configure the server final production name before installing
Contact Center software.

The computer name must match (including case sensitivity) the DNS name.
Disk drives Format the partitions as required for the server. For more information, see Avaya

Aura® Contact Center Overview and Specification.
Domain name Configure as required for your site.

You must check to ensure the DNS Domain name (including case) matches the
server name if the server is added to a domain after configuration.

Licensing modes Select Per server licensing mode.
Table continues…
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Name Description
Accept the default five concurrent connections.

Network components Configure IP Address, WINS, DNS for one or two network cards as per
configuration. Contact Center does not support IPv6.

Network connections If the server has more than one NIC/adapter, ensure contact center subnet
appears first in the network adapter binding order.

Hard Disk Partitions Configure C: drive to be a primary drive. Configure the other drives on your server
to meet the requirements according to Avaya Aura® Contact Center Overview and
Specification for the server.

Perform this procedure on each server before you install Contact Center server software on the
server.

Procedure
1. Insert the Microsoft Windows Server 2012 R2 Standard or Data Center DVD into the DVD

drive.

2. Turn on the power to the server.

The server begins to boot up.

3. On the Windows Setup screen, select a Language to install from the list.

4. Select a Time and currency format from the list.

5. Select Keyboard or input method from the list.

6. Click Next.
7. Click Install now.

8. Depending on the DVD image that you use, you might need to select an operating system
from a list. Select a version of Windows Server 2012 R2 Standard or Data Center that
includes a Graphical User Interface (GUI). Install a version that includes “(Server with a
GUI)”.

9. Click Next.
10. On the Enter the product key to activate Windows window, enter the operating system

product key.

11. Click Next.
12. On the Windows Setup screen, read the terms of the license agreement and select I

accept the license terms.

13. Click Next.
14. Select Custom: Install Windows only (advanced) to install a clean new installation of the

operating system.

15. Select the disk partition on which you want to install Windows Server 2012 R2.

Installing Microsoft Windows Server 2012 R2
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Important:

You can use the partition management options to configure the partitions on your
server.

16. Click Next.

The installation proceeds and automatically restarts the server several times.

17. After completing the installation, log on to the server as Administrator. Enter and confirm
the Administrator password.

18. Select Set time zone and complete the information as required for your system.

19. Select Configure Networking and complete the information for your Network Interface
Card (NIC) with the server IP address.

20. Select Provide computer name and domain and complete the information for your server
name and network settings.

21. Change the DVD drive letter to E: to ensure the correct drive letters are free for the
Contact Center application and database hard disk drives and partitions.

22. Configure the hard disk drives and partitions for this server using the Windows Server
2012 R2 Computer Management - Disk Management utility. For more information about
hard disk drives and partitions, see Avaya Aura® Contact Center Overview and
Specification.

23. Install other required drivers for your hardware configuration.

Job aid: Hard disk drive partitions
Configure the hard disk drives and partitions. These are the minimum hard disk partition sizes. For
more information about hard disk requirements, including the recommended partition sizes, see
Avaya Aura® Contact Center Overview and Specification.

For each partition, specify a volume size in MBs that when formatted results in a disk partition that
is equal to or greater than the required minimum partition size.

Hard disk drive Drive letter Minimum size
partition

Operating System drive

Including the 350 MB Windows boot loader System Reserved
partition.

C: 80 GB NTFS

Application drive D: 120 GB NTFS
DVD drive.

For continuity and consistency, Avaya recommends using Drive
letter E: for the DVD drive. However, Contact Center supports any

E: —

Table continues…
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Hard disk drive Drive letter Minimum size
partition

DVD Drive letter, other than the Drive letters listed here for the
hard disk partitions.
Voice Contact Server database drive F: 200 GB NTFS
Multimedia Contact Server database drive G: 300 GB NTFS
Database journal H: 100 GB NTFS

Installing the most recent supported operating system
service packs

Before you begin
• Access the Avaya hotfixes list on the website http://support.avaya.com.
• Install and configure Microsoft Windows Server 2012 R2 on your server.
• Review the specifications on operating system service updates in Avaya Aura® Contact

Center Overview and Specification.

About this task
Avaya recommends that you install the most recent supported operating system service packs.
You must download the supported operating system service pack from the Avaya hotfixes list to
ensure your Contact Center server software functions correctly with the supported operating
system patches.

Procedure
1. Review the Contact Center Service Packs Compatibility and Security Hotfixes Applicability

List to determine the most recent Avaya Aura® Contact Center supported patches or
service packs.

2. Download the appropriate Microsoft Windows Server 2012 R2 patches for the Avaya Aura®

Contact Center software installed on this server.

3. Install the most recent Windows Server 2012 R2 service pack that is validated with Avaya
Aura® Contact Center by following the Microsoft Installation instructions.

Connecting to the contact center subnet
About this task
Connect the Contact Center server to the contact center subnet. The contact center subnet is the
network on which the server software applications work together to route contacts and generate
reports.

Installing the most recent supported operating system service packs
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Procedure
1. Locate the slot assigned to the contact center subnet network interface card for the server.

Make a note of the slot.

2. Connect the cable from the contact center subnet to the contact center subnet network
interface card in the server in accordance with customer site networking guidelines.

3. Use the ping command to test the contact center subnet.

Adding a server to a domain
Before you begin

• Ensure that you have domain administrator privileges, or ask the Domain Administrator to
assign you a domain user account for remote access.

• On the server, configure a preferred Domain Name System (DNS) server on the Network
Interface Card (NIC).

About this task
Add the server to an existing domain.

Note:
Add the server to a Windows domain before installing Contact Center software. When joining
the domain, ensure the server time and domain controller time are synchronized to the same
time.

Ask your System Administrator to add a Domain Name System (DNS) static entry for this server.
Each Contact Center server in a domain requires a DNS static entry.
If your solution is going to use High Availability, ask your System Administrator to add one DNS
static entry for each managed name and associated managed IP address. A typical High
Availability campus solution with a pair of servers requires three DNS static entries; one DNS
static entry for the active server, one DNS static entry for the standby server, and one DNS static
entry for the managed name and associated IP address. Avaya Aura® Contact Center High
Availability solutions do not support Windows Server Dynamic DNS.

Procedure
1. Log on to the server.

2. On the Start screen, select Administrative Tools  > Server Manager.
3. In the left pane, select Local Server.
4. In the right pane, in the Properties section, double-click on the Domain value.

The System Properties dialog box appears.

5. In the System Properties dialog box, click the Computer Name tab.

6. Click Change.
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7. In the Member of section, click the Domain option.

8. Type the domain name (you must provide the fully qualified domain name, which includes
the prefix and suffix).

9. Click OK.

10. Type the domain administrator User name and Password.

11. Click OK.

12. Restart the server when you are prompted to do so.

Disabling unused Network Adapters
About this task
Disable all unused Network Adapters or Network Interface Cards (NICs) to improve network
communications and prevent the erroneous configuration of unused NICs during Contact Center
server commissioning.

Procedure
1. Log on to the server.

2. On the Start screen, select Control Panel  > Network and Internet  > Network and
Sharing Center  > Change adapter settings.

3. Right-click on the unused Network Adapter, and select Disable.

4. Repeat this procedure for all unused Network Adapters.

Enabling Microsoft Remote Desktop connection
About this task
Enable Microsoft Remote Desktop connection as your remote access tool. Microsoft Remote
Desktop provides remote access for support on the server.

Procedure
1. Log on to the server with administrator privileges.

2. On the Start screen, select Control Panel  > System and Security.

3. In the System section, select Allow remote access.

4. Click the Remote tab.

5. Select Allow remote connections to this computer.
6. Click Apply.

Disabling unused Network Adapters
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7. Click OK.

Disabling NetBIOS
About this task
If the Contact Center server uses two Network Interface Cards (NICs), disable NetBIOS on the
Embedded LAN (ELAN) network interface card (NIC) to avoid NetBIOS conflicts.
Contact Center supports two Network Interface Cards (NICs) and two subnets (one contact center
subnet and one ELAN subnet). The Contact Center ELAN NIC and ELAN subnet are optional.

Procedure
1. Log on to the server.

2. On the Start screen, select Control Panel  > Network and Internet.
3. Click Network and Sharing Center.
4. Click Change adapter settings.

5. Right-click the ELAN Network Interface Card (NIC).

6. Click Properties.

7. Select Internet Protocol Version 4 (TCP/IPv4).
8. Click Properties.

9. Click Advanced.

10. Click the WINS tab.

11. Select the Disable NetBIOS over TCP/IP check box.

12. Click OK.

Connecting the Embedded LAN subnet
Before you begin

• Install two network cards on the Contact Center server.
• Disable the NetBIOS on the ELAN network interface card.
• Connect the contact center subnet network interface card.

About this task
If your server uses two NICs, connect the Embedded LAN (ELAN) NIC to the ELAN subnet.
Contact Center supports two network interface cards (NICs) and two subnets (one contact center
subnet and one ELAN subnet). The Contact Center ELAN NIC and ELAN subnet are optional.
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Procedure
1. Locate the slot assigned to the ELAN network interface card for the server.

2. Write the MAC address of the card on a small label. Attach the label to the back of the card
or the chassis slot position.

3. Connect the ELAN subnet from the Avaya equipment to the Ethernet hub.

4. Connect the network cable from the ELAN network interface card in the server to the hub.

5. Plug in the power cord for the hub.

6. If you have an ELAN subnet network connection, use the ping command to test it.

Configuring the binding order
Before you begin

• Install two network interface cards on the Contact Center server.
• Disable the NetBIOS on the ELAN network interface card.
• Connect the Contact Center server network interface card to the contact center subnet.
• Connect the Contact Center server ELAN network interface card to the ELAN subnet.

About this task
Configure the binding order of the network cards. The contact center subnet network interface
card must be bound first and then the ELAN network interface card.

Procedure
1. On the Start screen, select Control Panel  > Network and Internet  > Network and

Sharing Center.
2. Click Change adapter settings.

3. In the Network Connections window, press the ALT key.

A hidden menu appears.

4. Choose Advanced  > Advanced Settings.

5. In the Connections box, ensure that the contact center subnet connection is listed first. If
it is not listed first, adjust the order.

Configuring the binding order
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Disabling Admin Approval Mode for Windows Server
administrators

About this task
Windows Server 2012 implements a security feature known as User Account Control (UAC). By
default, this feature causes applications run by local non built-in administrators to behave as if the
applications had been run by standard users. Perform this procedure to ensure that local
administrators get full privileges for running applications.

Note:
This procedure describes how to disable Admin Approval Mode on the Contact Center server
using one method only; there are additional methods available. For example, you can also
administer User Account Control settings for the Contact Center server using a group policy.

Procedure
1. On the Start screen, select Administrative Tools  > Local Security Policy.

2. Under Security Settings, expand Local Policies.

3. Select Security Options.

4. In the policy pane on the right, double-click on User Account Control: Run all
administrators in Admin Approval Mode.

5. Click the Local Security Setting tab, and select Disabled.

6. Click OK.

If prompted, restart the server.
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Disabling Windows Server 2012 Automatic Maintenance
About this task
Disable Windows Server 2012 R2 Automatic Maintenance while installing Contact Center
software. Windows Server 2012 Automatic Maintenance can occasionally interfere with the real-
time requirements for Contact Center deployment and configuration. You must therefore
temporarily disable Automatic Maintenance to install and configure Contact Center software. You
re-enable Automatic Maintenance after deploying and configuring Contact Center.

Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.

5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows  > TaskScheduler.
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6. In the Name column, right-click Idle Maintenance and select Disable.

7. In the Name column, right-click Regular Maintenance and select Disable.

8. From the File menu, select Exit.

Installing the Voice and Multimedia Contact Server
software for CS1000

Before you begin
• Ensure the Avaya Communication Server 1000 is configured. For more information see

Avaya Aura® Contact Center and Avaya Communication Server 1000 Integration.
• Download the most recent Contact Center and Common Components patches to the server.
• Read the Contact Center Release Notes for the most recent instructions.

About this task
Install the Contact Center Voice and Multimedia Contact Server software on the server.

Procedure
1. Insert the Contact Center DVD into the DVD drive of your server.

2. If the installation does not automatically start, double-click Setup.exe.

3. Click Accept to install the Microsoft .NET Framework on the server.

If you are prompted to accept the Microsoft .NET Framework license agreement, click
Accept. If you are prompted to restart the server, click Yes and repeat step 2.

4. Contact Center software installer runs Operating System and hardware checks on the
server. If the installer returns a Fail, the software installation cannot proceed until you
correct the problem. Review any failures returned by the System Readiness Check and
consult Avaya Aura® Contact Center Overview and Specification to determine the actions
to resolve the issue.
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You can ignore warnings if the potential impact to the operation of the contact center is
understood and not applicable.

5. The Contact Center software installer platform and server selection screen appears.

6. In the Select Voice Platform section, select Avaya Communication Server 1000 - AML.

7. In the Select Server Installation Option section, select Voice and Multimedia Contact
Server without Avaya Aura Media Server.

8. Click Next.
9. Under Journal Database Drive, select the drive for the database journal. The default drive

partition is H:.

10. Under Voice Contact Server Database Drive, select the drive for the Contact Center
Manager Server, Communication Control Toolkit, and Contact Center Manager
Administration databases. The default drive partition is F:.

11. Under Multimedia Contact Server Database Drive, select the drive for the Contact
Center Multimedia database. The default drive partition is G:.

12. In the Service Packs section, browse to and select the Service Pack.
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13. Click Install.
14. The AVAYA GLOBAL SOFTWARE LICENSE TERMS window appears.

15. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
16. The MICROSOFT SOFTWARE LICENSE TERMS window appears.

17. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
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18. The Progress window appears and displays the installation progress.

19. When the software is installed, you have the following options.

• To continue configuring the server installation data:

a. Select Launch Avaya Aura Contact Center Ignition Wizard.

b. Click Configure. This starts the Avaya Aura® Contact Center Ignition Wizard.

• To defer configuring the server installation data:

a. Clear Launch Avaya Aura Contact Center Ignition Wizard.

b. On the message box, click Yes.

c. On the main installer screen, click Close.

d. Follow the on-screen instructions and shut down the Contact Center server.

You must use the Ignition Wizard to initialize Avaya Aura® Contact Center, otherwise
Avaya Aura® Contact Center is not operational. For more information about the Ignition
Wizard, see the following procedures.

Configuring the standby Voice and Multimedia Contact
Server software for CS1000

Before you begin
• Ensure the Avaya Communication Server 1000 is configured. For more information see

Avaya Aura® Contact Center and Avaya Communication Server 1000 Integration.
• You must configure the required language and locale of the Contact Center server operating

system, if it is not a Latin-1 language, before configuring the Contact Center server using the
Contact Center Ignition Wizard. For more information about configuring language and locale
settings on the Contact Center server, see Avaya Aura® Contact Center Server
Administration.

• Download the most recent Contact Center and Common Components patches to the server.
• Read the Contact Center Release Notes for the most recent instructions.

About this task
Configure the Contact Center Voice and Multimedia Contact Server software to provide a resilient
solution.

Procedure
1. Log on to the Contact Center server using the Administrator account details.

2. On the Contact Center Ignition Wizard screen, click Next. If the Contact Center Ignition
Wizard is not visible, click the Ignition Wizard shortcut on the desktop.
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3. On the End-User License Agreement screen, read the license agreement. Optionally,
click Print to generate a local soft copy (in OpenXPS Document format) of the license
agreement.

4. Select I Accept the Terms of the End-User License Agreement and click Next.
5. On the Configuration Data window, type the configuration details for each tab.

6. Select the Core tab, and configure the server details.

7. In the Site Name box, type the site name for the Contact Center server. The site name
must not contain spaces or non-alphabetical characters except hyphen (-) and underscore
(_). The first character must be a letter. The site name must be unique and can consist of 6
to 15 characters. The Site Name of the standby server must be the same as the Site Name
of the primary server.

8. In the Real-Time Statistics Multicast IP Address box, type the Real-time Statistics
Multicast IP Address of the server to associate with sending real-time data. The IP
Address must be from 224.0.1.0 to 239.255.255.255. The default is 234.5.6.10.

9. In the Network Configuration section, in the ELAN IP Address box, type the IP Address
of the embedded local area network. The embedded local area network (ELAN) is a
dedicated Ethernet LAN that connects Contact Center to the PABX.
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10. In the CLAN IP Address box, type the IP Address of the Contact Center server. This is the
Contact Center server IP address on the subnet that connects to the other servers and
agent client computers in the contact center solution.

11. In the System Account Configuration section, in the Password box, type a password for
the Contact Center administration account. The password is checked against the server
security policy for minimum password requirements. Avaya recommends that you enter a
password that conforms to your corporate password policy.

12. In the Confirm Password box, type the password.

13. Select the Licensing tab, and configure the licensing details.

14. From the License Type list, select Standard KRS.

15. Click Browse to locate and load your license file.

16. From the Licensing Package list, select the license type that you have purchased. Select
Nodal Enterprise for single-site contact centers.

17. From the list of Optional Packages, enable the licensed features that you have
purchased.

18. Select the Open Queue check box.

19. Select the Multimedia tab, and configure the Contact Center Multimedia details.
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20. In the Incoming Mail Server box, type the name of the server on which email messages
are received in your network.

21. From the Protocol list, select the communication protocol for the inbound email server.
Select POP3 or IMAP. The default protocol is POP3.

22. In the Outgoing Mail Server box, type the name of the server from on which email
messages are sent. Your inbound and outbound mail servers can have the same name.

23. Select the CS1000 tab.

24. In the Switch Name box, type the name of the AML Avaya Communication Server 1000
telephone switch. Valid characters for Avaya Communication Server 1000 names are A–Z,
a–z, 0–9, underscore (_), and period (.). Names must begin with an alphabetical character
and cannot contain spaces. The last character must not be an underscore or a period.
Names must not exceed 80 characters in length.

25. In the Switch IP Address box, type the IP address of the Avaya Communication Server
1000.

26. In the Switch Customer Number box, type the customer number for the Avaya
Communication Server 1000.

27. In the Alternative Switch IP Address box, type the IP address of an alternate Avaya
Communication Server 1000, if you have one.
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28. In the Alternative Switch Customer Number box, type the customer number of the
alternate Avaya Communication Server 1000, if you have one.

29. In the Alternative Switch Serial ID box, type the serial number of the alternate Avaya
Communication Server 1000, if you have one.

30. In the Voice Connection Type section, select the method used to connect to the PABX.
Select None, Avaya Aura Experience Portal, or CallPilot.

31. If you are using an Avaya CallPilot® server, enter the Avaya CallPilot® server ELAN IP
Address and then configure the Port to 10008.

32. If you are using Avaya CallPilot® High Availability, in the CPHA Managed CLAN IP
Address box, type the Avaya CallPilot® Managed CLAN IP address.

33. If you are using an Avaya CallPilot® server, in the CLAN IP Address box, type the CLAN
IP address of the Avaya CallPilot® server.

34. Select the Security Configuration tab, and configure the security details in the Security
Store Details section.

35. If you do not want to enable security, select the Skip Security Configuration checkbox
and skip to step 54 on page 110.
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Important:

A warning message appears.

36. In the Full Computer Name (FQDN) box, type the full FQDN of the server on which you
are creating the security store.

Important:

The FQDN must be the full machine name of the server that the Security Store resides
on. The FQDN name is case-sensitive.

37. In the Name of Organizational unit box, type the name of the department or division
within the company.

38. In the Name of Organization box, type the company name.

39. In the City or Locality box, type the name of the city or district in which the contact center
is located.

40. In the State or Province box, type the state or province in which the contact center is
located.

41. In the Two Letter Country Code box, type the country code in which the contact center is
located.

42. In the Security Store password box, type a password for accessing the new security
store.

43. In the Confirm Store password box, confirm the password for accessing the new security
store.

Important:

Ensure you remember this password, because you need it when you log on to Security
Manager after install. If you forget the password, you cannot access Security Manager.

44. If you are implementing High Availability in the contact center, generate the security store
using Subject Alternative Names (SANs). In the Subject Alternative Name section, for
each SAN you want to add:

a. From the Type drop-down list, select DNS.

b. In the Value field, type the FQDN for the server.

c. Click Add.

For a High Availability system, add the current server FQDN and the Managed name for
the HA pair.

45. If you want to change the encryption setting, select the required encryption settings from
the Encryption Algorithm Level and Key Size drop-down lists.

The default value for Encryption Algorithm is SHA256 and the default value for Key Size
is 2048.
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Contact Center displays a warning message if you select SHA1 or 1024. Contact Center
includes these values for backward-compatibility only, because these settings do not meet
the industry-recommended level of encryption.

46. Click Create Store.

47. You can now use the Security Configuration tab to create and save a Certificate Signing
Request (CSR) file.

48. Click Create CSR File.

49. From the Save In drop-down list, select a shared location in which to save the CSR file
and click Save.

You must now send the Certificate Signing Request file to a Certificate Authority and
receive a signed certificate and root certificate to import to the security store.

50. In the Imported Trusted Certificate Authority Root Certificate(s) section, click Add to
import the Certificate Authority root certificate.

51. In the Open dialog box, browse to the location of the certificate and click Open.

52. In the Imported Identity Security Certificate section, click Add to import the Certificate
Authority signed certificate.

53. In the Open dialog box, browse to the location of the certificate and click Open.
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54. Click Next.
55. Review and verify the summary information, and click Configure.

56. After the installation is complete, click Finish.

57. If prompted, restart the server.

Enabling Windows Server 2012 Automatic Maintenance
About this task
Enable Windows Server 2012 R2 Automatic Maintenance after deploying and configuring Contact
Center software.

Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.

5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows > TaskScheduler.

6. In the Name column, right-click Idle Maintenance and select Enable.

7. In the Name column, right-click Regular Maintenance and select Enable.

8. From the File menu, select Exit.
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Securing the Windows server
About this task
Apply optional security measures to your operating system to further secure your server.

Important:
Scanning software can degrade the performance and decrease the reliability of the system.
Install virus scanning software only if the system connects to an exposed network or to the
Internet.

Important:
To maintain server performance, you must schedule virus scans during maintenance periods
or low usage hours only.

Procedure
1. Harden the operating system using defined site procedures.

2. Install antivirus software. If you install antivirus software, Avaya recommends that you
exclude some contact center files and folders from real-time and scheduled scans. For
more information, and for a list of files and folders to exclude, see Avaya Aura® Contact
Center Overview and Specification.

Commissioning the Contact Center server
About this task
Commission the installed Contact Center software.

Procedure
Commission the installed Contact Center software.

For information about commissioning the installed server software, see Avaya Aura® Contact
Center Commissioning for Avaya Communication Server 1000.
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Chapter 9: RGN Voice and Multimedia
Contact Server for CS1000
installation

This chapter describes how to install a Remote Geographic Node (RGN) Voice and Multimedia
Contact Server in a solution with an Avaya Communication Server 1000 (CS1000) platform. A Voice
and Multimedia Contact Server includes the following server software:

• Contact Center Manager Server (CCMS)

• Contact Center Manager Server Utility

• Contact Center License Manager

• Contact Center Manager Administration (CCMA)

• Communication Control Toolkit (CCT)

• Contact Center Multimedia (CCMM)

Install a Voice and Multimedia Contact Server and commission it to be the Remote Geographic
Node (RGN) Voice and Multimedia Contact Server in a solution with Disaster Recovery. The
Remote Geographic Node server shadows the active server. Remote Geographic Node servers do
not automatically take over if the active server fails. The standby server, Remote Geographic Node
server, and active server must be at the same patch level and have the same hard disk drive
partitions.

You can change the name of a Contact Center server, but because this is time consuming, Avaya
recommends that you configure the server final production name before installing Contact Center
software.

If you plan to follow the Microsoft server hardening guidelines, complete those procedures before
installing Avaya Aura® Contact Center.

You can use any account with local administrative rights to install Avaya Aura® Contact Center. You
can use any account with local administrative rights to upgrade and patch Avaya Aura® Contact
Center; you do not need to always use the same account to perform these tasks.

Important:

You must disable the Admin Approval Mode security feature on the Contact Center server. This
ensures that accounts with local administrative rights get full privileges for running applications
on the Contact Center server.
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Voice and Multimedia Contact Server supports two Network Interface Cards (NICs) and two subnets
(one contact center subnet and one ELAN subnet). The Voice and Multimedia Contact Server ELAN
NIC and ELAN subnet are optional.

You must complete all the procedures in this section in sequential order.

Voice and Multimedia Contact Server installation
prerequisites

Procedure
• Copy the most recent patches for the Contact Center software.

• Ensure that your new Contact Center license file is available.

Important:

For the system to correctly handle backup and restore SNMP events, you must install
Windows SNMP Service before you install Contact Center server software.

Installing Microsoft Windows Server 2012 R2
Before you begin

• Ensure that you have a newly formatted server that meets the specifications in Avaya Aura®

Contact Center Overview and Specification on which to install Microsoft Windows Server
2012 R2.
Do not upgrade your operating system from a previous release. Contact Center is not
supported on an upgraded operating system.

• Configure all servers for RAID as described in Avaya Aura® Contact Center Overview and
Specification.

• Ensure that you have a DVD for Microsoft Windows Server 2012 R2 Standard or Data
Center. Ensure that your DVD is the R2 version of Windows Server 2012 Standard or Data
Center.

• Ensure that you have a Microsoft Windows Server 2012 R2 operating system product key.
• Know the IP addresses for the contact center subnet.

About this task
Install the Microsoft Windows Server 2012 R2 Standard or Data Center operating system and
configure it to support Contact Center server software.
The following table lists the main inputs to consider while installing the operating system.
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Name Description
Computer name Do not use spaces or underscores or exceed 15 characters. The name must start

with an alphabetic character. Server names must adhere to RFC1123. Avaya
recommends that you configure the server final production name before installing
Contact Center software.

The computer name must match (including case sensitivity) the DNS name.
Disk drives Format the partitions as required for the server. For more information, see Avaya

Aura® Contact Center Overview and Specification.
Domain name Configure as required for your site.

You must check to ensure the DNS Domain name (including case) matches the
server name if the server is added to a domain after configuration.

Licensing modes Select Per server licensing mode.

Accept the default five concurrent connections.
Network components Configure IP Address, WINS, DNS for one or two network cards as per

configuration. Contact Center does not support IPv6.
Network connections If the server has more than one NIC/adapter, ensure contact center subnet

appears first in the network adapter binding order.
Hard Disk Partitions Configure C: drive to be a primary drive. Configure the other drives on your server

to meet the requirements according to Avaya Aura® Contact Center Overview and
Specification for the server.

Perform this procedure on each server before you install Contact Center server software on the
server.

Procedure
1. Insert the Microsoft Windows Server 2012 R2 Standard or Data Center DVD into the DVD

drive.

2. Turn on the power to the server.

The server begins to boot up.

3. On the Windows Setup screen, select a Language to install from the list.

4. Select a Time and currency format from the list.

5. Select Keyboard or input method from the list.

6. Click Next.
7. Click Install now.

8. Depending on the DVD image that you use, you might need to select an operating system
from a list. Select a version of Windows Server 2012 R2 Standard or Data Center that
includes a Graphical User Interface (GUI). Install a version that includes “(Server with a
GUI)”.

9. Click Next.
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10. On the Enter the product key to activate Windows window, enter the operating system
product key.

11. Click Next.
12. On the Windows Setup screen, read the terms of the license agreement and select I

accept the license terms.

13. Click Next.
14. Select Custom: Install Windows only (advanced) to install a clean new installation of the

operating system.

15. Select the disk partition on which you want to install Windows Server 2012 R2.

Important:

You can use the partition management options to configure the partitions on your
server.

16. Click Next.

The installation proceeds and automatically restarts the server several times.

17. After completing the installation, log on to the server as Administrator. Enter and confirm
the Administrator password.

18. Select Set time zone and complete the information as required for your system.

19. Select Configure Networking and complete the information for your Network Interface
Card (NIC) with the server IP address.

20. Select Provide computer name and domain and complete the information for your server
name and network settings.

21. Change the DVD drive letter to E: to ensure the correct drive letters are free for the
Contact Center application and database hard disk drives and partitions.

22. Configure the hard disk drives and partitions for this server using the Windows Server
2012 R2 Computer Management - Disk Management utility. For more information about
hard disk drives and partitions, see Avaya Aura® Contact Center Overview and
Specification.

23. Install other required drivers for your hardware configuration.

Job aid: Hard disk drive partitions
Configure the hard disk drives and partitions. These are the minimum hard disk partition sizes. For
more information about hard disk requirements, including the recommended partition sizes, see
Avaya Aura® Contact Center Overview and Specification.

For each partition, specify a volume size in MBs that when formatted results in a disk partition that
is equal to or greater than the required minimum partition size.
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Hard disk drive Drive letter Minimum size
partition

Operating System drive

Including the 350 MB Windows boot loader System Reserved
partition.

C: 80 GB NTFS

Application drive D: 120 GB NTFS
DVD drive.

For continuity and consistency, Avaya recommends using Drive
letter E: for the DVD drive. However, Contact Center supports any
DVD Drive letter, other than the Drive letters listed here for the
hard disk partitions.

E: —

Voice Contact Server database drive F: 200 GB NTFS
Multimedia Contact Server database drive G: 300 GB NTFS
Database journal H: 100 GB NTFS

Installing the most recent supported operating system
service packs

Before you begin
• Access the Avaya hotfixes list on the website http://support.avaya.com.
• Install and configure Microsoft Windows Server 2012 R2 on your server.
• Review the specifications on operating system service updates in Avaya Aura® Contact

Center Overview and Specification.

About this task
Avaya recommends that you install the most recent supported operating system service packs.
You must download the supported operating system service pack from the Avaya hotfixes list to
ensure your Contact Center server software functions correctly with the supported operating
system patches.

Procedure
1. Review the Contact Center Service Packs Compatibility and Security Hotfixes Applicability

List to determine the most recent Avaya Aura® Contact Center supported patches or
service packs.

2. Download the appropriate Microsoft Windows Server 2012 R2 patches for the Avaya Aura®

Contact Center software installed on this server.

3. Install the most recent Windows Server 2012 R2 service pack that is validated with Avaya
Aura® Contact Center by following the Microsoft Installation instructions.
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Connecting to the geographic node network
About this task
Connect the Contact Center server to the geographic node network. The geographic node network
is the network at the remote geographic site.

Procedure
1. Locate the slot assigned to the geographic node network interface card for the server.

Make a note of the slot.

2. Connect the cable from the geographic node network to the geographic node network
interface card in the server in accordance with customer site networking guidelines.

3. Use the ping command to test the geographic node network.

4. Use the ping command to test connectivity with the campus network and servers.

Adding a server to a domain
Before you begin

• Ensure that you have domain administrator privileges, or ask the Domain Administrator to
assign you a domain user account for remote access.

• On the server, configure a preferred Domain Name System (DNS) server on the Network
Interface Card (NIC).

About this task
Add the server to an existing domain.

Note:
Add the server to a Windows domain before installing Contact Center software. When joining
the domain, ensure the server time and domain controller time are synchronized to the same
time.

Ask your System Administrator to add a Domain Name System (DNS) static entry for this server.
Each Contact Center server in a domain requires a DNS static entry.
If your solution is going to use High Availability, ask your System Administrator to add one DNS
static entry for each managed name and associated managed IP address. A typical High
Availability campus solution with a pair of servers requires three DNS static entries; one DNS
static entry for the active server, one DNS static entry for the standby server, and one DNS static
entry for the managed name and associated IP address. Avaya Aura® Contact Center High
Availability solutions do not support Windows Server Dynamic DNS.

Procedure
1. Log on to the server.

2. On the Start screen, select Administrative Tools  > Server Manager.
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3. In the left pane, select Local Server.
4. In the right pane, in the Properties section, double-click on the Domain value.

The System Properties dialog box appears.

5. In the System Properties dialog box, click the Computer Name tab.

6. Click Change.

7. In the Member of section, click the Domain option.

8. Type the domain name (you must provide the fully qualified domain name, which includes
the prefix and suffix).

9. Click OK.

10. Type the domain administrator User name and Password.

11. Click OK.

12. Restart the server when you are prompted to do so.

Downloading the most recent Contact Center patches to
the server

Before you begin
• Download and install the most recent and supported updates for Microsoft Windows Server

2012 R2.
• Know the location at which you plan to install each Contact Center server software package.
• Ensure that you use one administrator account on your server to un-install and install

software updates.

About this task
To ensure that you have the most current software, download the most recent Contact Center
patches from http://support.avaya.com to the server you plan to install.

Procedure
1. Log on to the server using the administrator account.

2. Create a folder <Drive>:\Avaya-ProductUpdates\ to save the software updates. Where
<Drive> is the drive letter on which you want to save the Contact Center software updates.

3. Download the most recent service pack file. Save and unzip the file on the Contact Center
server in the Avaya-ProductUpdates folder.

4. If new patches are available for the latest service pack, download and save the patches on
the Contact Center server in the Avaya-ProductUpdates folder.

5. Read the Contact Center Release Notes for the most recent instructions.
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Disabling unused Network Adapters
About this task
Disable all unused Network Adapters or Network Interface Cards (NICs) to improve network
communications and prevent the erroneous configuration of unused NICs during Contact Center
server commissioning.

Procedure
1. Log on to the server.

2. On the Start screen, select Control Panel  > Network and Internet  > Network and
Sharing Center  > Change adapter settings.

3. Right-click on the unused Network Adapter, and select Disable.

4. Repeat this procedure for all unused Network Adapters.

Enabling Microsoft Remote Desktop connection
About this task
Enable Microsoft Remote Desktop connection as your remote access tool. Microsoft Remote
Desktop provides remote access for support on the server.

Procedure
1. Log on to the server with administrator privileges.

2. On the Start screen, select Control Panel  > System and Security.

3. In the System section, select Allow remote access.

4. Click the Remote tab.

5. Select Allow remote connections to this computer.
6. Click Apply.

7. Click OK.

Disabling NetBIOS
About this task
If the Contact Center server uses two Network Interface Cards (NICs), disable NetBIOS on the
Embedded LAN (ELAN) network interface card (NIC) to avoid NetBIOS conflicts.
Contact Center supports two Network Interface Cards (NICs) and two subnets (one contact center
subnet and one ELAN subnet). The Contact Center ELAN NIC and ELAN subnet are optional.
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Procedure
1. Log on to the server.

2. On the Start screen, select Control Panel  > Network and Internet.
3. Click Network and Sharing Center.
4. Click Change adapter settings.

5. Right-click the ELAN Network Interface Card (NIC).

6. Click Properties.

7. Select Internet Protocol Version 4 (TCP/IPv4).
8. Click Properties.

9. Click Advanced.

10. Click the WINS tab.

11. Select the Disable NetBIOS over TCP/IP check box.

12. Click OK.

Connecting the Embedded LAN subnet
Before you begin

• Install two network cards on the Contact Center server.
• Disable the NetBIOS on the ELAN network interface card.
• Connect the contact center subnet network interface card.

About this task
If your server uses two NICs, connect the Embedded LAN (ELAN) NIC to the ELAN subnet.
Contact Center supports two network interface cards (NICs) and two subnets (one contact center
subnet and one ELAN subnet). The Contact Center ELAN NIC and ELAN subnet are optional.

Procedure
1. Locate the slot assigned to the ELAN network interface card for the server.

2. Write the MAC address of the card on a small label. Attach the label to the back of the card
or the chassis slot position.

3. Connect the ELAN subnet from the Avaya equipment to the Ethernet hub.

4. Connect the network cable from the ELAN network interface card in the server to the hub.

5. Plug in the power cord for the hub.

6. If you have an ELAN subnet network connection, use the ping command to test it.
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Configuring the binding order
Before you begin

• Install two network interface cards on the Contact Center server.
• Disable the NetBIOS on the ELAN network interface card.
• Connect the Contact Center server network interface card to the contact center subnet.
• Connect the Contact Center server ELAN network interface card to the ELAN subnet.

About this task
Configure the binding order of the network cards. The contact center subnet network interface
card must be bound first and then the ELAN network interface card.

Procedure
1. On the Start screen, select Control Panel  > Network and Internet  > Network and

Sharing Center.
2. Click Change adapter settings.

3. In the Network Connections window, press the ALT key.

A hidden menu appears.

4. Choose Advanced  > Advanced Settings.

5. In the Connections box, ensure that the contact center subnet connection is listed first. If
it is not listed first, adjust the order.

Disabling Admin Approval Mode for Windows Server
administrators

About this task
Windows Server 2012 implements a security feature known as User Account Control (UAC). By
default, this feature causes applications run by local non built-in administrators to behave as if the
applications had been run by standard users. Perform this procedure to ensure that local
administrators get full privileges for running applications.

Note:
This procedure describes how to disable Admin Approval Mode on the Contact Center server
using one method only; there are additional methods available. For example, you can also
administer User Account Control settings for the Contact Center server using a group policy.

Procedure
1. On the Start screen, select Administrative Tools  > Local Security Policy.

2. Under Security Settings, expand Local Policies.
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3. Select Security Options.

4. In the policy pane on the right, double-click on User Account Control: Run all
administrators in Admin Approval Mode.

5. Click the Local Security Setting tab, and select Disabled.

6. Click OK.

If prompted, restart the server.

Disabling Windows Server 2012 Automatic Maintenance
About this task
Disable Windows Server 2012 R2 Automatic Maintenance while installing Contact Center
software. Windows Server 2012 Automatic Maintenance can occasionally interfere with the real-
time requirements for Contact Center deployment and configuration. You must therefore
temporarily disable Automatic Maintenance to install and configure Contact Center software. You
re-enable Automatic Maintenance after deploying and configuring Contact Center.
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Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.

5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows  > TaskScheduler.

6. In the Name column, right-click Idle Maintenance and select Disable.

7. In the Name column, right-click Regular Maintenance and select Disable.

8. From the File menu, select Exit.

Installing the Voice and Multimedia Contact Server
software for CS1000

Before you begin
• Ensure the Avaya Communication Server 1000 is configured. For more information see

Avaya Aura® Contact Center and Avaya Communication Server 1000 Integration.
• Download the most recent Contact Center and Common Components patches to the server.
• Read the Contact Center Release Notes for the most recent instructions.

About this task
Install the Contact Center Voice and Multimedia Contact Server software on the server.

Procedure
1. Insert the Contact Center DVD into the DVD drive of your server.
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2. If the installation does not automatically start, double-click Setup.exe.

3. Click Accept to install the Microsoft .NET Framework on the server.

If you are prompted to accept the Microsoft .NET Framework license agreement, click
Accept. If you are prompted to restart the server, click Yes and repeat step 2.

4. Contact Center software installer runs Operating System and hardware checks on the
server. If the installer returns a Fail, the software installation cannot proceed until you
correct the problem. Review any failures returned by the System Readiness Check and
consult Avaya Aura® Contact Center Overview and Specification to determine the actions
to resolve the issue.

You can ignore warnings if the potential impact to the operation of the contact center is
understood and not applicable.

5. The Contact Center software installer platform and server selection screen appears.

6. In the Select Voice Platform section, select Avaya Communication Server 1000 - AML.

7. In the Select Server Installation Option section, select Voice and Multimedia Contact
Server without Avaya Aura Media Server.

8. Click Next.
9. Under Journal Database Drive, select the drive for the database journal. The default drive

partition is H:.

10. Under Voice Contact Server Database Drive, select the drive for the Contact Center
Manager Server, Communication Control Toolkit, and Contact Center Manager
Administration databases. The default drive partition is F:.
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11. Under Multimedia Contact Server Database Drive, select the drive for the Contact
Center Multimedia database. The default drive partition is G:.

12. In the Service Packs section, browse to and select the Service Pack.

13. Click Install.
14. The AVAYA GLOBAL SOFTWARE LICENSE TERMS window appears.

15. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
16. The MICROSOFT SOFTWARE LICENSE TERMS window appears.

17. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

Installing the Voice and Multimedia Contact Server software for CS1000

July 2018 Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000 125
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000


• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
18. The Progress window appears and displays the installation progress.

19. When the software is installed, you have the following options.

• To continue configuring the server installation data:

a. Select Launch Avaya Aura Contact Center Ignition Wizard.

b. Click Configure. This starts the Avaya Aura® Contact Center Ignition Wizard.

• To defer configuring the server installation data:

a. Clear Launch Avaya Aura Contact Center Ignition Wizard.

b. On the message box, click Yes.

c. On the main installer screen, click Close.

d. Follow the on-screen instructions and shut down the Contact Center server.

You must use the Ignition Wizard to initialize Avaya Aura® Contact Center, otherwise
Avaya Aura® Contact Center is not operational. For more information about the Ignition
Wizard, see the following procedures.

Configuring the RGN Voice and Multimedia Contact Server
software for CS1000

Before you begin
• Ensure the Avaya Communication Server 1000 is configured. For more information see

Avaya Aura® Contact Center and Avaya Communication Server 1000 Integration.
• You must configure the required language and locale of the Contact Center server operating

system, if it is not a Latin-1 language, before configuring the Contact Center server using the
Contact Center Ignition Wizard. For more information about configuring language and locale
settings on the Contact Center server, see Avaya Aura® Contact Center Server
Administration.

• Download the most recent Contact Center and Common Components patches to the server.
• Read the Contact Center Release Notes for the most recent instructions.

About this task
Configure the RGN Contact Center Voice and Multimedia Contact Server software to provide data
resiliency and Disaster Recovery.

Procedure
1. Log on to the RGN Contact Center server using the Administrator account details.
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2. On the Contact Center Ignition Wizard screen, click Next. If the Contact Center Ignition
Wizard is not visible, click the Ignition Wizard shortcut on the desktop.

3. On the End-User License Agreement screen, read the license agreement. Optionally,
click Print to generate a local soft copy (in OpenXPS Document format) of the license
agreement.

4. Select I Accept the Terms of the End-User License Agreement and click Next.
5. On the Configuration Data window, type the configuration details for each tab.

6. Select the Core tab, and configure the server details.

7. In the Site Name box, type the site name for the Contact Center server. The site name
must not contain spaces or non-alphabetical characters except hyphen (-) and underscore
(_). The first character must be a letter. The site name must be unique and can consist of 6
to 15 characters.

8. In the Real-Time Statistics Multicast IP Address box, type the Real-time Statistics
Multicast IP Address of the server to associate with sending real-time data. The IP
Address must be from 224.0.1.0 to 239.255.255.255. The default is 234.5.6.10.

9. In the Network Configuration section, in the ELAN IP Address box, type the IP Address
of the embedded local area network. The embedded local area network (ELAN) is a
dedicated Ethernet LAN that connects Contact Center to the PABX.
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10. In the CLAN IP Address box, type the IP Address of the Contact Center server. This is the
Contact Center server IP address on the subnet that connects to the other servers and
agent client computers in the contact center solution.

11. In the System Account Configuration section, in the Password box, type a password for
the Contact Center administration account. The password is checked against the server
security policy for minimum password requirements. Avaya recommends that you enter a
password that conforms to your corporate password policy.

12. In the Confirm Password box, type the password.

13. Select the Licensing tab, and configure the licensing details.

14. From the License Type list, select Standard KRS.

15. Click Browse to locate and load your license file.

16. From the Licensing Package list, select the license type that you have purchased. Select
Nodal Enterprise for single-site contact centers.

17. From the list of Optional Packages, enable the licensed features that you have
purchased.

18. Select the Open Queue check box.

19. Select the Multimedia tab, and configure the Contact Center Multimedia details.
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20. In the Incoming Mail Server box, type the name of the server on which email messages
are received in your network.

21. From the Protocol list, select the communication protocol for the inbound email server.
Select POP3 or IMAP. The default protocol is POP3.

22. In the Outgoing Mail Server box, type the name of the server from on which email
messages are sent. Your inbound and outbound mail servers can have the same name.

23. Select the CS1000 tab.

24. In the Switch Name box, type the name of the AML Avaya Communication Server 1000
telephone switch. Valid characters for Avaya Communication Server 1000 names are A–Z,
a–z, 0–9, underscore (_), and period (.). Names must begin with an alphabetical character
and cannot contain spaces. The last character must not be an underscore or a period.
Names must not exceed 80 characters in length.

25. In the Switch IP Address box, type the IP address of the Avaya Communication Server
1000.

26. In the Switch Customer Number box, type the customer number for the Avaya
Communication Server 1000.

27. In the Alternative Switch IP Address box, type the IP address of an alternate Avaya
Communication Server 1000, if you have one.
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28. In the Alternative Switch Customer Number box, type the customer number of the
alternate Avaya Communication Server 1000, if you have one.

29. In the Alternative Switch Serial ID box, type the serial number of the alternate Avaya
Communication Server 1000, if you have one.

30. In the Voice Connection Type section, select the method used to connect to the PABX.
Select None, Avaya Aura Experience Portal, or CallPilot.

31. If you are using an Avaya CallPilot® server, enter the Avaya CallPilot® server ELAN IP
Address and then configure the Port to 10008.

32. If you are using Avaya CallPilot® High Availability, in the CPHA Managed CLAN IP
Address box, type the Avaya CallPilot® Managed CLAN IP address.

33. If you are using an Avaya CallPilot® server, in the CLAN IP Address box, type the CLAN
IP address of the Avaya CallPilot® server.

34. Select the Security Configuration tab, and configure the security details in the Security
Store Details section.

35. If you do not want to enable security, select the Skip Security Configuration checkbox
and skip to step 54 on page 133.
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Important:

A warning message appears.

36. In the Full Computer Name (FQDN) box, type the full FQDN of the server on which you
are creating the security store.

Important:

The FQDN must be the full machine name of the server that the Security Store resides
on. The FQDN name is case-sensitive.

37. In the Name of Organizational unit box, type the name of the department or division
within the company.

38. In the Name of Organization box, type the company name.

39. In the City or Locality box, type the name of the city or district in which the contact center
is located.

40. In the State or Province box, type the state or province in which the contact center is
located.

41. In the Two Letter Country Code box, type the country code in which the contact center is
located.

42. In the Security Store password box, type a password for accessing the new security
store.

43. In the Confirm Store password box, confirm the password for accessing the new security
store.

Important:

Ensure you remember this password, because you need it when you log on to Security
Manager after install. If you forget the password, you cannot access Security Manager.

44. If you are implementing High Availability in the contact center, generate the security store
using Subject Alternative Names (SANs). In the Subject Alternative Name section, for
each SAN you want to add:

a. From the Type drop-down list, select DNS.

b. In the Value field, type the FQDN for the server.

c. Click Add.

For a High Availability system, add the current server FQDN and the Managed name for
the HA pair.

45. If you want to change the encryption setting, select the required encryption settings from
the Encryption Algorithm Level and Key Size drop-down lists.

The default value for Encryption Algorithm is SHA256 and the default value for Key Size
is 2048.
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Contact Center displays a warning message if you select SHA1 or 1024. Contact Center
includes these values for backward-compatibility only, because these settings do not meet
the industry-recommended level of encryption.

46. Click Create Store.

47. You can now use the Security Configuration tab to create and save a Certificate Signing
Request (CSR) file.

48. Click Create CSR File.

49. From the Save In drop-down list, select a shared location in which to save the CSR file
and click Save.

You must now send the Certificate Signing Request file to a Certificate Authority and
receive a signed certificate and root certificate to import to the security store.

50. In the Imported Trusted Certificate Authority Root Certificate(s) section, click Add to
import the Certificate Authority root certificate.

51. In the Open dialog box, browse to the location of the certificate and click Open.

52. In the Imported Identity Security Certificate section, click Add to import the Certificate
Authority signed certificate.

53. In the Open dialog box, browse to the location of the certificate and click Open.
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54. Click Next.
55. Review and verify the summary information, and click Configure.

56. After the installation is complete, click Finish.

57. If prompted, restart the server.

Enabling Windows Server 2012 Automatic Maintenance
About this task
Enable Windows Server 2012 R2 Automatic Maintenance after deploying and configuring Contact
Center software.

Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.

5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows > TaskScheduler.

6. In the Name column, right-click Idle Maintenance and select Enable.

7. In the Name column, right-click Regular Maintenance and select Enable.

8. From the File menu, select Exit.
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Securing the Windows server
About this task
Apply optional security measures to your operating system to further secure your server.

Important:
Scanning software can degrade the performance and decrease the reliability of the system.
Install virus scanning software only if the system connects to an exposed network or to the
Internet.

Important:
To maintain server performance, you must schedule virus scans during maintenance periods
or low usage hours only.

Procedure
1. Harden the operating system using defined site procedures.

2. Install antivirus software. If you install antivirus software, Avaya recommends that you
exclude some contact center files and folders from real-time and scheduled scans. For
more information, and for a list of files and folders to exclude, see Avaya Aura® Contact
Center Overview and Specification.

Commissioning the Contact Center server
About this task
Commission the installed Contact Center software.

Procedure
Commission the installed Contact Center software.

For information about commissioning the installed server software, see Avaya Aura® Contact
Center Commissioning for Avaya Communication Server 1000.
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Chapter 10: Voice Contact Server for
CS1000 installation

This chapter describes how to install a Voice Contact Server in a solution with an Avaya
Communication Server 1000 (CS1000) platform. A Voice Contact Server includes the following
server software:

• Contact Center Manager Server (CCMS)
• Contact Center Manager Server Utility
• Contact Center License Manager
• Contact Center Manager Administration (CCMA)
• Communication Control Toolkit (CCT)

Install this server to provide context‐sensitive and skill-based routing for customer voice contacts.
This server provides routed contact support for voice calls. This server provides extensive tools for
agent management, real-time and historical reporting, and graphical tools to create contact flows
and treatment rules. Use this server for license management, High Availability configuration,
networking, Open Interfaces Web Service and third-party application interfaces integration.

If the server is to be used in a domain, Avaya recommends that you add the server to the domain
before installing Contact Center software.

You can change the name of a Contact Center server, but because this is time consuming, Avaya
recommends that you configure the server final production name before installing Contact Center
software.

If you plan to follow the Microsoft server hardening guidelines, complete those procedures before
installing Avaya Aura® Contact Center.

You can use any account with local administrative rights to install Avaya Aura® Contact Center. You
can use any account with local administrative rights to upgrade and patch Avaya Aura® Contact
Center; you do not need to always use the same account to perform these tasks.

Important:

You must disable the Admin Approval Mode security feature on the Contact Center server. This
ensures that accounts with local administrative rights get full privileges for running applications
on the Contact Center server.

Contact Center Manager Server supports two Network Interface Cards (NICs) and two subnets (one
contact center subnet and one ELAN subnet). The Contact Center Manager Server ELAN NIC and
ELAN subnet are optional.

July 2018 Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000 135
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000


You must complete all the procedures in this section in sequential order.

All active and standby applications must be on the same patch level.

Downloading the most recent documentation
Before you begin

• Download the most recent version of Acrobat Reader.
• Access the Avaya website at http://support.avaya.com.

About this task
Download the most recent documentation to ensure you have the most recent updates. Updates
in the documentation accurately reflect the most recent changes in the software.

Procedure
1. Log on to the Avaya website.

2. Compare the versions of the documentation on the site with the versions you have.

3. If the version number on http://support.avaya.com is higher than your version, download
the latest version of the document.

4. Review the Avaya website for release notes and readme files.

Installing Microsoft Windows Server 2012 R2
Before you begin

• Ensure that you have a newly formatted server that meets the specifications in Avaya Aura®

Contact Center Overview and Specification on which to install Microsoft Windows Server
2012 R2.
Do not upgrade your operating system from a previous release. Contact Center is not
supported on an upgraded operating system.

• Configure all servers for RAID as described in Avaya Aura® Contact Center Overview and
Specification.

• Ensure that you have a DVD for Microsoft Windows Server 2012 R2 Standard or Data
Center. Ensure that your DVD is the R2 version of Windows Server 2012 Standard or Data
Center.

• Ensure that you have a Microsoft Windows Server 2012 R2 operating system product key.
• Know the IP addresses for the contact center subnet.

About this task
Install the Microsoft Windows Server 2012 R2 Standard or Data Center operating system and
configure it to support Contact Center server software.
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The following table lists the main inputs to consider while installing the operating system.

Name Description
Computer name Do not use spaces or underscores or exceed 15 characters. The name must start

with an alphabetic character. Server names must adhere to RFC1123. Avaya
recommends that you configure the server final production name before installing
Contact Center software.

The computer name must match (including case sensitivity) the DNS name.
Disk drives Format the partitions as required for the server. For more information, see Avaya

Aura® Contact Center Overview and Specification.
Domain name Configure as required for your site.

You must check to ensure the DNS Domain name (including case) matches the
server name if the server is added to a domain after configuration.

Licensing modes Select Per server licensing mode.

Accept the default five concurrent connections.
Network components Configure IP Address, WINS, DNS for one or two network cards as per

configuration. Contact Center does not support IPv6.
Network connections If the server has more than one NIC/adapter, ensure contact center subnet

appears first in the network adapter binding order.
Hard Disk Partitions Configure C: drive to be a primary drive. Configure the other drives on your server

to meet the requirements according to Avaya Aura® Contact Center Overview and
Specification for the server.

Perform this procedure on each server before you install Contact Center server software on the
server.

Procedure
1. Insert the Microsoft Windows Server 2012 R2 Standard or Data Center DVD into the DVD

drive.

2. Turn on the power to the server.

The server begins to boot up.

3. On the Windows Setup screen, select a Language to install from the list.

4. Select a Time and currency format from the list.

5. Select Keyboard or input method from the list.

6. Click Next.
7. Click Install now.

8. Depending on the DVD image that you use, you might need to select an operating system
from a list. Select a version of Windows Server 2012 R2 Standard or Data Center that
includes a Graphical User Interface (GUI). Install a version that includes “(Server with a
GUI)”.

9. Click Next.
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10. On the Enter the product key to activate Windows window, enter the operating system
product key.

11. Click Next.
12. On the Windows Setup screen, read the terms of the license agreement and select I

accept the license terms.

13. Click Next.
14. Select Custom: Install Windows only (advanced) to install a clean new installation of the

operating system.

15. Select the disk partition on which you want to install Windows Server 2012 R2.

Important:

You can use the partition management options to configure the partitions on your
server.

16. Click Next.

The installation proceeds and automatically restarts the server several times.

17. After completing the installation, log on to the server as Administrator. Enter and confirm
the Administrator password.

18. Select Set time zone and complete the information as required for your system.

19. Select Configure Networking and complete the information for your Network Interface
Card (NIC) with the server IP address.

20. Select Provide computer name and domain and complete the information for your server
name and network settings.

21. Change the DVD drive letter to E: to ensure the correct drive letters are free for the
Contact Center application and database hard disk drives and partitions.

22. Configure the hard disk drives and partitions for this server using the Windows Server
2012 R2 Computer Management - Disk Management utility. For more information about
hard disk drives and partitions, see Avaya Aura® Contact Center Overview and
Specification.

23. Install other required drivers for your hardware configuration.

Job aid: Hard disk drive partitions
Configure the hard disk drives and partitions. These are the minimum hard disk partition sizes. For
more information about hard disk requirements, including the recommended partition sizes, see
Avaya Aura® Contact Center Overview and Specification.

For each partition, specify a volume size in MBs that when formatted results in a disk partition that
is equal to or greater than the required minimum partition size.
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Hard disk drive Drive letter Minimum size
partition

Operating System drive

Including the 350 MB Windows boot loader System Reserved
partition.

C: 80 GB NTFS

Application drive D: 120 GB NTFS
DVD drive

For continuity and consistency, Avaya recommends using Drive
letter E: for the DVD drive. However, Contact Center supports any
DVD Drive letter, other than the Drive letters listed here for the
hard disk partitions.

E: —

Voice Contact Server database drive F: 200 GB NTFS
Database journal H: 100 GB NTFS

Navigating the Microsoft Windows Server 2012 R2 User
Interface

This section describes how to navigate between the main user interface screens of the Windows
Server 2012 R2 operating system.

The following table describes some of the main Microsoft Windows Server 2012 R2 user interface
screens.

Screen name Description
Start The Start screen contains shortcuts to the main administration interfaces of the

server. If you have an application that you access on a regular basis, you can
add it to the Start screen so that it's more immediately accessible. The Start
screen displays the currently logged on user and provides some basic server log
out and locking functions. This is the operating system default screen.

Apps The Apps screen contains shortcuts to the applications and utilities installed on
the server. The server applications and utilities are grouped into categories.
Third-party vendors and applications can also add custom, vendor or product
specific, categories to the Apps screen.

Desktop The Desktop screen contains the Windows start button, the Windows Taskbar,
Recycle Bin, and shortcuts to the Windows Explorer utility, among others. The
Taskbar displays the Windows Notification Area and System Tray. The
notification area is located on the right portion of the Taskbar next to the time.

Navigation tips:

• Use the up  and down  arrow icons to navigate between the Start and Apps screens.

• To display the Start screen, on the Desktop screen, click the Windows start button.
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• To display the Desktop screen, on the Start screen select the Desktop tile.

• To display the Desktop screen, on the Apps screen select the Desktop tile.

• To switch between the Start screen and the Desktop screen press the Windows start button
on your keyboard.

• To access the Control Panel, on the Apps or Start screen click on the Control Panel tile.

• To access the Administration Tools, on the Apps or Start screen click on the Administrative
Tools tile.

These screen navigation methods work when you are using the server’s keyboard and mouse
directly, or when you are using Remote Desktop to access the server.

Figure 8: Example of the Start screen, with the down arrow icon highlighted in a red box.
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Figure 9: Example of the Apps screen, with the up arrow icon highlighted in a red box.
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Figure 10: Example of the Desktop screen, with the Windows start button highlighted in a red box.

The following table describes some of the Taskbar sections of the Desktop screen.

Icon Name Description
Windows start button Use the Windows start button to navigate to the Start screen. Use this

button to switch between the Start screen and the Desktop screen.

Server Manager Use this button to access the Server Manager to configure the roles and
features to the server.

PowerShell Use the PowerShell button to start the Windows PowerShell console.
Windows PowerShell is a command-line shell that provides cmdlets
(pronounced command-lets) for server configuration and management.
PowerShell also provides scripting functions for task automation.

This PC Use this button to start the This PC Windows Explorer. Use this to
access and navigate the folders, files, and storage devices on the
server.
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The contents of your screens can vary depending on the roles, features, and applications installed
on your server.

For more information about the Windows Server 2012 R2 operating system, refer to the Microsoft
support website and Microsoft product documentation.

Installing the most recent supported operating system
service packs

Before you begin
• Access the Avaya hotfixes list on the website http://support.avaya.com.
• Install and configure Microsoft Windows Server 2012 R2 on your server.
• Review the specifications on operating system service updates in Avaya Aura® Contact

Center Overview and Specification.

About this task
Avaya recommends that you install the most recent supported operating system service packs.
You must download the supported operating system service pack from the Avaya hotfixes list to
ensure your Contact Center server software functions correctly with the supported operating
system patches.

Procedure
1. Review the Contact Center Service Packs Compatibility and Security Hotfixes Applicability

List to determine the most recent Avaya Aura® Contact Center supported patches or
service packs.

2. Download the appropriate Microsoft Windows Server 2012 R2 patches for the Avaya Aura®

Contact Center software installed on this server.

3. Install the most recent Windows Server 2012 R2 service pack that is validated with Avaya
Aura® Contact Center by following the Microsoft Installation instructions.

Connecting to the contact center subnet
About this task
Connect the Contact Center server to the contact center subnet. The contact center subnet is the
network on which the server software applications work together to route contacts and generate
reports.

Procedure
1. Locate the slot assigned to the contact center subnet network interface card for the server.

Make a note of the slot.
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2. Connect the cable from the contact center subnet to the contact center subnet network
interface card in the server in accordance with customer site networking guidelines.

3. Use the ping command to test the contact center subnet.

Adding the server to a domain or workgroup
About this task
Add the server to a domain or workgroup. Avaya recommends that you add the server to the
domain or workgroup before installing Contact Center software.
If you are using a domain:

• Add the server to a Windows domain before installing Contact Center software. When joining
the domain, ensure the server time and domain controller time are synchronized to the same
time.

• On the server, configure a preferred Domain Name System (DNS) server on the Network
Interface Card (NIC).

• Ask your System Administrator to add a Domain Name System (DNS) static entry for this
server. Each Contact Center server in a domain requires a DNS static entry.

Procedure
1. Log on to the server.

2. On the Start screen, select Administrative Tools  > Server Manager.
3. In the left pane, select Local Server.
4. In the right pane, in the Properties section, double-click on the Domain or Workgroup

value.

The System Properties dialog box appears.

5. In the System Properties dialog box, click the Computer Name tab.

6. Click Change.

7. To add the server to a workgroup, skip to step 9.

8. To add the server to a domain, in the Member of dialog box, click the Domain option.

a. Type the domain name (you must provide the fully qualified domain name, which
includes the prefix and suffix).

b. Click OK.

c. Type the domain administrator User name and Password.

d. Click OK.

e. Skip to step 10.
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9. To add the server to a workgroup, in the Member of dialog box, click the Workgroup
option.

a. Type the workgroup name.

b. Click OK.

c. Type the workgroup administrator User name and Password.

d. Click OK.

10. Restart the server when you are prompted to do so.

Downloading the most recent Contact Center patches to
the server

Before you begin
• Download and install the most recent and supported updates for Microsoft Windows Server

2012 R2.
• Know the location at which you plan to install each Contact Center server software package.
• Ensure that you use one administrator account on your server to un-install and install

software updates.

About this task
To ensure that you have the most current software, download the most recent Contact Center
patches from http://support.avaya.com to the server you plan to install.

Procedure
1. Log on to the server using the administrator account.

2. Create a folder <Drive>:\Avaya-ProductUpdates\ to save the software updates. Where
<Drive> is the drive letter on which you want to save the Contact Center software updates.

3. Download the most recent service pack file. Save and unzip the file on the Contact Center
server in the Avaya-ProductUpdates folder.

4. If new patches are available for the latest service pack, download and save the patches on
the Contact Center server in the Avaya-ProductUpdates folder.

5. Read the Contact Center Release Notes for the most recent instructions.
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Disabling unused Network Adapters
About this task
Disable all unused Network Adapters or Network Interface Cards (NICs) to improve network
communications and prevent the erroneous configuration of unused NICs during Contact Center
server commissioning.

Procedure
1. Log on to the server.

2. On the Start screen, select Control Panel  > Network and Internet  > Network and
Sharing Center  > Change adapter settings.

3. Right-click on the unused Network Adapter, and select Disable.

4. Repeat this procedure for all unused Network Adapters.

Enabling Microsoft Remote Desktop connection
About this task
Enable Microsoft Remote Desktop connection as your remote access tool. Microsoft Remote
Desktop provides remote access for support on the server.

Procedure
1. Log on to the server with administrator privileges.

2. On the Start screen, select Control Panel  > System and Security.

3. In the System section, select Allow remote access.

4. Click the Remote tab.

5. Select Allow remote connections to this computer.
6. Click Apply.

7. Click OK.

Disabling NetBIOS
About this task
If the Contact Center server uses two Network Interface Cards (NICs), disable NetBIOS on the
Embedded LAN (ELAN) network interface card (NIC) to avoid NetBIOS conflicts.
Contact Center supports two Network Interface Cards (NICs) and two subnets (one contact center
subnet and one ELAN subnet). The Contact Center ELAN NIC and ELAN subnet are optional.
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Procedure
1. Log on to the server.

2. On the Start screen, select Control Panel  > Network and Internet.
3. Click Network and Sharing Center.
4. Click Change adapter settings.

5. Right-click the ELAN Network Interface Card (NIC).

6. Click Properties.

7. Select Internet Protocol Version 4 (TCP/IPv4).
8. Click Properties.

9. Click Advanced.

10. Click the WINS tab.

11. Select the Disable NetBIOS over TCP/IP check box.

12. Click OK.

Connecting the Embedded LAN subnet
Before you begin

• Install two network cards on the Contact Center server.
• Disable the NetBIOS on the ELAN network interface card.
• Connect the contact center subnet network interface card.

About this task
If your server uses two NICs, connect the Embedded LAN (ELAN) NIC to the ELAN subnet.
Contact Center supports two network interface cards (NICs) and two subnets (one contact center
subnet and one ELAN subnet). The Contact Center ELAN NIC and ELAN subnet are optional.

Procedure
1. Locate the slot assigned to the ELAN network interface card for the server.

2. Write the MAC address of the card on a small label. Attach the label to the back of the card
or the chassis slot position.

3. Connect the ELAN subnet from the Avaya equipment to the Ethernet hub.

4. Connect the network cable from the ELAN network interface card in the server to the hub.

5. Plug in the power cord for the hub.

6. If you have an ELAN subnet network connection, use the ping command to test it.

Connecting the Embedded LAN subnet

July 2018 Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000 147
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000


Configuring the binding order
Before you begin

• Install two network interface cards on the Contact Center server.
• Disable the NetBIOS on the ELAN network interface card.
• Connect the Contact Center server network interface card to the contact center subnet.
• Connect the Contact Center server ELAN network interface card to the ELAN subnet.

About this task
Configure the binding order of the network cards. The contact center subnet network interface
card must be bound first and then the ELAN network interface card.

Procedure
1. On the Start screen, select Control Panel  > Network and Internet  > Network and

Sharing Center.
2. Click Change adapter settings.

3. In the Network Connections window, press the ALT key.

A hidden menu appears.

4. Choose Advanced  > Advanced Settings.

5. In the Connections box, ensure that the contact center subnet connection is listed first. If
it is not listed first, adjust the order.

Disabling Admin Approval Mode for Windows Server
administrators

About this task
Windows Server 2012 implements a security feature known as User Account Control (UAC). By
default, this feature causes applications run by local non built-in administrators to behave as if the
applications had been run by standard users. Perform this procedure to ensure that local
administrators get full privileges for running applications.

Note:
This procedure describes how to disable Admin Approval Mode on the Contact Center server
using one method only; there are additional methods available. For example, you can also
administer User Account Control settings for the Contact Center server using a group policy.

Procedure
1. On the Start screen, select Administrative Tools  > Local Security Policy.

2. Under Security Settings, expand Local Policies.
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3. Select Security Options.

4. In the policy pane on the right, double-click on User Account Control: Run all
administrators in Admin Approval Mode.

5. Click the Local Security Setting tab, and select Disabled.

6. Click OK.

If prompted, restart the server.

Disabling Windows Server 2012 Automatic Maintenance
About this task
Disable Windows Server 2012 R2 Automatic Maintenance while installing Contact Center
software. Windows Server 2012 Automatic Maintenance can occasionally interfere with the real-
time requirements for Contact Center deployment and configuration. You must therefore
temporarily disable Automatic Maintenance to install and configure Contact Center software. You
re-enable Automatic Maintenance after deploying and configuring Contact Center.
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Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.

5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows  > TaskScheduler.

6. In the Name column, right-click Idle Maintenance and select Disable.

7. In the Name column, right-click Regular Maintenance and select Disable.

8. From the File menu, select Exit.

Installing the Voice Contact Server software for CS1000
Before you begin

• Ensure the Avaya Communication Server 1000 is configured. For more information see
Avaya Aura® Contact Center and Avaya Communication Server 1000 Integration.

• Download the most recent Contact Center and Common Components patches to the server.
• Read the Contact Center Release Notes for the most recent instructions.

About this task
Install the Contact Center Voice Contact Server software on the server.

Procedure
1. Insert the Contact Center DVD into the DVD drive of your server.

2. If the installation does not automatically start, double-click Setup.exe.
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3. Click Accept to install the Microsoft .NET Framework on the server.

If you are prompted to accept the Microsoft .NET Framework license agreement, click
Accept. If you are prompted to restart the server, click Yes and repeat step 2.

4. Contact Center software installer runs Operating System and hardware checks on the
server. If the installer returns a Fail, the software installation cannot proceed until you
correct the problem. Review any failures returned by the System Readiness Check and
consult Avaya Aura® Contact Center Overview and Specification to determine the actions
to resolve the issue.

You can ignore warnings if the potential impact to the operation of the contact center is
understood and not applicable.

5. The Contact Center software installer platform and server selection screen appears.

6. In the Select Voice Platform section, select Avaya Communication Server 1000 - AML.

7. In the Select Server Installation Option section, select Voice Contact Server Only.

8. Click Next.
9. Under Journal Database Drive, select the drive for the database journal. The default drive

partition is H:.

10. Under Voice Contact Server Database Drive, select the drive for the Contact Center
Manager Server, Communication Control Toolkit, and Contact Center Manager
Administration databases. The default drive partition is F:.

11. In the Service Packs section, browse to and select the Service Pack.
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12. Click Install.
13. The AVAYA GLOBAL SOFTWARE LICENSE TERMS window appears.

14. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
15. The MICROSOFT SOFTWARE LICENSE TERMS window appears.

16. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
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17. The Progress window appears and displays the installation progress.

18. When the software is installed, you have the following options.

• To continue configuring the server installation data:

a. Select Launch Avaya Aura Contact Center Ignition Wizard.

b. Click Configure. This starts the Avaya Aura® Contact Center Ignition Wizard.

• To defer configuring the server installation data:

a. Clear Launch Avaya Aura Contact Center Ignition Wizard.

b. On the message box, click Yes.

c. On the main installer screen, click Close.

d. Follow the on-screen instructions and shut down the Contact Center server.

You must use the Ignition Wizard to initialize Avaya Aura® Contact Center, otherwise
Avaya Aura® Contact Center is not operational. For more information about the Ignition
Wizard, see the following procedures.

Configuring Voice Contact Server software for CS1000
Before you begin

• Ensure the Avaya Communication Server 1000 is configured. For more information see
Avaya Aura® Contact Center and Avaya Communication Server 1000 Integration.

• You must configure the required language and locale of the Contact Center server operating
system, if it is not a Latin-1 language, before configuring the Contact Center server using the
Contact Center Ignition Wizard. For more information about configuring language and locale
settings on the Contact Center server, see Avaya Aura® Contact Center Server
Administration.

• Download the most recent Contact Center and Common Components patches to the server.
• Read the Contact Center Release Notes for the most recent instructions.

About this task
Configure the Contact Center Voice Contact Server software and enable your contact center to
route contacts to the agents that can answer the call with the correct skills.

Procedure
1. Log on to the Contact Center server using the Administrator account details.

2. On the Contact Center Ignition Wizard screen, click Next. If the Contact Center Ignition
Wizard is not visible, click the Ignition Wizard shortcut on the desktop.

3. On the End-User License Agreement screen, read the license agreement. Optionally,
click Print to generate a local soft copy (in OpenXPS Document format) of the license
agreement.
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4. Select I Accept the Terms of the End-User License Agreement and click Next.
5. On the Configuration Data window, type the configuration details for each tab.

6. Select the Core tab, and configure the server details.

7. In the Site Name box, type the site name for the Contact Center server. The site name
must not contain spaces or non-alphabetical characters except hyphen (-) and underscore
(_). The first character must be a letter. The site name must be unique and can consist of 6
to 15 characters.

8. In the Real-Time Statistics Multicast IP Address box, type the Real-time Statistics
Multicast IP Address of the server to associate with sending real-time data. The IP
Address must be from 224.0.1.0 to 239.255.255.255. The default is 234.5.6.10.

9. In the Network Configuration section, in the ELAN P Address box, type the IP Address
of the embedded local area network. The embedded local area network (ELAN) is a
dedicated Ethernet LAN that connects Contact Center to the PABX.

10. In the CLAN IP Address box, type the IP Address of the Contact Center server. This is the
Contact Center server IP address on the subnet that connects to the other servers and
agent client computers in the contact center solution.

11. In the System Account Configuration section, in the Password box, type a password for
the Contact Center administration account. The password is checked against the server
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security policy for minimum password requirements. Avaya recommends that you enter a
password that conforms to your corporate password policy.

12. In the Confirm Password box, type the password.

13. Select the Licensing tab, and configure the licensing details.

14. From the License Type list, select Standard KRS.

15. Click Browse to locate and load your license file.

16. From the Licensing Package list, select the license type that you have purchased. Select
Nodal Enterprise for single-site contact centers.

17. From the list of Optional Packages, enable the licensed features that you have
purchased.

18. Select the Open Queue check box.

19. Select the CS1000 tab.

20. In the Switch Name box, type the name of the AML Avaya Communication Server 1000
telephone switch. Valid characters for Avaya Communication Server 1000 names are A–Z,
a–z, 0–9, underscore (_), and period (.). Names must begin with an alphabetical character
and cannot contain spaces. The last character must not be an underscore or a period.
Names must not exceed 80 characters in length.
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21. In the Switch IP Address box, type the IP address of the Avaya Communication Server
1000.

22. In the Switch Customer Number box, type the customer number for the Avaya
Communication Server 1000.

23. In the Alternative Switch IP Address box, type the IP address of an alternate Avaya
Communication Server 1000, if you have one.

24. In the Alternative Switch Customer Number box, type the customer number of the
alternate Avaya Communication Server 1000, if you have one.

25. In the Alternative Switch Serial ID box, type the serial number of the alternate Avaya
Communication Server 1000, if you have one.

26. In the Voice Connection Type section, select the method used to connect to the PABX.
Select None, Avaya Aura Experience Portal, or CallPilot.

27. If you are using an Avaya CallPilot® server, enter the Avaya CallPilot® server ELAN IP
Address and then configure the Port to 10008.

28. If you are using Avaya CallPilot® High Availability, in the CPHA Managed CLAN IP
Address box, type the Avaya CallPilot® Managed CLAN IP address.

29. If you are using an Avaya CallPilot® server, in the CLAN IP Address box, type the CLAN
IP address of the Avaya CallPilot® server.

30. Select the Security Configuration tab, and configure the security details in the Security
Store Details section.
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31. If you do not want to enable security, select the Skip Security Configuration checkbox
and skip to step 50 on page 159.

Important:

A warning message appears.

32. In the Full Computer Name (FQDN) box, type the full FQDN of the server on which you
are creating the security store.

Important:

The FQDN must be the full machine name of the server that the Security Store resides
on. The FQDN name is case-sensitive.

33. In the Name of Organizational unit box, type the name of the department or division
within the company.

34. In the Name of Organization box, type the company name.

35. In the City or Locality box, type the name of the city or district in which the contact center
is located.

36. In the State or Province box, type the state or province in which the contact center is
located.
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37. In the Two Letter Country Code box, type the country code in which the contact center is
located.

38. In the Security Store password box, type a password for accessing the new security
store.

39. In the Confirm Store password box, confirm the password for accessing the new security
store.

Important:

Ensure you remember this password, because you need it when you log on to Security
Manager after install. If you forget the password, you cannot access Security Manager.

40. If you are implementing High Availability in the contact center, generate the security store
using Subject Alternative Names (SANs). In the Subject Alternative Name section, for
each SAN you want to add:

a. From the Type drop-down list, select DNS.

b. In the Value field, type the FQDN for the server.

c. Click Add.

For a High Availability system, add the current server FQDN and the Managed name for
the HA pair.

41. If you want to change the encryption setting, select the required encryption settings from
the Encryption Algorithm Level and Key Size drop-down lists.

The default value for Encryption Algorithm is SHA256 and the default value for Key Size
is 2048.

Contact Center displays a warning message if you select SHA1 or 1024. Contact Center
includes these values for backward-compatibility only, because these settings do not meet
the industry-recommended level of encryption.

42. Click Create Store.

43. You can now use the Security Configuration tab to create and save a Certificate Signing
Request (CSR) file.
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44. Click Create CSR File.

45. From the Save In drop-down list, select a shared location in which to save the CSR file
and click Save.

You must now send the Certificate Signing Request file to a Certificate Authority and
receive a signed certificate and root certificate to import to the security store.

46. In the Imported Trusted Certificate Authority Root Certificate(s) section, click Add to
import the Certificate Authority root certificate.

47. In the Open dialog box, browse to the location of the certificate and click Open.

48. In the Imported Identity Security Certificate section, click Add to import the Certificate
Authority signed certificate.

49. In the Open dialog box, browse to the location of the certificate and click Open.

50. Click Next.
51. Review and verify the summary information, and click Configure.

52. After the installation is complete, click Finish.

53. If prompted, restart the server.
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Enabling Windows Server 2012 Automatic Maintenance
About this task
Enable Windows Server 2012 R2 Automatic Maintenance after deploying and configuring Contact
Center software.

Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.

5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows > TaskScheduler.

6. In the Name column, right-click Idle Maintenance and select Enable.

7. In the Name column, right-click Regular Maintenance and select Enable.

8. From the File menu, select Exit.

Securing the Windows server
About this task
Apply optional security measures to your operating system to further secure your server.

Important:
Scanning software can degrade the performance and decrease the reliability of the system.
Install virus scanning software only if the system connects to an exposed network or to the
Internet.
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Important:
To maintain server performance, you must schedule virus scans during maintenance periods
or low usage hours only.

Procedure
1. Harden the operating system using defined site procedures.

2. Install antivirus software. If you install antivirus software, Avaya recommends that you
exclude some contact center files and folders from real-time and scheduled scans. For
more information, and for a list of files and folders to exclude, see Avaya Aura® Contact
Center Overview and Specification.

Commissioning the Contact Center server
About this task
Commission the installed Contact Center software.

Procedure
Commission the installed Contact Center software.

For information about commissioning the installed server software, see Avaya Aura® Contact
Center Commissioning for Avaya Communication Server 1000.
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Chapter 11: Primary Voice Contact Server
for CS1000 installation in a
domain

This chapter describes how to install a Voice Contact Server in a solution with an Avaya
Communication Server 1000 (CS1000) platform. This chapter describes how to install a Voice
Contact Server in a domain. A Voice Contact Server includes the following server software:

• Contact Center Manager Server (CCMS)
• Contact Center Manager Server Utility
• Contact Center License Manager
• Contact Center Manager Administration (CCMA)
• Communication Control Toolkit (CCT)

Install this server to provide context‐sensitive and skill-based routing for customer voice contacts.
This server provides routed contact support for voice calls. This server provides extensive tools for
agent management, real-time and historical reporting, and graphical tools to create contact flows
and treatment rules. Use this server for license management, High Availability configuration,
networking, Open Interfaces Web Service and third-party application interfaces integration.

You can change the name of a Contact Center server, but because this is time consuming, Avaya
recommends that you configure the server final production name before installing Contact Center
software.

If you plan to follow the Microsoft server hardening guidelines, complete those procedures before
installing Avaya Aura® Contact Center.

You can use any account with local administrative rights to install Avaya Aura® Contact Center. You
can use any account with local administrative rights to upgrade and patch Avaya Aura® Contact
Center; you do not need to always use the same account to perform these tasks.

Important:

You must disable the Admin Approval Mode security feature on the Contact Center server. This
ensures that accounts with local administrative rights get full privileges for running applications
on the Contact Center server.

Contact Center Manager Server supports two Network Interface Cards (NICs) and two subnets (one
contact center subnet and one ELAN subnet). The Contact Center Manager Server ELAN NIC and
ELAN subnet are optional.

July 2018 Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000 162
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000


All active and standby applications must be on the same patch level.

Voice Contact Server installation prerequisites
Procedure

• Copy the most recent patches for the Contact Center software.

• Ensure that your new Contact Center license file with a High Availability standby server
license is available.

Important:

For the system to correctly handle backup and restore SNMP events, you must install
Windows SNMP Service before you install Contact Center server software.

Downloading the most recent documentation
Before you begin

• Download the most recent version of Acrobat Reader.
• Access the Avaya website at http://support.avaya.com.

About this task
Download the most recent documentation to ensure you have the most recent updates. Updates
in the documentation accurately reflect the most recent changes in the software.

Procedure
1. Log on to the Avaya website.

2. Compare the versions of the documentation on the site with the versions you have.

3. If the version number on http://support.avaya.com is higher than your version, download
the latest version of the document.

4. Review the Avaya website for release notes and readme files.

Installing Microsoft Windows Server 2012 R2
Before you begin

• Ensure that you have a newly formatted server that meets the specifications in Avaya Aura®

Contact Center Overview and Specification on which to install Microsoft Windows Server
2012 R2.
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Do not upgrade your operating system from a previous release. Contact Center is not
supported on an upgraded operating system.

• Configure all servers for RAID as described in Avaya Aura® Contact Center Overview and
Specification.

• Ensure that you have a DVD for Microsoft Windows Server 2012 R2 Standard or Data
Center. Ensure that your DVD is the R2 version of Windows Server 2012 Standard or Data
Center.

• Ensure that you have a Microsoft Windows Server 2012 R2 operating system product key.
• Know the IP addresses for the contact center subnet.

About this task
Install the Microsoft Windows Server 2012 R2 Standard or Data Center operating system and
configure it to support Contact Center server software.
The following table lists the main inputs to consider while installing the operating system.

Name Description
Computer name Do not use spaces or underscores or exceed 15 characters. The name must start

with an alphabetic character. Server names must adhere to RFC1123. Avaya
recommends that you configure the server final production name before installing
Contact Center software.

The computer name must match (including case sensitivity) the DNS name.
Disk drives Format the partitions as required for the server. For more information, see Avaya

Aura® Contact Center Overview and Specification.
Domain name Configure as required for your site.

You must check to ensure the DNS Domain name (including case) matches the
server name if the server is added to a domain after configuration.

Licensing modes Select Per server licensing mode.

Accept the default five concurrent connections.
Network components Configure IP Address, WINS, DNS for one or two network cards as per

configuration. Contact Center does not support IPv6.
Network connections If the server has more than one NIC/adapter, ensure contact center subnet

appears first in the network adapter binding order.
Hard Disk Partitions Configure C: drive to be a primary drive. Configure the other drives on your server

to meet the requirements according to Avaya Aura® Contact Center Overview and
Specification for the server.

Perform this procedure on each server before you install Contact Center server software on the
server.

Procedure
1. Insert the Microsoft Windows Server 2012 R2 Standard or Data Center DVD into the DVD

drive.

2. Turn on the power to the server.

The server begins to boot up.
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3. On the Windows Setup screen, select a Language to install from the list.

4. Select a Time and currency format from the list.

5. Select Keyboard or input method from the list.

6. Click Next.
7. Click Install now.

8. Depending on the DVD image that you use, you might need to select an operating system
from a list. Select a version of Windows Server 2012 R2 Standard or Data Center that
includes a Graphical User Interface (GUI). Install a version that includes “(Server with a
GUI)”.

9. Click Next.
10. On the Enter the product key to activate Windows window, enter the operating system

product key.

11. Click Next.
12. On the Windows Setup screen, read the terms of the license agreement and select I

accept the license terms.

13. Click Next.
14. Select Custom: Install Windows only (advanced) to install a clean new installation of the

operating system.

15. Select the disk partition on which you want to install Windows Server 2012 R2.

Important:

You can use the partition management options to configure the partitions on your
server.

16. Click Next.

The installation proceeds and automatically restarts the server several times.

17. After completing the installation, log on to the server as Administrator. Enter and confirm
the Administrator password.

18. Select Set time zone and complete the information as required for your system.

19. Select Configure Networking and complete the information for your Network Interface
Card (NIC) with the server IP address.

20. Select Provide computer name and domain and complete the information for your server
name and network settings.

21. Change the DVD drive letter to E: to ensure the correct drive letters are free for the
Contact Center application and database hard disk drives and partitions.

22. Configure the hard disk drives and partitions for this server using the Windows Server
2012 R2 Computer Management - Disk Management utility. For more information about
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hard disk drives and partitions, see Avaya Aura® Contact Center Overview and
Specification.

23. Install other required drivers for your hardware configuration.

Job aid: Hard disk drive partitions
Configure the hard disk drives and partitions. These are the minimum hard disk partition sizes. For
more information about hard disk requirements, including the recommended partition sizes, see
Avaya Aura® Contact Center Overview and Specification.

For each partition, specify a volume size in MBs that when formatted results in a disk partition that
is equal to or greater than the required minimum partition size.

Hard disk drive Drive letter Minimum size
partition

Operating System drive

Including the 350 MB Windows boot loader System Reserved
partition.

C: 80 GB NTFS

Application drive D: 120 GB NTFS
DVD drive

For continuity and consistency, Avaya recommends using Drive
letter E: for the DVD drive. However, Contact Center supports any
DVD Drive letter, other than the Drive letters listed here for the
hard disk partitions.

E: —

Voice Contact Server database drive F: 200 GB NTFS
Database journal H: 100 GB NTFS

Navigating the Microsoft Windows Server 2012 R2 User
Interface

This section describes how to navigate between the main user interface screens of the Windows
Server 2012 R2 operating system.

The following table describes some of the main Microsoft Windows Server 2012 R2 user interface
screens.

Screen name Description
Start The Start screen contains shortcuts to the main administration interfaces of the

server. If you have an application that you access on a regular basis, you can
add it to the Start screen so that it's more immediately accessible. The Start

Table continues…
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Screen name Description
screen displays the currently logged on user and provides some basic server log
out and locking functions. This is the operating system default screen.

Apps The Apps screen contains shortcuts to the applications and utilities installed on
the server. The server applications and utilities are grouped into categories.
Third-party vendors and applications can also add custom, vendor or product
specific, categories to the Apps screen.

Desktop The Desktop screen contains the Windows start button, the Windows Taskbar,
Recycle Bin, and shortcuts to the Windows Explorer utility, among others. The
Taskbar displays the Windows Notification Area and System Tray. The
notification area is located on the right portion of the Taskbar next to the time.

Navigation tips:

• Use the up  and down  arrow icons to navigate between the Start and Apps screens.

• To display the Start screen, on the Desktop screen, click the Windows start button.

• To display the Desktop screen, on the Start screen select the Desktop tile.

• To display the Desktop screen, on the Apps screen select the Desktop tile.

• To switch between the Start screen and the Desktop screen press the Windows start button
on your keyboard.

• To access the Control Panel, on the Apps or Start screen click on the Control Panel tile.

• To access the Administration Tools, on the Apps or Start screen click on the Administrative
Tools tile.

These screen navigation methods work when you are using the server’s keyboard and mouse
directly, or when you are using Remote Desktop to access the server.
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Figure 11: Example of the Start screen, with the down arrow icon highlighted in a red box.
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Figure 12: Example of the Apps screen, with the up arrow icon highlighted in a red box.
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Figure 13: Example of the Desktop screen, with the Windows start button highlighted in a red box.

The following table describes some of the Taskbar sections of the Desktop screen.

Icon Name Description
Windows start button Use the Windows start button to navigate to the Start screen. Use this

button to switch between the Start screen and the Desktop screen.

Server Manager Use this button to access the Server Manager to configure the roles and
features to the server.

PowerShell Use the PowerShell button to start the Windows PowerShell console.
Windows PowerShell is a command-line shell that provides cmdlets
(pronounced command-lets) for server configuration and management.
PowerShell also provides scripting functions for task automation.

This PC Use this button to start the This PC Windows Explorer. Use this to
access and navigate the folders, files, and storage devices on the
server.
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The contents of your screens can vary depending on the roles, features, and applications installed
on your server.

For more information about the Windows Server 2012 R2 operating system, refer to the Microsoft
support website and Microsoft product documentation.

Installing the most recent supported operating system
service packs

Before you begin
• Access the Avaya hotfixes list on the website http://support.avaya.com.
• Install and configure Microsoft Windows Server 2012 R2 on your server.
• Review the specifications on operating system service updates in Avaya Aura® Contact

Center Overview and Specification.

About this task
Avaya recommends that you install the most recent supported operating system service packs.
You must download the supported operating system service pack from the Avaya hotfixes list to
ensure your Contact Center server software functions correctly with the supported operating
system patches.

Procedure
1. Review the Contact Center Service Packs Compatibility and Security Hotfixes Applicability

List to determine the most recent Avaya Aura® Contact Center supported patches or
service packs.

2. Download the appropriate Microsoft Windows Server 2012 R2 patches for the Avaya Aura®

Contact Center software installed on this server.

3. Install the most recent Windows Server 2012 R2 service pack that is validated with Avaya
Aura® Contact Center by following the Microsoft Installation instructions.

Connecting to the contact center subnet
About this task
Connect the Contact Center server to the contact center subnet. The contact center subnet is the
network on which the server software applications work together to route contacts and generate
reports.

Procedure
1. Locate the slot assigned to the contact center subnet network interface card for the server.

Make a note of the slot.
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2. Connect the cable from the contact center subnet to the contact center subnet network
interface card in the server in accordance with customer site networking guidelines.

3. Use the ping command to test the contact center subnet.

Adding a server to a domain
Before you begin

• Ensure that you have domain administrator privileges, or ask the Domain Administrator to
assign you a domain user account for remote access.

• On the server, configure a preferred Domain Name System (DNS) server on the Network
Interface Card (NIC).

About this task
Add the server to an existing domain.

Note:
Add the server to a Windows domain before installing Contact Center software. When joining
the domain, ensure the server time and domain controller time are synchronized to the same
time.

Ask your System Administrator to add a Domain Name System (DNS) static entry for this server.
Each Contact Center server in a domain requires a DNS static entry.
If your solution is going to use High Availability, ask your System Administrator to add one DNS
static entry for each managed name and associated managed IP address. A typical High
Availability campus solution with a pair of servers requires three DNS static entries; one DNS
static entry for the active server, one DNS static entry for the standby server, and one DNS static
entry for the managed name and associated IP address. Avaya Aura® Contact Center High
Availability solutions do not support Windows Server Dynamic DNS.

Procedure
1. Log on to the server.

2. On the Start screen, select Administrative Tools  > Server Manager.
3. In the left pane, select Local Server.
4. In the right pane, in the Properties section, double-click on the Domain value.

The System Properties dialog box appears.

5. In the System Properties dialog box, click the Computer Name tab.

6. Click Change.

7. In the Member of section, click the Domain option.

8. Type the domain name (you must provide the fully qualified domain name, which includes
the prefix and suffix).
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9. Click OK.

10. Type the domain administrator User name and Password.

11. Click OK.

12. Restart the server when you are prompted to do so.

Downloading the most recent Contact Center patches to
the server

Before you begin
• Download and install the most recent and supported updates for Microsoft Windows Server

2012 R2.
• Know the location at which you plan to install each Contact Center server software package.
• Ensure that you use one administrator account on your server to un-install and install

software updates.

About this task
To ensure that you have the most current software, download the most recent Contact Center
patches from http://support.avaya.com to the server you plan to install.

Procedure
1. Log on to the server using the administrator account.

2. Create a folder <Drive>:\Avaya-ProductUpdates\ to save the software updates. Where
<Drive> is the drive letter on which you want to save the Contact Center software updates.

3. Download the most recent service pack file. Save and unzip the file on the Contact Center
server in the Avaya-ProductUpdates folder.

4. If new patches are available for the latest service pack, download and save the patches on
the Contact Center server in the Avaya-ProductUpdates folder.

5. Read the Contact Center Release Notes for the most recent instructions.

Disabling unused Network Adapters
About this task
Disable all unused Network Adapters or Network Interface Cards (NICs) to improve network
communications and prevent the erroneous configuration of unused NICs during Contact Center
server commissioning.
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Procedure
1. Log on to the server.

2. On the Start screen, select Control Panel  > Network and Internet  > Network and
Sharing Center  > Change adapter settings.

3. Right-click on the unused Network Adapter, and select Disable.

4. Repeat this procedure for all unused Network Adapters.

Enabling Microsoft Remote Desktop connection
About this task
Enable Microsoft Remote Desktop connection as your remote access tool. Microsoft Remote
Desktop provides remote access for support on the server.

Procedure
1. Log on to the server with administrator privileges.

2. On the Start screen, select Control Panel  > System and Security.

3. In the System section, select Allow remote access.

4. Click the Remote tab.

5. Select Allow remote connections to this computer.
6. Click Apply.

7. Click OK.

Disabling NetBIOS
About this task
If the Contact Center server uses two Network Interface Cards (NICs), disable NetBIOS on the
Embedded LAN (ELAN) network interface card (NIC) to avoid NetBIOS conflicts.
Contact Center supports two Network Interface Cards (NICs) and two subnets (one contact center
subnet and one ELAN subnet). The Contact Center ELAN NIC and ELAN subnet are optional.

Procedure
1. Log on to the server.

2. On the Start screen, select Control Panel  > Network and Internet.
3. Click Network and Sharing Center.
4. Click Change adapter settings.
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5. Right-click the ELAN Network Interface Card (NIC).

6. Click Properties.

7. Select Internet Protocol Version 4 (TCP/IPv4).
8. Click Properties.

9. Click Advanced.

10. Click the WINS tab.

11. Select the Disable NetBIOS over TCP/IP check box.

12. Click OK.

Connecting the Embedded LAN subnet
Before you begin

• Install two network cards on the Contact Center server.
• Disable the NetBIOS on the ELAN network interface card.
• Connect the contact center subnet network interface card.

About this task
If your server uses two NICs, connect the Embedded LAN (ELAN) NIC to the ELAN subnet.
Contact Center supports two network interface cards (NICs) and two subnets (one contact center
subnet and one ELAN subnet). The Contact Center ELAN NIC and ELAN subnet are optional.

Procedure
1. Locate the slot assigned to the ELAN network interface card for the server.

2. Write the MAC address of the card on a small label. Attach the label to the back of the card
or the chassis slot position.

3. Connect the ELAN subnet from the Avaya equipment to the Ethernet hub.

4. Connect the network cable from the ELAN network interface card in the server to the hub.

5. Plug in the power cord for the hub.

6. If you have an ELAN subnet network connection, use the ping command to test it.

Configuring the binding order
Before you begin

• Install two network interface cards on the Contact Center server.
• Disable the NetBIOS on the ELAN network interface card.
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• Connect the Contact Center server network interface card to the contact center subnet.
• Connect the Contact Center server ELAN network interface card to the ELAN subnet.

About this task
Configure the binding order of the network cards. The contact center subnet network interface
card must be bound first and then the ELAN network interface card.

Procedure
1. On the Start screen, select Control Panel  > Network and Internet  > Network and

Sharing Center.
2. Click Change adapter settings.

3. In the Network Connections window, press the ALT key.

A hidden menu appears.

4. Choose Advanced  > Advanced Settings.

5. In the Connections box, ensure that the contact center subnet connection is listed first. If
it is not listed first, adjust the order.

Disabling Admin Approval Mode for Windows Server
administrators

About this task
Windows Server 2012 implements a security feature known as User Account Control (UAC). By
default, this feature causes applications run by local non built-in administrators to behave as if the
applications had been run by standard users. Perform this procedure to ensure that local
administrators get full privileges for running applications.

Note:
This procedure describes how to disable Admin Approval Mode on the Contact Center server
using one method only; there are additional methods available. For example, you can also
administer User Account Control settings for the Contact Center server using a group policy.

Procedure
1. On the Start screen, select Administrative Tools  > Local Security Policy.

2. Under Security Settings, expand Local Policies.

3. Select Security Options.

4. In the policy pane on the right, double-click on User Account Control: Run all
administrators in Admin Approval Mode.

5. Click the Local Security Setting tab, and select Disabled.

6. Click OK.
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If prompted, restart the server.

Disabling Windows Server 2012 Automatic Maintenance
About this task
Disable Windows Server 2012 R2 Automatic Maintenance while installing Contact Center
software. Windows Server 2012 Automatic Maintenance can occasionally interfere with the real-
time requirements for Contact Center deployment and configuration. You must therefore
temporarily disable Automatic Maintenance to install and configure Contact Center software. You
re-enable Automatic Maintenance after deploying and configuring Contact Center.

Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.
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5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows  > TaskScheduler.

6. In the Name column, right-click Idle Maintenance and select Disable.

7. In the Name column, right-click Regular Maintenance and select Disable.

8. From the File menu, select Exit.

Installing the Voice Contact Server software for CS1000
Before you begin

• Ensure the Avaya Communication Server 1000 is configured. For more information see
Avaya Aura® Contact Center and Avaya Communication Server 1000 Integration.

• Download the most recent Contact Center and Common Components patches to the server.
• Read the Contact Center Release Notes for the most recent instructions.

About this task
Install the Contact Center Voice Contact Server software on the server.

Procedure
1. Insert the Contact Center DVD into the DVD drive of your server.

2. If the installation does not automatically start, double-click Setup.exe.

3. Click Accept to install the Microsoft .NET Framework on the server.

If you are prompted to accept the Microsoft .NET Framework license agreement, click
Accept. If you are prompted to restart the server, click Yes and repeat step 2.

4. Contact Center software installer runs Operating System and hardware checks on the
server. If the installer returns a Fail, the software installation cannot proceed until you
correct the problem. Review any failures returned by the System Readiness Check and
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consult Avaya Aura® Contact Center Overview and Specification to determine the actions
to resolve the issue.

You can ignore warnings if the potential impact to the operation of the contact center is
understood and not applicable.

5. The Contact Center software installer platform and server selection screen appears.

6. In the Select Voice Platform section, select Avaya Communication Server 1000 - AML.

7. In the Select Server Installation Option section, select Voice Contact Server Only.

8. Click Next.
9. Under Journal Database Drive, select the drive for the database journal. The default drive

partition is H:.

10. Under Voice Contact Server Database Drive, select the drive for the Contact Center
Manager Server, Communication Control Toolkit, and Contact Center Manager
Administration databases. The default drive partition is F:.

11. In the Service Packs section, browse to and select the Service Pack.
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12. Click Install.
13. The AVAYA GLOBAL SOFTWARE LICENSE TERMS window appears.

14. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
15. The MICROSOFT SOFTWARE LICENSE TERMS window appears.

16. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
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17. The Progress window appears and displays the installation progress.

18. When the software is installed, you have the following options.

• To continue configuring the server installation data:

a. Select Launch Avaya Aura Contact Center Ignition Wizard.

b. Click Configure. This starts the Avaya Aura® Contact Center Ignition Wizard.

• To defer configuring the server installation data:

a. Clear Launch Avaya Aura Contact Center Ignition Wizard.

b. On the message box, click Yes.

c. On the main installer screen, click Close.

d. Follow the on-screen instructions and shut down the Contact Center server.

You must use the Ignition Wizard to initialize Avaya Aura® Contact Center, otherwise
Avaya Aura® Contact Center is not operational. For more information about the Ignition
Wizard, see the following procedures.

Configuring Voice Contact Server software for CS1000
Before you begin

• Ensure the Avaya Communication Server 1000 is configured. For more information see
Avaya Aura® Contact Center and Avaya Communication Server 1000 Integration.

• You must configure the required language and locale of the Contact Center server operating
system, if it is not a Latin-1 language, before configuring the Contact Center server using the
Contact Center Ignition Wizard. For more information about configuring language and locale
settings on the Contact Center server, see Avaya Aura® Contact Center Server
Administration.

• Download the most recent Contact Center and Common Components patches to the server.
• Read the Contact Center Release Notes for the most recent instructions.

About this task
Configure the Contact Center Voice Contact Server software and enable your contact center to
route contacts to the agents that can answer the call with the correct skills.

Procedure
1. Log on to the Contact Center server using the Administrator account details.

2. On the Contact Center Ignition Wizard screen, click Next. If the Contact Center Ignition
Wizard is not visible, click the Ignition Wizard shortcut on the desktop.

3. On the End-User License Agreement screen, read the license agreement. Optionally,
click Print to generate a local soft copy (in OpenXPS Document format) of the license
agreement.
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4. Select I Accept the Terms of the End-User License Agreement and click Next.
5. On the Configuration Data window, type the configuration details for each tab.

6. Select the Core tab, and configure the server details.

7. In the Site Name box, type the site name for the Contact Center server. The site name
must not contain spaces or non-alphabetical characters except hyphen (-) and underscore
(_). The first character must be a letter. The site name must be unique and can consist of 6
to 15 characters.

8. In the Real-Time Statistics Multicast IP Address box, type the Real-time Statistics
Multicast IP Address of the server to associate with sending real-time data. The IP
Address must be from 224.0.1.0 to 239.255.255.255. The default is 234.5.6.10.

9. In the Network Configuration section, in the ELAN P Address box, type the IP Address
of the embedded local area network. The embedded local area network (ELAN) is a
dedicated Ethernet LAN that connects Contact Center to the PABX.

10. In the CLAN IP Address box, type the IP Address of the Contact Center server. This is the
Contact Center server IP address on the subnet that connects to the other servers and
agent client computers in the contact center solution.

11. In the System Account Configuration section, in the Password box, type a password for
the Contact Center administration account. The password is checked against the server
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security policy for minimum password requirements. Avaya recommends that you enter a
password that conforms to your corporate password policy.

12. In the Confirm Password box, type the password.

13. Select the Licensing tab, and configure the licensing details.

14. From the License Type list, select Standard KRS.

15. Click Browse to locate and load your license file.

16. From the Licensing Package list, select the license type that you have purchased. Select
Nodal Enterprise for single-site contact centers.

17. From the list of Optional Packages, enable the licensed features that you have
purchased.

18. Select the Open Queue check box.

19. Select the CS1000 tab.

20. In the Switch Name box, type the name of the AML Avaya Communication Server 1000
telephone switch. Valid characters for Avaya Communication Server 1000 names are A–Z,
a–z, 0–9, underscore (_), and period (.). Names must begin with an alphabetical character
and cannot contain spaces. The last character must not be an underscore or a period.
Names must not exceed 80 characters in length.
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21. In the Switch IP Address box, type the IP address of the Avaya Communication Server
1000.

22. In the Switch Customer Number box, type the customer number for the Avaya
Communication Server 1000.

23. In the Alternative Switch IP Address box, type the IP address of an alternate Avaya
Communication Server 1000, if you have one.

24. In the Alternative Switch Customer Number box, type the customer number of the
alternate Avaya Communication Server 1000, if you have one.

25. In the Alternative Switch Serial ID box, type the serial number of the alternate Avaya
Communication Server 1000, if you have one.

26. In the Voice Connection Type section, select the method used to connect to the PABX.
Select None, Avaya Aura Experience Portal, or CallPilot.

27. If you are using an Avaya CallPilot® server, enter the Avaya CallPilot® server ELAN IP
Address and then configure the Port to 10008.

28. If you are using Avaya CallPilot® High Availability, in the CPHA Managed CLAN IP
Address box, type the Avaya CallPilot® Managed CLAN IP address.

29. If you are using an Avaya CallPilot® server, in the CLAN IP Address box, type the CLAN
IP address of the Avaya CallPilot® server.

30. Select the Security Configuration tab, and configure the security details in the Security
Store Details section.
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31. If you do not want to enable security, select the Skip Security Configuration checkbox
and skip to step 50 on page 187.

Important:

A warning message appears.

32. In the Full Computer Name (FQDN) box, type the full FQDN of the server on which you
are creating the security store.

Important:

The FQDN must be the full machine name of the server that the Security Store resides
on. The FQDN name is case-sensitive.

33. In the Name of Organizational unit box, type the name of the department or division
within the company.

34. In the Name of Organization box, type the company name.

35. In the City or Locality box, type the name of the city or district in which the contact center
is located.

36. In the State or Province box, type the state or province in which the contact center is
located.
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37. In the Two Letter Country Code box, type the country code in which the contact center is
located.

38. In the Security Store password box, type a password for accessing the new security
store.

39. In the Confirm Store password box, confirm the password for accessing the new security
store.

Important:

Ensure you remember this password, because you need it when you log on to Security
Manager after install. If you forget the password, you cannot access Security Manager.

40. If you are implementing High Availability in the contact center, generate the security store
using Subject Alternative Names (SANs). In the Subject Alternative Name section, for
each SAN you want to add:

a. From the Type drop-down list, select DNS.

b. In the Value field, type the FQDN for the server.

c. Click Add.

For a High Availability system, add the current server FQDN and the Managed name for
the HA pair.

41. If you want to change the encryption setting, select the required encryption settings from
the Encryption Algorithm Level and Key Size drop-down lists.

The default value for Encryption Algorithm is SHA256 and the default value for Key Size
is 2048.

Contact Center displays a warning message if you select SHA1 or 1024. Contact Center
includes these values for backward-compatibility only, because these settings do not meet
the industry-recommended level of encryption.

42. Click Create Store.

43. You can now use the Security Configuration tab to create and save a Certificate Signing
Request (CSR) file.
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44. Click Create CSR File.

45. From the Save In drop-down list, select a shared location in which to save the CSR file
and click Save.

You must now send the Certificate Signing Request file to a Certificate Authority and
receive a signed certificate and root certificate to import to the security store.

46. In the Imported Trusted Certificate Authority Root Certificate(s) section, click Add to
import the Certificate Authority root certificate.

47. In the Open dialog box, browse to the location of the certificate and click Open.

48. In the Imported Identity Security Certificate section, click Add to import the Certificate
Authority signed certificate.

49. In the Open dialog box, browse to the location of the certificate and click Open.

50. Click Next.
51. Review and verify the summary information, and click Configure.

52. After the installation is complete, click Finish.

53. If prompted, restart the server.
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Enabling Windows Server 2012 Automatic Maintenance
About this task
Enable Windows Server 2012 R2 Automatic Maintenance after deploying and configuring Contact
Center software.

Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.

5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows > TaskScheduler.

6. In the Name column, right-click Idle Maintenance and select Enable.

7. In the Name column, right-click Regular Maintenance and select Enable.

8. From the File menu, select Exit.

Securing the Windows server
About this task
Apply optional security measures to your operating system to further secure your server.

Important:
Scanning software can degrade the performance and decrease the reliability of the system.
Install virus scanning software only if the system connects to an exposed network or to the
Internet.

Primary Voice Contact Server for CS1000 installation in a domain

July 2018 Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000 188
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000


Important:
To maintain server performance, you must schedule virus scans during maintenance periods
or low usage hours only.

Procedure
1. Harden the operating system using defined site procedures.

2. Install antivirus software. If you install antivirus software, Avaya recommends that you
exclude some contact center files and folders from real-time and scheduled scans. For
more information, and for a list of files and folders to exclude, see Avaya Aura® Contact
Center Overview and Specification.

Commissioning the Contact Center server
About this task
Commission the installed Contact Center software.

Procedure
Commission the installed Contact Center software.

For information about commissioning the installed server software, see Avaya Aura® Contact
Center Commissioning for Avaya Communication Server 1000.
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Chapter 12: Standby Voice Contact Server
for CS1000 installation in a
domain

This chapter describes how to install a standby Voice Contact Server for Avaya Communication
Server 1000 (CS1000). A standby Voice Contact Server includes the following server software:

• Contact Center Manager Server (CCMS)

• Contact Center Manager Server Utility

• Contact Center License Manager

• Contact Center Manager Administration (CCMA)

• Communication Control Toolkit (CCT)

Voice Contact Server supports two Network Interface Cards (NICs) and two subnets (one contact
center subnet and one ELAN subnet). The Voice Contact Server ELAN NIC and ELAN subnet are
optional.

You can install a standby Voice Contact Server and commission it to be the standby Voice Contact
Server in a campus High Availability solution. The standby server takes over contact processing and
becomes the active server if the existing active server fails. The standby server provides High
Availability redundancy and resiliency. The standby and active servers must be at the same patch
level and have the same hard disk drive partitions.

You must complete the procedures in this section in sequential order.

Standby Voice Contact Server installation prerequisites
Procedure

• Copy the most recent patches for the Contact Center software.

• Ensure that your new Contact Center license file with a High Availability standby server
license is available.
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Downloading the most recent documentation
Before you begin

• Download the most recent version of Acrobat Reader.
• Access the Avaya website at http://support.avaya.com.

About this task
Download the most recent documentation to ensure you have the most recent updates. Updates
in the documentation accurately reflect the most recent changes in the software.

Procedure
1. Log on to the Avaya website.

2. Compare the versions of the documentation on the site with the versions you have.

3. If the version number on http://support.avaya.com is higher than your version, download
the latest version of the document.

4. Review the Avaya website for release notes and readme files.

Installing Microsoft Windows Server 2012 R2
Before you begin

• Ensure that you have a newly formatted server that meets the specifications in Avaya Aura®

Contact Center Overview and Specification on which to install Microsoft Windows Server
2012 R2.
Do not upgrade your operating system from a previous release. Contact Center is not
supported on an upgraded operating system.

• Configure all servers for RAID as described in Avaya Aura® Contact Center Overview and
Specification.

• Ensure that you have a DVD for Microsoft Windows Server 2012 R2 Standard or Data
Center. Ensure that your DVD is the R2 version of Windows Server 2012 Standard or Data
Center.

• Ensure that you have a Microsoft Windows Server 2012 R2 operating system product key.
• Know the IP addresses for the contact center subnet.

About this task
Install the Microsoft Windows Server 2012 R2 Standard or Data Center operating system and
configure it to support Contact Center server software.
The following table lists the main inputs to consider while installing the operating system.
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Name Description
Computer name Do not use spaces or underscores or exceed 15 characters. The name must start

with an alphabetic character. Server names must adhere to RFC1123. Avaya
recommends that you configure the server final production name before installing
Contact Center software.

The computer name must match (including case sensitivity) the DNS name.
Disk drives Format the partitions as required for the server. For more information, see Avaya

Aura® Contact Center Overview and Specification.
Domain name Configure as required for your site.

You must check to ensure the DNS Domain name (including case) matches the
server name if the server is added to a domain after configuration.

Licensing modes Select Per server licensing mode.

Accept the default five concurrent connections.
Network components Configure IP Address, WINS, DNS for one or two network cards as per

configuration. Contact Center does not support IPv6.
Network connections If the server has more than one NIC/adapter, ensure contact center subnet

appears first in the network adapter binding order.
Hard Disk Partitions Configure C: drive to be a primary drive. Configure the other drives on your server

to meet the requirements according to Avaya Aura® Contact Center Overview and
Specification for the server.

Perform this procedure on each server before you install Contact Center server software on the
server.

Procedure
1. Insert the Microsoft Windows Server 2012 R2 Standard or Data Center DVD into the DVD

drive.

2. Turn on the power to the server.

The server begins to boot up.

3. On the Windows Setup screen, select a Language to install from the list.

4. Select a Time and currency format from the list.

5. Select Keyboard or input method from the list.

6. Click Next.
7. Click Install now.

8. Depending on the DVD image that you use, you might need to select an operating system
from a list. Select a version of Windows Server 2012 R2 Standard or Data Center that
includes a Graphical User Interface (GUI). Install a version that includes “(Server with a
GUI)”.

9. Click Next.
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10. On the Enter the product key to activate Windows window, enter the operating system
product key.

11. Click Next.
12. On the Windows Setup screen, read the terms of the license agreement and select I

accept the license terms.

13. Click Next.
14. Select Custom: Install Windows only (advanced) to install a clean new installation of the

operating system.

15. Select the disk partition on which you want to install Windows Server 2012 R2.

Important:

You can use the partition management options to configure the partitions on your
server.

16. Click Next.

The installation proceeds and automatically restarts the server several times.

17. After completing the installation, log on to the server as Administrator. Enter and confirm
the Administrator password.

18. Select Set time zone and complete the information as required for your system.

19. Select Configure Networking and complete the information for your Network Interface
Card (NIC) with the server IP address.

20. Select Provide computer name and domain and complete the information for your server
name and network settings.

21. Change the DVD drive letter to E: to ensure the correct drive letters are free for the
Contact Center application and database hard disk drives and partitions.

22. Configure the hard disk drives and partitions for this server using the Windows Server
2012 R2 Computer Management - Disk Management utility. For more information about
hard disk drives and partitions, see Avaya Aura® Contact Center Overview and
Specification.

23. Install other required drivers for your hardware configuration.

Job aid: Hard disk drive partitions
Configure the hard disk drives and partitions. These are the minimum hard disk partition sizes. For
more information about hard disk requirements, including the recommended partition sizes, see
Avaya Aura® Contact Center Overview and Specification.

For each partition, specify a volume size in MBs that when formatted results in a disk partition that
is equal to or greater than the required minimum partition size.

Installing Microsoft Windows Server 2012 R2
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Hard disk drive Drive letter Minimum size
partition

Operating System drive

Including the 350 MB Windows boot loader System Reserved
partition.

C: 80 GB NTFS

Application drive D: 120 GB NTFS
DVD drive

For continuity and consistency, Avaya recommends using Drive
letter E: for the DVD drive. However, Contact Center supports any
DVD Drive letter, other than the Drive letters listed here for the
hard disk partitions.

E: —

Voice Contact Server database drive F: 200 GB NTFS
Database journal H: 100 GB NTFS

Installing the most recent supported operating system
service packs

Before you begin
• Access the Avaya hotfixes list on the website http://support.avaya.com.
• Install and configure Microsoft Windows Server 2012 R2 on your server.
• Review the specifications on operating system service updates in Avaya Aura® Contact

Center Overview and Specification.

About this task
Avaya recommends that you install the most recent supported operating system service packs.
You must download the supported operating system service pack from the Avaya hotfixes list to
ensure your Contact Center server software functions correctly with the supported operating
system patches.

Procedure
1. Review the Contact Center Service Packs Compatibility and Security Hotfixes Applicability

List to determine the most recent Avaya Aura® Contact Center supported patches or
service packs.

2. Download the appropriate Microsoft Windows Server 2012 R2 patches for the Avaya Aura®

Contact Center software installed on this server.

3. Install the most recent Windows Server 2012 R2 service pack that is validated with Avaya
Aura® Contact Center by following the Microsoft Installation instructions.
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Connecting to the contact center subnet
About this task
Connect the Contact Center server to the contact center subnet. The contact center subnet is the
network on which the server software applications work together to route contacts and generate
reports.

Procedure
1. Locate the slot assigned to the contact center subnet network interface card for the server.

Make a note of the slot.

2. Connect the cable from the contact center subnet to the contact center subnet network
interface card in the server in accordance with customer site networking guidelines.

3. Use the ping command to test the contact center subnet.

Adding a server to a domain
Before you begin

• Ensure that you have domain administrator privileges, or ask the Domain Administrator to
assign you a domain user account for remote access.

• On the server, configure a preferred Domain Name System (DNS) server on the Network
Interface Card (NIC).

About this task
Add the server to an existing domain.

Note:
Add the server to a Windows domain before installing Contact Center software. When joining
the domain, ensure the server time and domain controller time are synchronized to the same
time.

Ask your System Administrator to add a Domain Name System (DNS) static entry for this server.
Each Contact Center server in a domain requires a DNS static entry.
If your solution is going to use High Availability, ask your System Administrator to add one DNS
static entry for each managed name and associated managed IP address. A typical High
Availability campus solution with a pair of servers requires three DNS static entries; one DNS
static entry for the active server, one DNS static entry for the standby server, and one DNS static
entry for the managed name and associated IP address. Avaya Aura® Contact Center High
Availability solutions do not support Windows Server Dynamic DNS.

Procedure
1. Log on to the server.

2. On the Start screen, select Administrative Tools  > Server Manager.

Connecting to the contact center subnet

July 2018 Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000 195
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000


3. In the left pane, select Local Server.
4. In the right pane, in the Properties section, double-click on the Domain value.

The System Properties dialog box appears.

5. In the System Properties dialog box, click the Computer Name tab.

6. Click Change.

7. In the Member of section, click the Domain option.

8. Type the domain name (you must provide the fully qualified domain name, which includes
the prefix and suffix).

9. Click OK.

10. Type the domain administrator User name and Password.

11. Click OK.

12. Restart the server when you are prompted to do so.

Downloading the most recent Contact Center patches to
the server

Before you begin
• Download and install the most recent and supported updates for Microsoft Windows Server

2012 R2.
• Know the location at which you plan to install each Contact Center server software package.
• Ensure that you use one administrator account on your server to un-install and install

software updates.

About this task
To ensure that you have the most current software, download the most recent Contact Center
patches from http://support.avaya.com to the server you plan to install.

Procedure
1. Log on to the server using the administrator account.

2. Create a folder <Drive>:\Avaya-ProductUpdates\ to save the software updates. Where
<Drive> is the drive letter on which you want to save the Contact Center software updates.

3. Download the most recent service pack file. Save and unzip the file on the Contact Center
server in the Avaya-ProductUpdates folder.

4. If new patches are available for the latest service pack, download and save the patches on
the Contact Center server in the Avaya-ProductUpdates folder.

5. Read the Contact Center Release Notes for the most recent instructions.
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Disabling unused Network Adapters
About this task
Disable all unused Network Adapters or Network Interface Cards (NICs) to improve network
communications and prevent the erroneous configuration of unused NICs during Contact Center
server commissioning.

Procedure
1. Log on to the server.

2. On the Start screen, select Control Panel  > Network and Internet  > Network and
Sharing Center  > Change adapter settings.

3. Right-click on the unused Network Adapter, and select Disable.

4. Repeat this procedure for all unused Network Adapters.

Enabling Microsoft Remote Desktop connection
About this task
Enable Microsoft Remote Desktop connection as your remote access tool. Microsoft Remote
Desktop provides remote access for support on the server.

Procedure
1. Log on to the server with administrator privileges.

2. On the Start screen, select Control Panel  > System and Security.

3. In the System section, select Allow remote access.

4. Click the Remote tab.

5. Select Allow remote connections to this computer.
6. Click Apply.

7. Click OK.

Disabling NetBIOS
About this task
If the Contact Center server uses two Network Interface Cards (NICs), disable NetBIOS on the
Embedded LAN (ELAN) network interface card (NIC) to avoid NetBIOS conflicts.
Contact Center supports two Network Interface Cards (NICs) and two subnets (one contact center
subnet and one ELAN subnet). The Contact Center ELAN NIC and ELAN subnet are optional.
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Procedure
1. Log on to the server.

2. On the Start screen, select Control Panel  > Network and Internet.
3. Click Network and Sharing Center.
4. Click Change adapter settings.

5. Right-click the ELAN Network Interface Card (NIC).

6. Click Properties.

7. Select Internet Protocol Version 4 (TCP/IPv4).
8. Click Properties.

9. Click Advanced.

10. Click the WINS tab.

11. Select the Disable NetBIOS over TCP/IP check box.

12. Click OK.

Connecting the Embedded LAN subnet
Before you begin

• Install two network cards on the Contact Center server.
• Disable the NetBIOS on the ELAN network interface card.
• Connect the contact center subnet network interface card.

About this task
If your server uses two NICs, connect the Embedded LAN (ELAN) NIC to the ELAN subnet.
Contact Center supports two network interface cards (NICs) and two subnets (one contact center
subnet and one ELAN subnet). The Contact Center ELAN NIC and ELAN subnet are optional.

Procedure
1. Locate the slot assigned to the ELAN network interface card for the server.

2. Write the MAC address of the card on a small label. Attach the label to the back of the card
or the chassis slot position.

3. Connect the ELAN subnet from the Avaya equipment to the Ethernet hub.

4. Connect the network cable from the ELAN network interface card in the server to the hub.

5. Plug in the power cord for the hub.

6. If you have an ELAN subnet network connection, use the ping command to test it.
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Configuring the binding order
Before you begin

• Install two network interface cards on the Contact Center server.
• Disable the NetBIOS on the ELAN network interface card.
• Connect the Contact Center server network interface card to the contact center subnet.
• Connect the Contact Center server ELAN network interface card to the ELAN subnet.

About this task
Configure the binding order of the network cards. The contact center subnet network interface
card must be bound first and then the ELAN network interface card.

Procedure
1. On the Start screen, select Control Panel  > Network and Internet  > Network and

Sharing Center.
2. Click Change adapter settings.

3. In the Network Connections window, press the ALT key.

A hidden menu appears.

4. Choose Advanced  > Advanced Settings.

5. In the Connections box, ensure that the contact center subnet connection is listed first. If
it is not listed first, adjust the order.

Disabling Admin Approval Mode for Windows Server
administrators

About this task
Windows Server 2012 implements a security feature known as User Account Control (UAC). By
default, this feature causes applications run by local non built-in administrators to behave as if the
applications had been run by standard users. Perform this procedure to ensure that local
administrators get full privileges for running applications.

Note:
This procedure describes how to disable Admin Approval Mode on the Contact Center server
using one method only; there are additional methods available. For example, you can also
administer User Account Control settings for the Contact Center server using a group policy.

Procedure
1. On the Start screen, select Administrative Tools  > Local Security Policy.

2. Under Security Settings, expand Local Policies.
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3. Select Security Options.

4. In the policy pane on the right, double-click on User Account Control: Run all
administrators in Admin Approval Mode.

5. Click the Local Security Setting tab, and select Disabled.

6. Click OK.

If prompted, restart the server.

Disabling Windows Server 2012 Automatic Maintenance
About this task
Disable Windows Server 2012 R2 Automatic Maintenance while installing Contact Center
software. Windows Server 2012 Automatic Maintenance can occasionally interfere with the real-
time requirements for Contact Center deployment and configuration. You must therefore
temporarily disable Automatic Maintenance to install and configure Contact Center software. You
re-enable Automatic Maintenance after deploying and configuring Contact Center.
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Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.

5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows  > TaskScheduler.

6. In the Name column, right-click Idle Maintenance and select Disable.

7. In the Name column, right-click Regular Maintenance and select Disable.

8. From the File menu, select Exit.

Installing the Voice Contact Server software for CS1000
Before you begin

• Ensure the Avaya Communication Server 1000 is configured. For more information see
Avaya Aura® Contact Center and Avaya Communication Server 1000 Integration.

• Download the most recent Contact Center and Common Components patches to the server.
• Read the Contact Center Release Notes for the most recent instructions.

About this task
Install the Contact Center Voice Contact Server software on the server.

Procedure
1. Insert the Contact Center DVD into the DVD drive of your server.

2. If the installation does not automatically start, double-click Setup.exe.
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3. Click Accept to install the Microsoft .NET Framework on the server.

If you are prompted to accept the Microsoft .NET Framework license agreement, click
Accept. If you are prompted to restart the server, click Yes and repeat step 2.

4. Contact Center software installer runs Operating System and hardware checks on the
server. If the installer returns a Fail, the software installation cannot proceed until you
correct the problem. Review any failures returned by the System Readiness Check and
consult Avaya Aura® Contact Center Overview and Specification to determine the actions
to resolve the issue.

You can ignore warnings if the potential impact to the operation of the contact center is
understood and not applicable.

5. The Contact Center software installer platform and server selection screen appears.

6. In the Select Voice Platform section, select Avaya Communication Server 1000 - AML.

7. In the Select Server Installation Option section, select Voice Contact Server Only.

8. Click Next.
9. Under Journal Database Drive, select the drive for the database journal. The default drive

partition is H:.

10. Under Voice Contact Server Database Drive, select the drive for the Contact Center
Manager Server, Communication Control Toolkit, and Contact Center Manager
Administration databases. The default drive partition is F:.

11. In the Service Packs section, browse to and select the Service Pack.
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12. Click Install.
13. The AVAYA GLOBAL SOFTWARE LICENSE TERMS window appears.

14. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
15. The MICROSOFT SOFTWARE LICENSE TERMS window appears.

16. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
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17. The Progress window appears and displays the installation progress.

18. When the software is installed, you have the following options.

• To continue configuring the server installation data:

a. Select Launch Avaya Aura Contact Center Ignition Wizard.

b. Click Configure. This starts the Avaya Aura® Contact Center Ignition Wizard.

• To defer configuring the server installation data:

a. Clear Launch Avaya Aura Contact Center Ignition Wizard.

b. On the message box, click Yes.

c. On the main installer screen, click Close.

d. Follow the on-screen instructions and shut down the Contact Center server.

You must use the Ignition Wizard to initialize Avaya Aura® Contact Center, otherwise
Avaya Aura® Contact Center is not operational. For more information about the Ignition
Wizard, see the following procedures.

Configuring the standby Voice Contact Server software for
CS1000

Before you begin
• Ensure the Avaya Communication Server 1000 is configured. For more information see

Avaya Aura® Contact Center and Avaya Communication Server 1000 Integration.
• You must configure the required language and locale of the Contact Center server operating

system, if it is not a Latin-1 language, before configuring the Contact Center server using the
Contact Center Ignition Wizard. For more information about configuring language and locale
settings on the Contact Center server, see Avaya Aura® Contact Center Server
Administration.

• Download the most recent Contact Center and Common Components patches to the server.
• Read the Contact Center Release Notes for the most recent instructions.

About this task
Configure the standby Contact Center Voice Contact Server software to provide a resilient
solution.

Procedure
1. Log on to the standby Contact Center server using the Administrator account details.

2. On the Contact Center Ignition Wizard screen, click Next. If the Contact Center Ignition
Wizard is not visible, click the Ignition Wizard shortcut on the desktop.
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3. On the End-User License Agreement screen, read the license agreement. Optionally,
click Print to generate a local soft copy (in OpenXPS Document format) of the license
agreement.

4. Select I Accept the Terms of the End-User License Agreement and click Next.
5. On the Configuration Data window, type the configuration details for each tab.

6. Select the Core tab, and configure the server details.

7. In the Site Name box, type the site name for the Contact Center server. The site name
must not contain spaces or non-alphabetical characters except hyphen (-) and underscore
(_). The first character must be a letter. The site name must be unique and can consist of 6
to 15 characters. The Site Name of the standby server must be the same as the Site Name
of the primary server.

8. In the Real-Time Statistics Multicast IP Address box, type the Real-time Statistics
Multicast IP Address of the server to associate with sending real-time data. The IP
Address must be from 224.0.1.0 to 239.255.255.255. The default is 234.5.6.10.

9. In the Network Configuration section, in the ELAN IP Address box, type the IP Address
of the embedded local area network. The embedded local area network (ELAN) is a
dedicated Ethernet LAN that connects Contact Center to the PABX.
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10. In the CLAN IP Address box, type the IP Address of the Contact Center server. This is the
Contact Center server IP address on the subnet that connects to the other servers and
agent client computers in the contact center solution.

11. In the System Account Configuration section, in the Password box, type a password for
the Contact Center administration account. The password is checked against the server
security policy for minimum password requirements. Avaya recommends that you enter a
password that conforms to your corporate password policy.

12. In the Confirm Password box, type the password.

13. Select the Licensing tab, and configure the licensing details.

14. From the License Type list, select Standard KRS.

15. Click Browse to locate and load your license file.

16. From the Licensing Package list, select the license type that you have purchased. Select
Nodal Enterprise for single-site contact centers.

17. From the list of Optional Packages, enable the licensed features that you have
purchased.

18. Select the Open Queue check box.

19. Select the CS1000 tab.
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20. In the Switch Name box, type the name of the AML Avaya Communication Server 1000
telephone switch. Valid characters for Avaya Communication Server 1000 names are A–Z,
a–z, 0–9, underscore (_), and period (.). Names must begin with an alphabetical character
and cannot contain spaces. The last character must not be an underscore or a period.
Names must not exceed 80 characters in length.

21. In the Switch IP Address box, type the IP address of the Avaya Communication Server
1000.

22. In the Switch Customer Number box, type the customer number for the Avaya
Communication Server 1000.

23. In the Alternative Switch IP Address box, type the IP address of an alternate Avaya
Communication Server 1000, if you have one.

24. In the Alternative Switch Customer Number box, type the customer number of the
alternate Avaya Communication Server 1000, if you have one.

25. In the Alternative Switch Serial ID box, type the serial number of the alternate Avaya
Communication Server 1000, if you have one.

26. In the Voice Connection Type section, select the method used to connect to the PABX.
Select None, Avaya Aura Experience Portal, or CallPilot.

27. If you are using an Avaya CallPilot® server, enter the Avaya CallPilot® server ELAN IP
Address and then configure the Port to 10008.

28. If you are using Avaya CallPilot® High Availability, in the CPHA Managed CLAN IP
Address box, type the Avaya CallPilot® Managed CLAN IP address.

29. If you are using an Avaya CallPilot® server, in the CLAN IP Address box, type the CLAN
IP address of the Avaya CallPilot® server.

30. Select the Security Configuration tab, and configure the security details in the Security
Store Details section.
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31. If you do not want to enable security, select the Skip Security Configuration checkbox
and skip to step 50 on page 210.

Important:

A warning message appears.

32. In the Full Computer Name (FQDN) box, type the full FQDN of the server on which you
are creating the security store.

Important:

The FQDN must be the full machine name of the server that the Security Store resides
on. The FQDN name is case-sensitive.

33. In the Name of Organizational unit box, type the name of the department or division
within the company.

34. In the Name of Organization box, type the company name.

35. In the City or Locality box, type the name of the city or district in which the contact center
is located.

36. In the State or Province box, type the state or province in which the contact center is
located.
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37. In the Two Letter Country Code box, type the country code in which the contact center is
located.

38. In the Security Store password box, type a password for accessing the new security
store.

39. In the Confirm Store password box, confirm the password for accessing the new security
store.

Important:

Ensure you remember this password, because you need it when you log on to Security
Manager after install. If you forget the password, you cannot access Security Manager.

40. If you are implementing High Availability in the contact center, generate the security store
using Subject Alternative Names (SANs). In the Subject Alternative Name section, for
each SAN you want to add:

a. From the Type drop-down list, select DNS.

b. In the Value field, type the FQDN for the server.

c. Click Add.

For a High Availability system, add the current server FQDN and the Managed name for
the HA pair.

41. If you want to change the encryption setting, select the required encryption settings from
the Encryption Algorithm Level and Key Size drop-down lists.

The default value for Encryption Algorithm is SHA256 and the default value for Key Size
is 2048.

Contact Center displays a warning message if you select SHA1 or 1024. Contact Center
includes these values for backward-compatibility only, because these settings do not meet
the industry-recommended level of encryption.

42. Click Create Store.

43. You can now use the Security Configuration tab to create and save a Certificate Signing
Request (CSR) file.

Configuring the standby Voice Contact Server software for CS1000

July 2018 Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000 209
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000


44. Click Create CSR File.

45. From the Save In drop-down list, select a shared location in which to save the CSR file
and click Save.

You must now send the Certificate Signing Request file to a Certificate Authority and
receive a signed certificate and root certificate to import to the security store.

46. In the Imported Trusted Certificate Authority Root Certificate(s) section, click Add to
import the Certificate Authority root certificate.

47. In the Open dialog box, browse to the location of the certificate and click Open.

48. In the Imported Identity Security Certificate section, click Add to import the Certificate
Authority signed certificate.

49. In the Open dialog box, browse to the location of the certificate and click Open.

50. Click Next.
51. Review and verify the summary information, and click Configure.

52. After the installation is complete, click Finish.

53. If prompted, restart the server.

Standby Voice Contact Server for CS1000 installation in a domain

July 2018 Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000 210
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000


Enabling Windows Server 2012 Automatic Maintenance
About this task
Enable Windows Server 2012 R2 Automatic Maintenance after deploying and configuring Contact
Center software.

Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.

5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows > TaskScheduler.

6. In the Name column, right-click Idle Maintenance and select Enable.

7. In the Name column, right-click Regular Maintenance and select Enable.

8. From the File menu, select Exit.

Securing the Windows server
About this task
Apply optional security measures to your operating system to further secure your server.

Important:
Scanning software can degrade the performance and decrease the reliability of the system.
Install virus scanning software only if the system connects to an exposed network or to the
Internet.
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Important:
To maintain server performance, you must schedule virus scans during maintenance periods
or low usage hours only.

Procedure
1. Harden the operating system using defined site procedures.

2. Install antivirus software. If you install antivirus software, Avaya recommends that you
exclude some contact center files and folders from real-time and scheduled scans. For
more information, and for a list of files and folders to exclude, see Avaya Aura® Contact
Center Overview and Specification.

Commissioning the Contact Center server
About this task
Commission the installed Contact Center software.

Procedure
Commission the installed Contact Center software.

For information about commissioning the installed server software, see Avaya Aura® Contact
Center Commissioning for Avaya Communication Server 1000.
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Chapter 13: RGN Voice Contact Server for
CS1000 installation

This chapter describes how to install a Remote Geographic Node (RGN) Voice Contact Server for
Avaya Communication Server 1000 (CS1000). A standby Voice Contact Server includes the
following server software:

• Contact Center Manager Server (CCMS)

• Contact Center Manager Server Utility

• Contact Center License Manager

• Contact Center Manager Administration (CCMA)

• Communication Control Toolkit (CCT)

You can install a Voice Contact Server and commission it to be the Remote Geographic Node Voice
Contact Server in a solution with Disaster Recovery. The Remote Geographic Node (RGN) server
shadows the active server. Remote Geographic Node servers do not automatically take over if the
active server fails. The standby server, Remote Geographic Node server, and active server must be
at the same patch level and have the same hard disk drive partitions.

You can use any account with local administrative rights to install Avaya Aura® Contact Center. You
can use any account with local administrative rights to upgrade and patch Avaya Aura® Contact
Center; you do not need to always use the same account to perform these tasks.

Important:

You must disable the Admin Approval Mode security feature on the Contact Center server. This
ensures that accounts with local administrative rights get full privileges for running applications
on the Contact Center server.

Voice Contact Server supports two Network Interface Cards (NICs) and two subnets (one contact
center subnet and one ELAN subnet). The Voice Contact Server ELAN NIC and ELAN subnet are
optional.

You must complete the procedures in this section in sequential order.
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Voice Contact Server installation prerequisites
Procedure

• Copy the most recent patches for the Contact Center software.

• Ensure that your new Contact Center license file with a High Availability standby server
license is available.

Important:

For the system to correctly handle backup and restore SNMP events, you must install
Windows SNMP Service before you install Contact Center server software.

Downloading the most recent documentation
Before you begin

• Download the most recent version of Acrobat Reader.
• Access the Avaya website at http://support.avaya.com.

About this task
Download the most recent documentation to ensure you have the most recent updates. Updates
in the documentation accurately reflect the most recent changes in the software.

Procedure
1. Log on to the Avaya website.

2. Compare the versions of the documentation on the site with the versions you have.

3. If the version number on http://support.avaya.com is higher than your version, download
the latest version of the document.

4. Review the Avaya website for release notes and readme files.

Installing Microsoft Windows Server 2012 R2
Before you begin

• Ensure that you have a newly formatted server that meets the specifications in Avaya Aura®

Contact Center Overview and Specification on which to install Microsoft Windows Server
2012 R2.
Do not upgrade your operating system from a previous release. Contact Center is not
supported on an upgraded operating system.

• Configure all servers for RAID as described in Avaya Aura® Contact Center Overview and
Specification.
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• Ensure that you have a DVD for Microsoft Windows Server 2012 R2 Standard or Data
Center. Ensure that your DVD is the R2 version of Windows Server 2012 Standard or Data
Center.

• Ensure that you have a Microsoft Windows Server 2012 R2 operating system product key.
• Know the IP addresses for the contact center subnet.

About this task
Install the Microsoft Windows Server 2012 R2 Standard or Data Center operating system and
configure it to support Contact Center server software.
The following table lists the main inputs to consider while installing the operating system.

Name Description
Computer name Do not use spaces or underscores or exceed 15 characters. The name must start

with an alphabetic character. Server names must adhere to RFC1123. Avaya
recommends that you configure the server final production name before installing
Contact Center software.

The computer name must match (including case sensitivity) the DNS name.
Disk drives Format the partitions as required for the server. For more information, see Avaya

Aura® Contact Center Overview and Specification.
Domain name Configure as required for your site.

You must check to ensure the DNS Domain name (including case) matches the
server name if the server is added to a domain after configuration.

Licensing modes Select Per server licensing mode.

Accept the default five concurrent connections.
Network components Configure IP Address, WINS, DNS for one or two network cards as per

configuration. Contact Center does not support IPv6.
Network connections If the server has more than one NIC/adapter, ensure contact center subnet

appears first in the network adapter binding order.
Hard Disk Partitions Configure C: drive to be a primary drive. Configure the other drives on your server

to meet the requirements according to Avaya Aura® Contact Center Overview and
Specification for the server.

Perform this procedure on each server before you install Contact Center server software on the
server.

Procedure
1. Insert the Microsoft Windows Server 2012 R2 Standard or Data Center DVD into the DVD

drive.

2. Turn on the power to the server.

The server begins to boot up.

3. On the Windows Setup screen, select a Language to install from the list.

4. Select a Time and currency format from the list.
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5. Select Keyboard or input method from the list.

6. Click Next.
7. Click Install now.

8. Depending on the DVD image that you use, you might need to select an operating system
from a list. Select a version of Windows Server 2012 R2 Standard or Data Center that
includes a Graphical User Interface (GUI). Install a version that includes “(Server with a
GUI)”.

9. Click Next.
10. On the Enter the product key to activate Windows window, enter the operating system

product key.

11. Click Next.
12. On the Windows Setup screen, read the terms of the license agreement and select I

accept the license terms.

13. Click Next.
14. Select Custom: Install Windows only (advanced) to install a clean new installation of the

operating system.

15. Select the disk partition on which you want to install Windows Server 2012 R2.

Important:

You can use the partition management options to configure the partitions on your
server.

16. Click Next.

The installation proceeds and automatically restarts the server several times.

17. After completing the installation, log on to the server as Administrator. Enter and confirm
the Administrator password.

18. Select Set time zone and complete the information as required for your system.

19. Select Configure Networking and complete the information for your Network Interface
Card (NIC) with the server IP address.

20. Select Provide computer name and domain and complete the information for your server
name and network settings.

21. Change the DVD drive letter to E: to ensure the correct drive letters are free for the
Contact Center application and database hard disk drives and partitions.

22. Configure the hard disk drives and partitions for this server using the Windows Server
2012 R2 Computer Management - Disk Management utility. For more information about
hard disk drives and partitions, see Avaya Aura® Contact Center Overview and
Specification.

23. Install other required drivers for your hardware configuration.
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Job aid: Hard disk drive partitions
Configure the hard disk drives and partitions. These are the minimum hard disk partition sizes. For
more information about hard disk requirements, including the recommended partition sizes, see
Avaya Aura® Contact Center Overview and Specification.

For each partition, specify a volume size in MBs that when formatted results in a disk partition that
is equal to or greater than the required minimum partition size.

Hard disk drive Drive letter Minimum size
partition

Operating System drive

Including the 350 MB Windows boot loader System Reserved
partition.

C: 80 GB NTFS

Application drive D: 120 GB NTFS
DVD drive

For continuity and consistency, Avaya recommends using Drive
letter E: for the DVD drive. However, Contact Center supports any
DVD Drive letter, other than the Drive letters listed here for the
hard disk partitions.

E: —

Voice Contact Server database drive F: 200 GB NTFS
Database journal H: 100 GB NTFS

Installing the most recent supported operating system
service packs

Before you begin
• Access the Avaya hotfixes list on the website http://support.avaya.com.
• Install and configure Microsoft Windows Server 2012 R2 on your server.
• Review the specifications on operating system service updates in Avaya Aura® Contact

Center Overview and Specification.

About this task
Avaya recommends that you install the most recent supported operating system service packs.
You must download the supported operating system service pack from the Avaya hotfixes list to
ensure your Contact Center server software functions correctly with the supported operating
system patches.

Installing the most recent supported operating system service packs

July 2018 Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000 217
Comments on this document? infodev@avaya.com

http://support.avaya.com
mailto:infodev@avaya.com?subject=Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000


Procedure
1. Review the Contact Center Service Packs Compatibility and Security Hotfixes Applicability

List to determine the most recent Avaya Aura® Contact Center supported patches or
service packs.

2. Download the appropriate Microsoft Windows Server 2012 R2 patches for the Avaya Aura®

Contact Center software installed on this server.

3. Install the most recent Windows Server 2012 R2 service pack that is validated with Avaya
Aura® Contact Center by following the Microsoft Installation instructions.

Connecting to the geographic node network
About this task
Connect the Contact Center server to the geographic node network. The geographic node network
is the network at the remote geographic site.

Procedure
1. Locate the slot assigned to the geographic node network interface card for the server.

Make a note of the slot.

2. Connect the cable from the geographic node network to the geographic node network
interface card in the server in accordance with customer site networking guidelines.

3. Use the ping command to test the geographic node network.

4. Use the ping command to test connectivity with the campus network and servers.

Adding a server to a domain
Before you begin

• Ensure that you have domain administrator privileges, or ask the Domain Administrator to
assign you a domain user account for remote access.

• On the server, configure a preferred Domain Name System (DNS) server on the Network
Interface Card (NIC).

About this task
Add the server to an existing domain.

Note:
Add the server to a Windows domain before installing Contact Center software. When joining
the domain, ensure the server time and domain controller time are synchronized to the same
time.
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Ask your System Administrator to add a Domain Name System (DNS) static entry for this server.
Each Contact Center server in a domain requires a DNS static entry.
If your solution is going to use High Availability, ask your System Administrator to add one DNS
static entry for each managed name and associated managed IP address. A typical High
Availability campus solution with a pair of servers requires three DNS static entries; one DNS
static entry for the active server, one DNS static entry for the standby server, and one DNS static
entry for the managed name and associated IP address. Avaya Aura® Contact Center High
Availability solutions do not support Windows Server Dynamic DNS.

Procedure
1. Log on to the server.

2. On the Start screen, select Administrative Tools  > Server Manager.
3. In the left pane, select Local Server.
4. In the right pane, in the Properties section, double-click on the Domain value.

The System Properties dialog box appears.

5. In the System Properties dialog box, click the Computer Name tab.

6. Click Change.

7. In the Member of section, click the Domain option.

8. Type the domain name (you must provide the fully qualified domain name, which includes
the prefix and suffix).

9. Click OK.

10. Type the domain administrator User name and Password.

11. Click OK.

12. Restart the server when you are prompted to do so.

Downloading the most recent Contact Center patches to
the server

Before you begin
• Download and install the most recent and supported updates for Microsoft Windows Server

2012 R2.
• Know the location at which you plan to install each Contact Center server software package.
• Ensure that you use one administrator account on your server to un-install and install

software updates.

About this task
To ensure that you have the most current software, download the most recent Contact Center
patches from http://support.avaya.com to the server you plan to install.
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Procedure
1. Log on to the server using the administrator account.

2. Create a folder <Drive>:\Avaya-ProductUpdates\ to save the software updates. Where
<Drive> is the drive letter on which you want to save the Contact Center software updates.

3. Download the most recent service pack file. Save and unzip the file on the Contact Center
server in the Avaya-ProductUpdates folder.

4. If new patches are available for the latest service pack, download and save the patches on
the Contact Center server in the Avaya-ProductUpdates folder.

5. Read the Contact Center Release Notes for the most recent instructions.

Disabling unused Network Adapters
About this task
Disable all unused Network Adapters or Network Interface Cards (NICs) to improve network
communications and prevent the erroneous configuration of unused NICs during Contact Center
server commissioning.

Procedure
1. Log on to the server.

2. On the Start screen, select Control Panel  > Network and Internet  > Network and
Sharing Center  > Change adapter settings.

3. Right-click on the unused Network Adapter, and select Disable.

4. Repeat this procedure for all unused Network Adapters.

Enabling Microsoft Remote Desktop connection
About this task
Enable Microsoft Remote Desktop connection as your remote access tool. Microsoft Remote
Desktop provides remote access for support on the server.

Procedure
1. Log on to the server with administrator privileges.

2. On the Start screen, select Control Panel  > System and Security.

3. In the System section, select Allow remote access.

4. Click the Remote tab.
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5. Select Allow remote connections to this computer.
6. Click Apply.

7. Click OK.

Disabling NetBIOS
About this task
If the Contact Center server uses two Network Interface Cards (NICs), disable NetBIOS on the
Embedded LAN (ELAN) network interface card (NIC) to avoid NetBIOS conflicts.
Contact Center supports two Network Interface Cards (NICs) and two subnets (one contact center
subnet and one ELAN subnet). The Contact Center ELAN NIC and ELAN subnet are optional.

Procedure
1. Log on to the server.

2. On the Start screen, select Control Panel  > Network and Internet.
3. Click Network and Sharing Center.
4. Click Change adapter settings.

5. Right-click the ELAN Network Interface Card (NIC).

6. Click Properties.

7. Select Internet Protocol Version 4 (TCP/IPv4).
8. Click Properties.

9. Click Advanced.

10. Click the WINS tab.

11. Select the Disable NetBIOS over TCP/IP check box.

12. Click OK.

Connecting the Embedded LAN subnet
Before you begin

• Install two network cards on the Contact Center server.
• Disable the NetBIOS on the ELAN network interface card.
• Connect the contact center subnet network interface card.
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About this task
If your server uses two NICs, connect the Embedded LAN (ELAN) NIC to the ELAN subnet.
Contact Center supports two network interface cards (NICs) and two subnets (one contact center
subnet and one ELAN subnet). The Contact Center ELAN NIC and ELAN subnet are optional.

Procedure
1. Locate the slot assigned to the ELAN network interface card for the server.

2. Write the MAC address of the card on a small label. Attach the label to the back of the card
or the chassis slot position.

3. Connect the ELAN subnet from the Avaya equipment to the Ethernet hub.

4. Connect the network cable from the ELAN network interface card in the server to the hub.

5. Plug in the power cord for the hub.

6. If you have an ELAN subnet network connection, use the ping command to test it.

Configuring the binding order
Before you begin

• Install two network interface cards on the Contact Center server.
• Disable the NetBIOS on the ELAN network interface card.
• Connect the Contact Center server network interface card to the contact center subnet.
• Connect the Contact Center server ELAN network interface card to the ELAN subnet.

About this task
Configure the binding order of the network cards. The contact center subnet network interface
card must be bound first and then the ELAN network interface card.

Procedure
1. On the Start screen, select Control Panel  > Network and Internet  > Network and

Sharing Center.
2. Click Change adapter settings.

3. In the Network Connections window, press the ALT key.

A hidden menu appears.

4. Choose Advanced  > Advanced Settings.

5. In the Connections box, ensure that the contact center subnet connection is listed first. If
it is not listed first, adjust the order.
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Disabling Admin Approval Mode for Windows Server
administrators

About this task
Windows Server 2012 implements a security feature known as User Account Control (UAC). By
default, this feature causes applications run by local non built-in administrators to behave as if the
applications had been run by standard users. Perform this procedure to ensure that local
administrators get full privileges for running applications.

Note:
This procedure describes how to disable Admin Approval Mode on the Contact Center server
using one method only; there are additional methods available. For example, you can also
administer User Account Control settings for the Contact Center server using a group policy.

Procedure
1. On the Start screen, select Administrative Tools  > Local Security Policy.

2. Under Security Settings, expand Local Policies.

3. Select Security Options.

4. In the policy pane on the right, double-click on User Account Control: Run all
administrators in Admin Approval Mode.

5. Click the Local Security Setting tab, and select Disabled.

6. Click OK.

If prompted, restart the server.
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Disabling Windows Server 2012 Automatic Maintenance
About this task
Disable Windows Server 2012 R2 Automatic Maintenance while installing Contact Center
software. Windows Server 2012 Automatic Maintenance can occasionally interfere with the real-
time requirements for Contact Center deployment and configuration. You must therefore
temporarily disable Automatic Maintenance to install and configure Contact Center software. You
re-enable Automatic Maintenance after deploying and configuring Contact Center.

Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.

5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows  > TaskScheduler.
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6. In the Name column, right-click Idle Maintenance and select Disable.

7. In the Name column, right-click Regular Maintenance and select Disable.

8. From the File menu, select Exit.

Installing the Voice Contact Server software for CS1000
Before you begin

• Ensure the Avaya Communication Server 1000 is configured. For more information see
Avaya Aura® Contact Center and Avaya Communication Server 1000 Integration.

• Download the most recent Contact Center and Common Components patches to the server.
• Read the Contact Center Release Notes for the most recent instructions.

About this task
Install the Contact Center Voice Contact Server software on the server.

Procedure
1. Insert the Contact Center DVD into the DVD drive of your server.

2. If the installation does not automatically start, double-click Setup.exe.

3. Click Accept to install the Microsoft .NET Framework on the server.

If you are prompted to accept the Microsoft .NET Framework license agreement, click
Accept. If you are prompted to restart the server, click Yes and repeat step 2.

4. Contact Center software installer runs Operating System and hardware checks on the
server. If the installer returns a Fail, the software installation cannot proceed until you
correct the problem. Review any failures returned by the System Readiness Check and
consult Avaya Aura® Contact Center Overview and Specification to determine the actions
to resolve the issue.
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You can ignore warnings if the potential impact to the operation of the contact center is
understood and not applicable.

5. The Contact Center software installer platform and server selection screen appears.

6. In the Select Voice Platform section, select Avaya Communication Server 1000 - AML.

7. In the Select Server Installation Option section, select Voice Contact Server Only.

8. Click Next.
9. Under Journal Database Drive, select the drive for the database journal. The default drive

partition is H:.

10. Under Voice Contact Server Database Drive, select the drive for the Contact Center
Manager Server, Communication Control Toolkit, and Contact Center Manager
Administration databases. The default drive partition is F:.

11. In the Service Packs section, browse to and select the Service Pack.
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12. Click Install.
13. The AVAYA GLOBAL SOFTWARE LICENSE TERMS window appears.

14. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
15. The MICROSOFT SOFTWARE LICENSE TERMS window appears.

16. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
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17. The Progress window appears and displays the installation progress.

18. When the software is installed, you have the following options.

• To continue configuring the server installation data:

a. Select Launch Avaya Aura Contact Center Ignition Wizard.

b. Click Configure. This starts the Avaya Aura® Contact Center Ignition Wizard.

• To defer configuring the server installation data:

a. Clear Launch Avaya Aura Contact Center Ignition Wizard.

b. On the message box, click Yes.

c. On the main installer screen, click Close.

d. Follow the on-screen instructions and shut down the Contact Center server.

You must use the Ignition Wizard to initialize Avaya Aura® Contact Center, otherwise
Avaya Aura® Contact Center is not operational. For more information about the Ignition
Wizard, see the following procedures.

Configuring the RGN Voice Contact Server software for
CS1000

Before you begin
• Ensure the Avaya Communication Server 1000 is configured. For more information see

Avaya Aura® Contact Center and Avaya Communication Server 1000 Integration.
• You must configure the required language and locale of the Contact Center server operating

system, if it is not a Latin-1 language, before configuring the Contact Center server using the
Contact Center Ignition Wizard. For more information about configuring language and locale
settings on the Contact Center server, see Avaya Aura® Contact Center Server
Administration.

• Download the most recent Contact Center and Common Components patches to the server.
• Read the Contact Center Release Notes for the most recent instructions.

About this task
Configure the RGN Contact Center Voice Contact Server software to provide data resiliency and
disaster recovery.

Procedure
1. Log on to the RGN Contact Center server using the Administrator account details.

2. On the Contact Center Ignition Wizard screen, click Next. If the Contact Center Ignition
Wizard is not visible, click the Ignition Wizard shortcut on the desktop.
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3. On the End-User License Agreement screen, read the license agreement. Optionally,
click Print to generate a local soft copy (in OpenXPS Document format) of the license
agreement.

4. Select I Accept the Terms of the End-User License Agreement and click Next.
5. On the Configuration Data window, type the configuration details for each tab.

6. Select the Core tab, and configure the server details.

7. In the Site Name box, type the site name for the Contact Center server. The site name
must not contain spaces or non-alphabetical characters except hyphen (-) and underscore
(_). The first character must be a letter. The site name must be unique and can consist of 6
to 15 characters.

8. In the Real-Time Statistics Multicast IP Address box, type the Real-time Statistics
Multicast IP Address of the server to associate with sending real-time data. The IP
Address must be from 224.0.1.0 to 239.255.255.255. The default is 234.5.6.10.

9. In the Network Configuration section, in the ELAN IP Address box, type the IP Address
of the embedded local area network. The embedded local area network (ELAN) is a
dedicated Ethernet LAN that connects Contact Center to the PABX.
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10. In the CLAN IP Address box, type the IP Address of the Contact Center server. This is the
Contact Center server IP address on the subnet that connects to the other servers and
agent client computers in the contact center solution.

11. In the System Account Configuration section, in the Password box, type a password for
the Contact Center administration account. The password is checked against the server
security policy for minimum password requirements. Avaya recommends that you enter a
password that conforms to your corporate password policy.

12. In the Confirm Password box, type the password.

13. Select the Licensing tab, and configure the licensing details.

14. From the License Type list, select Standard KRS.

15. Click Browse to locate and load your license file.

16. From the Licensing Package list, select the license type that you have purchased. Select
Nodal Enterprise for single-site contact centers.

17. From the list of Optional Packages, enable the licensed features that you have
purchased.

18. Select the Open Queue check box.

19. Select the CS1000 tab.
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20. In the Switch Name box, type the name of the AML Avaya Communication Server 1000
telephone switch. Valid characters for Avaya Communication Server 1000 names are A–Z,
a–z, 0–9, underscore (_), and period (.). Names must begin with an alphabetical character
and cannot contain spaces. The last character must not be an underscore or a period.
Names must not exceed 80 characters in length.

21. In the Switch IP Address box, type the IP address of the Avaya Communication Server
1000.

22. In the Switch Customer Number box, type the customer number for the Avaya
Communication Server 1000.

23. In the Alternative Switch IP Address box, type the IP address of an alternate Avaya
Communication Server 1000, if you have one.

24. In the Alternative Switch Customer Number box, type the customer number of the
alternate Avaya Communication Server 1000, if you have one.

25. In the Alternative Switch Serial ID box, type the serial number of the alternate Avaya
Communication Server 1000, if you have one.

26. In the Voice Connection Type section, select the method used to connect to the PABX.
Select None, Avaya Aura Experience Portal, or CallPilot.

27. If you are using an Avaya CallPilot® server, enter the Avaya CallPilot® server ELAN IP
Address and then configure the Port to 10008.

28. If you are using Avaya CallPilot® High Availability, in the CPHA Managed CLAN IP
Address box, type the Avaya CallPilot® Managed CLAN IP address.

29. If you are using an Avaya CallPilot® server, in the CLAN IP Address box, type the CLAN
IP address of the Avaya CallPilot® server.

30. Select the Security Configuration tab, and configure the security details in the Security
Store Details section.
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31. If you do not want to enable security, select the Skip Security Configuration checkbox
and skip to step 50 on page 234.

Important:

A warning message appears.

32. In the Full Computer Name (FQDN) box, type the full FQDN of the server on which you
are creating the security store.

Important:

The FQDN must be the full machine name of the server that the Security Store resides
on. The FQDN name is case-sensitive.

33. In the Name of Organizational unit box, type the name of the department or division
within the company.

34. In the Name of Organization box, type the company name.

35. In the City or Locality box, type the name of the city or district in which the contact center
is located.

36. In the State or Province box, type the state or province in which the contact center is
located.
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37. In the Two Letter Country Code box, type the country code in which the contact center is
located.

38. In the Security Store password box, type a password for accessing the new security
store.

39. In the Confirm Store password box, confirm the password for accessing the new security
store.

Important:

Ensure you remember this password, because you need it when you log on to Security
Manager after install. If you forget the password, you cannot access Security Manager.

40. If you are implementing High Availability in the contact center, generate the security store
using Subject Alternative Names (SANs). In the Subject Alternative Name section, for
each SAN you want to add:

a. From the Type drop-down list, select DNS.

b. In the Value field, type the FQDN for the server.

c. Click Add.

For a High Availability system, add the current server FQDN and the Managed name for
the HA pair.

41. If you want to change the encryption setting, select the required encryption settings from
the Encryption Algorithm Level and Key Size drop-down lists.

The default value for Encryption Algorithm is SHA256 and the default value for Key Size
is 2048.

Contact Center displays a warning message if you select SHA1 or 1024. Contact Center
includes these values for backward-compatibility only, because these settings do not meet
the industry-recommended level of encryption.

42. Click Create Store.

43. You can now use the Security Configuration tab to create and save a Certificate Signing
Request (CSR) file.
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44. Click Create CSR File.

45. From the Save In drop-down list, select a shared location in which to save the CSR file
and click Save.

You must now send the Certificate Signing Request file to a Certificate Authority and
receive a signed certificate and root certificate to import to the security store.

46. In the Imported Trusted Certificate Authority Root Certificate(s) section, click Add to
import the Certificate Authority root certificate.

47. In the Open dialog box, browse to the location of the certificate and click Open.

48. In the Imported Identity Security Certificate section, click Add to import the Certificate
Authority signed certificate.

49. In the Open dialog box, browse to the location of the certificate and click Open.

50. Click Next.
51. Review and verify the summary information, and click Configure.

52. After the installation is complete, click Finish.

53. If prompted, restart the server.
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Enabling Windows Server 2012 Automatic Maintenance
About this task
Enable Windows Server 2012 R2 Automatic Maintenance after deploying and configuring Contact
Center software.

Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.

5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows > TaskScheduler.

6. In the Name column, right-click Idle Maintenance and select Enable.

7. In the Name column, right-click Regular Maintenance and select Enable.

8. From the File menu, select Exit.

Securing the Windows server
About this task
Apply optional security measures to your operating system to further secure your server.

Important:
Scanning software can degrade the performance and decrease the reliability of the system.
Install virus scanning software only if the system connects to an exposed network or to the
Internet.
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Important:
To maintain server performance, you must schedule virus scans during maintenance periods
or low usage hours only.

Procedure
1. Harden the operating system using defined site procedures.

2. Install antivirus software. If you install antivirus software, Avaya recommends that you
exclude some contact center files and folders from real-time and scheduled scans. For
more information, and for a list of files and folders to exclude, see Avaya Aura® Contact
Center Overview and Specification.

Commissioning the Contact Center server
About this task
Commission the installed Contact Center software.

Procedure
Commission the installed Contact Center software.

For information about commissioning the installed server software, see Avaya Aura® Contact
Center Commissioning for Avaya Communication Server 1000.

RGN Voice Contact Server for CS1000 installation

July 2018 Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000 236
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000


Chapter 14: Multimedia Contact Server
software installation

This chapter describes how to install the Multimedia Contact Server software that enables your
contact center to handle multimedia contacts. Contact Center Multimedia (CCMM) software enables
routing of email (including voice mail, SMS, faxes, and scanned documents), outbound, and Web
communication contacts to appropriate agents based on subject, contact type, or the time that the
contact arrives.

This section describes how to install Multimedia Contact Server software in Avaya Communication
Server 1000 based solutions.

In some small contact center environments, you can install a Voice and Multimedia Contact Server
to process both voice and multimedia contacts. But in large contact center environments, you must
install the Multimedia Contact Server software on a standalone server. Separate servers are also
required for email (MS Exchange for example), Web communication, and some outbound call
processing.

You can use any account with local administrative rights to install Avaya Aura® Contact Center. You
can use any account with local administrative rights to upgrade and patch Avaya Aura® Contact
Center; you do not need to always use the same account to perform these tasks.

Important:

You must disable the Admin Approval Mode security feature on the Contact Center server. This
ensures that accounts with local administrative rights get full privileges for running applications
on the Contact Center server.

You must complete all the procedures in this section in sequential order.

Standby Multimedia Contact Server - High Availability note
Avaya Aura® Contact Center Multimedia Contact Server supports High Availability. To install a
standby Multimedia Contact Server, first use the procedures in this chapter to install a primary active
Multimedia Contact Server, then repeat the procedures in this chapter to install a standby
Multimedia Contact Server.
You can use the procedures in this chapter to install the following:

• Primary active Multimedia Contact Server
• (Optional) Standby Multimedia Contact Server
• (Optional) Remote Geographic Node Multimedia Contact Server

You can install a Multimedia Contact Server and commission it to be the standby Multimedia
Contact Server in a campus High Availability solution. The standby server takes over multimedia
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contact processing and becomes the active server if the existing active Multimedia Contact Server
fails. The standby server provides High Availability redundancy and resiliency. The standby and
active servers must be at the same patch level and have the same hard disk drive partitions.
You can install another standby Multimedia Contact Server and commission it to be the Remote
Geographic Node Multimedia Contact Server in a solution with Disaster Recovery. The Remote
Geographic Node (RGN) server shadows the active server. The Remote Geographic Node server
does not automatically take over if the active server fails. The standby server, Remote Geographic
Node server, and active server must be at the same patch level and have the same hard disk drive
partitions.
The roles and responsibilities of the active, Remote Geographic Node, and standby Multimedia
Contact Servers are defined later during commissioning.

Multimedia Contact Server installation prerequisites
Procedure

• Install a Voice Contact Server to provide the core functionality for this Multimedia Contact
Server.

• If you use email in your contact center, install and configure an inbound email server and an
outbound email server in your network.

• If you use Web communications in your contact center, install and configure a Web server in
your network.

• Ensure that your new Contact Center license file is available.

Downloading the most recent documentation
Before you begin

• Download the most recent version of Acrobat Reader.
• Access the Avaya website at http://support.avaya.com.

About this task
Download the most recent documentation to ensure you have the most recent updates. Updates
in the documentation accurately reflect the most recent changes in the software.

Procedure
1. Log on to the Avaya website.

2. Compare the versions of the documentation on the site with the versions you have.

3. If the version number on http://support.avaya.com is higher than your version, download
the latest version of the document.
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4. Review the Avaya website for release notes and readme files.

Installing Microsoft Windows Server 2012 R2
Before you begin

• Ensure that you have a newly formatted server that meets the specifications in Avaya Aura®

Contact Center Overview and Specification on which to install Microsoft Windows Server
2012 R2.
Do not upgrade your operating system from a previous release. Contact Center is not
supported on an upgraded operating system.

• Configure all servers for RAID as described in Avaya Aura® Contact Center Overview and
Specification.

• Ensure that you have a DVD for Microsoft Windows Server 2012 R2 Standard or Data
Center. Ensure that your DVD is the R2 version of Windows Server 2012 Standard or Data
Center.

• Ensure that you have a Microsoft Windows Server 2012 R2 operating system product key.
• Know the IP addresses for the contact center subnet.

About this task
Install the Microsoft Windows Server 2012 R2 Standard or Data Center operating system and
configure it to support Contact Center server software.
The following table lists the main inputs to consider while installing the operating system.

Name Description
Computer name Do not use spaces or underscores or exceed 15 characters. The name must start

with an alphabetic character. Server names must adhere to RFC1123. Avaya
recommends that you configure the server final production name before installing
Contact Center software.

The computer name must match (including case sensitivity) the DNS name.
Disk drives Format the partitions as required for the server. For more information, see Avaya

Aura® Contact Center Overview and Specification.
Domain name Configure as required for your site.

You must check to ensure the DNS Domain name (including case) matches the
server name if the server is added to a domain after configuration.

Licensing modes Select Per server licensing mode.

Accept the default five concurrent connections.
Network components Configure IP Address, WINS, DNS for one or two network cards as per

configuration. Contact Center does not support IPv6.

Table continues…
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Name Description
Network connections If the server has more than one NIC/adapter, ensure contact center subnet

appears first in the network adapter binding order.
Hard Disk Partitions Configure C: drive to be a primary drive. Configure the other drives on your server

to meet the requirements according to Avaya Aura® Contact Center Overview and
Specification for the server.

Perform this procedure on each server before you install Contact Center server software on the
server.

Procedure
1. Insert the Microsoft Windows Server 2012 R2 Standard or Data Center DVD into the DVD

drive.

2. Turn on the power to the server.

The server begins to boot up.

3. On the Windows Setup screen, select a Language to install from the list.

4. Select a Time and currency format from the list.

5. Select Keyboard or input method from the list.

6. Click Next.
7. Click Install now.

8. Depending on the DVD image that you use, you might need to select an operating system
from a list. Select a version of Windows Server 2012 R2 Standard or Data Center that
includes a Graphical User Interface (GUI). Install a version that includes “(Server with a
GUI)”.

9. Click Next.
10. On the Enter the product key to activate Windows window, enter the operating system

product key.

11. Click Next.
12. On the Windows Setup screen, read the terms of the license agreement and select I

accept the license terms.

13. Click Next.
14. Select Custom: Install Windows only (advanced) to install a clean new installation of the

operating system.

15. Select the disk partition on which you want to install Windows Server 2012 R2.

Important:

You can use the partition management options to configure the partitions on your
server.

16. Click Next.
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The installation proceeds and automatically restarts the server several times.

17. After completing the installation, log on to the server as Administrator. Enter and confirm
the Administrator password.

18. Select Set time zone and complete the information as required for your system.

19. Select Configure Networking and complete the information for your Network Interface
Card (NIC) with the server IP address.

20. Select Provide computer name and domain and complete the information for your server
name and network settings.

21. Change the DVD drive letter to E: to ensure the correct drive letters are free for the
Contact Center application and database hard disk drives and partitions.

22. Configure the hard disk drives and partitions for this server using the Windows Server
2012 R2 Computer Management - Disk Management utility. For more information about
hard disk drives and partitions, see Avaya Aura® Contact Center Overview and
Specification.

23. Install other required drivers for your hardware configuration.

Job aid: Hard disk drive partitions
Configure the hard disk drives and partitions. These are the minimum hard disk partition sizes. For
more information about hard disk requirements, including the recommended partition sizes, see
Avaya Aura® Contact Center Overview and Specification.

For each partition, specify a volume size in MBs that when formatted results in a disk partition that
is equal to or greater than the required minimum partition size.

Hard disk drive Drive letter Minimum size
partition

Operating System drive

Including the 350 MB Windows boot loader System Reserved
partition.

C: 80 GB NTFS

Application drive D: 120 GB NTFS
DVD drive

For continuity and consistency, Avaya recommends using Drive
letter E: for the DVD drive. However, Contact Center supports any
DVD Drive letter, other than the Drive letters listed here for the
hard disk partitions.

E: —

Multimedia Contact Server database drive G: 300 GB NTFS
Database journal H: 100 GB NTFS
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Navigating the Microsoft Windows Server 2012 R2 User
Interface

This section describes how to navigate between the main user interface screens of the Windows
Server 2012 R2 operating system.

The following table describes some of the main Microsoft Windows Server 2012 R2 user interface
screens.

Screen name Description
Start The Start screen contains shortcuts to the main administration interfaces of the

server. If you have an application that you access on a regular basis, you can
add it to the Start screen so that it's more immediately accessible. The Start
screen displays the currently logged on user and provides some basic server log
out and locking functions. This is the operating system default screen.

Apps The Apps screen contains shortcuts to the applications and utilities installed on
the server. The server applications and utilities are grouped into categories.
Third-party vendors and applications can also add custom, vendor or product
specific, categories to the Apps screen.

Desktop The Desktop screen contains the Windows start button, the Windows Taskbar,
Recycle Bin, and shortcuts to the Windows Explorer utility, among others. The
Taskbar displays the Windows Notification Area and System Tray. The
notification area is located on the right portion of the Taskbar next to the time.

Navigation tips:

• Use the up  and down  arrow icons to navigate between the Start and Apps screens.

• To display the Start screen, on the Desktop screen, click the Windows start button.

• To display the Desktop screen, on the Start screen select the Desktop tile.

• To display the Desktop screen, on the Apps screen select the Desktop tile.

• To switch between the Start screen and the Desktop screen press the Windows start button
on your keyboard.

• To access the Control Panel, on the Apps or Start screen click on the Control Panel tile.

• To access the Administration Tools, on the Apps or Start screen click on the Administrative
Tools tile.

These screen navigation methods work when you are using the server’s keyboard and mouse
directly, or when you are using Remote Desktop to access the server.
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Figure 14: Example of the Start screen, with the down arrow icon highlighted in a red box.
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Figure 15: Example of the Apps screen, with the up arrow icon highlighted in a red box.
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Figure 16: Example of the Desktop screen, with the Windows start button highlighted in a red box.

The following table describes some of the Taskbar sections of the Desktop screen.

Icon Name Description
Windows start button Use the Windows start button to navigate to the Start screen. Use this

button to switch between the Start screen and the Desktop screen.

Server Manager Use this button to access the Server Manager to configure the roles and
features to the server.

PowerShell Use the PowerShell button to start the Windows PowerShell console.
Windows PowerShell is a command-line shell that provides cmdlets
(pronounced command-lets) for server configuration and management.
PowerShell also provides scripting functions for task automation.

This PC Use this button to start the This PC Windows Explorer. Use this to
access and navigate the folders, files, and storage devices on the
server.
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The contents of your screens can vary depending on the roles, features, and applications installed
on your server.

For more information about the Windows Server 2012 R2 operating system, refer to the Microsoft
support website and Microsoft product documentation.

Installing the most recent supported operating system
service packs

Before you begin
• Access the Avaya hotfixes list on the website http://support.avaya.com.
• Install and configure Microsoft Windows Server 2012 R2 on your server.
• Review the specifications on operating system service updates in Avaya Aura® Contact

Center Overview and Specification.

About this task
Avaya recommends that you install the most recent supported operating system service packs.
You must download the supported operating system service pack from the Avaya hotfixes list to
ensure your Contact Center server software functions correctly with the supported operating
system patches.

Procedure
1. Review the Contact Center Service Packs Compatibility and Security Hotfixes Applicability

List to determine the most recent Avaya Aura® Contact Center supported patches or
service packs.

2. Download the appropriate Microsoft Windows Server 2012 R2 patches for the Avaya Aura®

Contact Center software installed on this server.

3. Install the most recent Windows Server 2012 R2 service pack that is validated with Avaya
Aura® Contact Center by following the Microsoft Installation instructions.

Connecting to the contact center subnet
About this task
Connect the Contact Center server to the contact center subnet. The contact center subnet is the
network on which the server software applications work together to route contacts and generate
reports.

Procedure
1. Locate the slot assigned to the contact center subnet network interface card for the server.

Make a note of the slot.
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2. Connect the cable from the contact center subnet to the contact center subnet network
interface card in the server in accordance with customer site networking guidelines.

3. Use the ping command to test the contact center subnet.

Adding the server to a domain or workgroup
About this task
Add the server to a domain or workgroup. Avaya recommends that you add the server to the
domain or workgroup before installing Contact Center software.
If you are using a domain:

• Add the server to a Windows domain before installing Contact Center software. When joining
the domain, ensure the server time and domain controller time are synchronized to the same
time.

• On the server, configure a preferred Domain Name System (DNS) server on the Network
Interface Card (NIC).

• Ask your System Administrator to add a Domain Name System (DNS) static entry for this
server. Each Contact Center server in a domain requires a DNS static entry.

Procedure
1. Log on to the server.

2. On the Start screen, select Administrative Tools  > Server Manager.
3. In the left pane, select Local Server.
4. In the right pane, in the Properties section, double-click on the Domain or Workgroup

value.

The System Properties dialog box appears.

5. In the System Properties dialog box, click the Computer Name tab.

6. Click Change.

7. To add the server to a workgroup, skip to step 9.

8. To add the server to a domain, in the Member of dialog box, click the Domain option.

a. Type the domain name (you must provide the fully qualified domain name, which
includes the prefix and suffix).

b. Click OK.

c. Type the domain administrator User name and Password.

d. Click OK.

e. Skip to step 10.
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9. To add the server to a workgroup, in the Member of dialog box, click the Workgroup
option.

a. Type the workgroup name.

b. Click OK.

c. Type the workgroup administrator User name and Password.

d. Click OK.

10. Restart the server when you are prompted to do so.

Downloading the most recent Contact Center patches to
the server

Before you begin
• Download and install the most recent and supported updates for Microsoft Windows Server

2012 R2.
• Know the location at which you plan to install each Contact Center server software package.
• Ensure that you use one administrator account on your server to un-install and install

software updates.

About this task
To ensure that you have the most current software, download the most recent Contact Center
patches from http://support.avaya.com to the server you plan to install.

Procedure
1. Log on to the server using the administrator account.

2. Create a folder <Drive>:\Avaya-ProductUpdates\ to save the software updates. Where
<Drive> is the drive letter on which you want to save the Contact Center software updates.

3. Download the most recent service pack file. Save and unzip the file on the Contact Center
server in the Avaya-ProductUpdates folder.

4. If new patches are available for the latest service pack, download and save the patches on
the Contact Center server in the Avaya-ProductUpdates folder.

5. Read the Contact Center Release Notes for the most recent instructions.
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Disabling unused Network Adapters
About this task
Disable all unused Network Adapters or Network Interface Cards (NICs) to improve network
communications and prevent the erroneous configuration of unused NICs during Contact Center
server commissioning.

Procedure
1. Log on to the server.

2. On the Start screen, select Control Panel  > Network and Internet  > Network and
Sharing Center  > Change adapter settings.

3. Right-click on the unused Network Adapter, and select Disable.

4. Repeat this procedure for all unused Network Adapters.

Enabling Microsoft Remote Desktop connection
About this task
Enable Microsoft Remote Desktop connection as your remote access tool. Microsoft Remote
Desktop provides remote access for support on the server.

Procedure
1. Log on to the server with administrator privileges.

2. On the Start screen, select Control Panel  > System and Security.

3. In the System section, select Allow remote access.

4. Click the Remote tab.

5. Select Allow remote connections to this computer.
6. Click Apply.

7. Click OK.

Disabling Admin Approval Mode for Windows Server
administrators

About this task
Windows Server 2012 implements a security feature known as User Account Control (UAC). By
default, this feature causes applications run by local non built-in administrators to behave as if the
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applications had been run by standard users. Perform this procedure to ensure that local
administrators get full privileges for running applications.

Note:
This procedure describes how to disable Admin Approval Mode on the Contact Center server
using one method only; there are additional methods available. For example, you can also
administer User Account Control settings for the Contact Center server using a group policy.

Procedure
1. On the Start screen, select Administrative Tools  > Local Security Policy.

2. Under Security Settings, expand Local Policies.

3. Select Security Options.

4. In the policy pane on the right, double-click on User Account Control: Run all
administrators in Admin Approval Mode.

5. Click the Local Security Setting tab, and select Disabled.

6. Click OK.

If prompted, restart the server.
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Disabling Windows Server 2012 Automatic Maintenance
About this task
Disable Windows Server 2012 R2 Automatic Maintenance while installing Contact Center
software. Windows Server 2012 Automatic Maintenance can occasionally interfere with the real-
time requirements for Contact Center deployment and configuration. You must therefore
temporarily disable Automatic Maintenance to install and configure Contact Center software. You
re-enable Automatic Maintenance after deploying and configuring Contact Center.

Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.

5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows  > TaskScheduler.

6. In the Name column, right-click Idle Maintenance and select Disable.

7. In the Name column, right-click Regular Maintenance and select Disable.

8. From the File menu, select Exit.

Installing the Multimedia Contact Server software
Before you begin

• Download the most recent Contact Center Multimedia and common component patches to
the server.
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• Empty all temporary folders on the server. To determine the specific temporary folders for a
server, access the DOS prompt and type set. Note the values listed for TEMP and TMP, and
delete all files in those locations.

About this task
Install the Multimedia Contact Server software to provide inbound and outbound voice, email
(including voice mail, SMS, faxes and scanned documents), and Web communications contact
types in your contact center. Multimedia Contact Server also supports Instant Messaging in SIP-
enabled contact centers.

Procedure
1. Insert the Contact Center DVD into the DVD drive of your server.

2. If the installation does not automatically start, double-click Setup.exe.

3. Click Accept to install the Microsoft .NET Framework on the server.

If you are prompted to accept the Microsoft .NET Framework license agreement, click
Accept. If you are prompted to restart the server, click Yes and repeat step 2.

4. Contact Center software installer runs Operating System and hardware checks on the
server. If the installer returns a Fail, the software installation cannot proceed until you
correct the problem. Review any failures returned by the System Readiness Check and
consult Avaya Aura® Contact Center Overview and Specification to determine the actions
to resolve the issue.

You can ignore warnings if the potential impact to the operation of the contact center is
understood and not applicable.

5. The Contact Center software installer platform and server selection screen appears.
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6. Select the type of multimedia server to install:

In an Avaya Communication Server 1000 (CS1000) based solution, in the Select Voice
Platform section, select Avaya Communication Server 1000 - AML.

In a SIP-enabled solution, in the Select Voice Platform section, select Avaya Aura - SIP.

7. In the Select Server Installation Option section, select Multimedia Contact Server
Only.

8. Click Next.
9. Under Journal Database Drive, select the drive for the database journal.

10. Under Multimedia Contact Server Database Drive, select the drive for the Contact
Center Multimedia database.

11. In the Service Packs section, browse to and select the Service Pack.
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12. Click Install.
13. The AVAYA GLOBAL SOFTWARE LICENSE TERMS window appears.

14. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
15. The MICROSOFT SOFTWARE LICENSE TERMS window appears.

16. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
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17. The Progress window appears and displays the installation progress.

18. When the software is installed, you have the following options.

• To continue configuring the server installation data:

a. Select Launch Avaya Aura Contact Center Ignition Wizard.

b. Click Configure. This starts the Avaya Aura® Contact Center Ignition Wizard.

• To defer configuring the server installation data:

a. Clear Launch Avaya Aura Contact Center Ignition Wizard.

b. On the message box, click Yes.

c. On the main installer screen, click Close.

d. Follow the on-screen instructions and shut down the Contact Center server.

You must use the Ignition Wizard to initialize Avaya Aura® Contact Center, otherwise
Avaya Aura® Contact Center is not operational. For more information about the Ignition
Wizard, see the following procedure.

Configuring the Multimedia Contact Server software
Before you begin

• Ensure the Avaya Aura® Unified Communications platform is configured. For more
information see Avaya Aura® Contact Center and Avaya Aura® Unified Communications
Integration.

• You must configure the required language and locale of the Contact Center server operating
system, if it is not a Latin-1 language, before configuring the Contact Center server using the
Contact Center Ignition Wizard. For more information about configuring language and locale
settings on the Contact Center server, see Avaya Aura® Contact Center Server
Administration.

• Read the Contact Center Release Notes for the most recent instructions.

About this task
Configure the Contact Center Multimedia Contact Server software to provide inbound and
outbound voice, email (including voice mail, SMS, faxes and scanned documents), and Web
communications contact types in your contact center.

Procedure
1. Log on to the Contact Center server using the Administrator account details.

2. On the Contact Center Ignition Wizard screen, click Next. If the Contact Center Ignition
Wizard is not visible, click the Ignition Wizard shortcut on the desktop.

3. On the End-User License Agreement screen, read the license agreement. Optionally,
click Print to generate a local soft copy (in OpenXPS Document format) of the license
agreement.
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4. Select I Accept the Terms of the End-User License Agreement and click Next.
5. On the Configuration Data window, type the configuration details for each tab.

6. Select the Multimedia tab, and configure the Contact Center Multimedia details.

7. In the Incoming Mail Server box, type the name of the server on which email messages
are received in your network.

8. From the Protocol list, select the communication protocol for the inbound email server.
Select POP3 or IMAP. The default protocol is POP3.

9. In the Outgoing Mail Server box, type the name of the server from on which email
messages are sent. Your inbound and outbound mail servers can have the same name.

10. Select the Voice Server tab.
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11. In the IP Address box, type the IP address for the Contact Center Voice Contact Server.

12. Select the Security Configuration tab, and configure the security details in the Security
Store Details section.
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13. If you do not want to enable security, select the Skip Security Configuration checkbox
and skip to step 32 on page 260.

Important:

A warning message appears. If you proceed without enabling security, you cannot fully
commission your solution. For example, in SIP-enabled contact centers that use Voice,
the SIP CTI link is disabled until you configure Contact Center TLS certificates to
communicate securely with Application Enablement Services.

14. In the Full Computer Name (FQDN) box, type the full FQDN of the server on which you
are creating the security store.

Important:

The FQDN must be the full machine name of the server that the Security Store resides
on. The FQDN name is case-sensitive.

15. In the Name of Organizational unit box, type the name of the department or division
within the company.

16. In the Name of Organization box, type the company name.

17. In the City or Locality box, type the name of the city or district in which the contact center
is located.

Multimedia Contact Server software installation

July 2018 Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000 258
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000


18. In the State or Province box, type the state or province in which the contact center is
located.

19. In the Two Letter Country Code box, type the country code in which the contact center is
located.

20. In the Security Store password box, type a password for accessing the new security
store.

21. In the Confirm Store password box, confirm the password for accessing the new security
store.

Important:

Ensure you remember this password, because you need it when you log on to Security
Manager after install. If you forget the password, you cannot access Security Manager.

22. If you are implementing High Availability in the contact center, generate the security store
using Subject Alternative Names (SANs). In the Subject Alternative Name section, for
each SAN you want to add:

a. From the Type drop-down list, select DNS.

b. In the Value field, type the FQDN for the server.

c. Click Add.

For a High Availability system, add the current server FQDN and the Managed name for
the HA pair.

23. If you want to change the encryption setting, select the required encryption settings from
the Encryption Algorithm Level and Key Size drop-down lists.

The default value for Encryption Algorithm is SHA256 and the default value for Key Size
is 2048.

Contact Center displays a warning message if you select SHA1 or 1024. Contact Center
includes these values for backward-compatibility only, because these settings do not meet
the industry-recommended level of encryption.

24. Click Create Store.

25. You can now use the Security Configuration tab to create and save a Certificate Signing
Request (CSR) file.
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26. Click Create CSR File.

27. From the Save In drop-down list, select a shared location in which to save the CSR file
and click Save.

You must now send the Certificate Signing Request file to a Certificate Authority and
receive a signed certificate and root certificate to import to the security store.

28. In the Imported Trusted Certificate Authority Root Certificate(s) section, click Add to
import the Certificate Authority root certificate.

29. In the Open dialog box, browse to the location of the certificate and click Open.

30. In the Imported Identity Security Certificate section, click Add to import the Certificate
Authority signed certificate.

31. In the Open dialog box, browse to the location of the certificate and click Open.

32. Click Next.
33. Review and verify the summary information, and click Configure.

34. If prompted, restart the server.
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Enabling Windows Server 2012 Automatic Maintenance
About this task
Enable Windows Server 2012 R2 Automatic Maintenance after deploying and configuring Contact
Center software.

Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.

5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows > TaskScheduler.

6. In the Name column, right-click Idle Maintenance and select Enable.

7. In the Name column, right-click Regular Maintenance and select Enable.

8. From the File menu, select Exit.

Securing the Windows server
About this task
Apply optional security measures to your operating system to further secure your server.

Important:
Scanning software can degrade the performance and decrease the reliability of the system.
Install virus scanning software only if the system connects to an exposed network or to the
Internet.
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Important:
To maintain server performance, you must schedule virus scans during maintenance periods
or low usage hours only.

Procedure
1. Harden the operating system using defined site procedures.

2. Install antivirus software. If you install antivirus software, Avaya recommends that you
exclude some contact center files and folders from real-time and scheduled scans. For
more information, and for a list of files and folders to exclude, see Avaya Aura® Contact
Center Overview and Specification.

Installing the external Web communication server software
Before you begin

• Install Contact Center Multimedia software.

About this task
If you use Web communications in your contact center, you can use the Sample Customer
Interface (CI) website implementation to help you develop pages for your corporate website. The
Web services architecture is a platform-independent interface that customers can access from
both Microsoft .NET and Java applications. Customer websites or third-party applications use the
open interface for integration with the Contact Center Multimedia system.
The Customer Interface Web services provide a range of methods to perform the following
functions:

• Register new customers in the Contact Center Multimedia database
• Log on or log off existing customers
• Update customer logon credentials
• Create customer contacts
• Update customer details
• Read customer information
• Review a customer contact history
• Request immediate or scheduled callback requests
• Read a contact
• Create and maintain a Web communications chat session

To integrate Web Communications with the Contact Center Multimedia system, download the
Avaya Aura® Contact Center Web Communications SDK package and Reference Implementation
from www.avaya.com/devconnect. The Web Communications Reference Implementation contains
information about customizing the Web communication application to your solution.

Multimedia Contact Server software installation

July 2018 Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000 262
Comments on this document? infodev@avaya.com

http://www.avaya.com/devconnect
mailto:infodev@avaya.com?subject=Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000


Important:
Do not install the Web Communications Reference Implementation on an Avaya Aura®

Contact Center server. Install the Web Communications Reference Implementation on your
own server in the contact center solution.

Procedure
1. Locate and download the Web Communications Reference Implementation software from 

www.avaya.com/devconnect.

2. Copy the Web Communications Reference Implementation software to the external Web
server.

3. Follow the Reference Implementation instructions to install and commission the Web
Communications server.

Commissioning the Contact Center server
About this task
Commission the installed Contact Center software.

Procedure
Commission the installed Contact Center software.

For information about commissioning the installed server software, see Avaya Aura® Contact
Center Commissioning for Avaya Communication Server 1000.
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Part 2: Network Control Center
Server
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Chapter 15: Network Control Center Server
software installation

This chapter describes how to install the Network Control Center Server software on a network. The
Network Control Center (NCC) server is required when servers in multiple Contact Center Manager
Server sites are networked and operate as a single distributed contact center.

A Network Control Center Server includes the following server software:

• Contact Center Manager Server — Network Control Center (NCC)

• Contact Center License Manager (LM)

• Contact Center Manager Administration (CCMA)

Install this server to add networking, network skill-based routing, and consolidated reporting support
for a number of Voice and Multimedia Contact Servers operating as a single distributed contact
center. Use this server to configure contact routing between the Voice and Multimedia Contact
Server nodes of a distributed contact center solution.

Avaya Aura® Contact Center supports networked calls between AML-based and SIP-enabled nodes.
The Network Control Center (NCC) software must be the most recent release, relative to the other
nodes on the network. For example, in a network with Avaya Aura® Contact Center Release 7.0 and
Release 6.4 nodes, the NCC must be Release 7.0. All nodes in the network must be Avaya Aura®

Contact Center Release 6.4 or more recent.

All nodes in an Avaya Aura® Contact Center networking deployment, including the Network Control
Center server, must be installed on operating systems from the same language family. Contact
Center Manager Administration does not support displaying names from two different languages
families. For example, a single Contact Center Manager Administration does not support one node
with French and another node with Russian.

You must complete all the procedures in this section in sequential order.

Network Control Center Server software installation
prerequisites

Procedure
Ensure that your new Contact Center license file is available.
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Downloading the most recent documentation
Before you begin

• Download the most recent version of Acrobat Reader.
• Access the Avaya website at http://support.avaya.com.

About this task
Download the most recent documentation to ensure you have the most recent updates. Updates
in the documentation accurately reflect the most recent changes in the software.

Procedure
1. Log on to the Avaya website.

2. Compare the versions of the documentation on the site with the versions you have.

3. If the version number on http://support.avaya.com is higher than your version, download
the latest version of the document.

4. Review the Avaya website for release notes and readme files.

Installing Microsoft Windows Server 2012 R2
Before you begin

• Ensure that you have a newly formatted server that meets the specifications in Avaya Aura®

Contact Center Overview and Specification on which to install Microsoft Windows Server
2012 R2.
Do not upgrade your operating system from a previous release. Contact Center is not
supported on an upgraded operating system.

• Configure all servers for RAID as described in Avaya Aura® Contact Center Overview and
Specification.

• Ensure that you have a DVD for Microsoft Windows Server 2012 R2 Standard or Data
Center. Ensure that your DVD is the R2 version of Windows Server 2012 Standard or Data
Center.

• Ensure that you have a Microsoft Windows Server 2012 R2 operating system product key.
• Know the IP addresses for the contact center subnet.

About this task
Install the Microsoft Windows Server 2012 R2 Standard or Data Center operating system and
configure it to support Contact Center server software.
The following table lists the main inputs to consider while installing the operating system.
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Name Description
Computer name Do not use spaces or underscores or exceed 15 characters. The name must start

with an alphabetic character. Server names must adhere to RFC1123. Avaya
recommends that you configure the server final production name before installing
Contact Center software.

The computer name must match (including case sensitivity) the DNS name.
Disk drives Format the partitions as required for the server. For more information, see Avaya

Aura® Contact Center Overview and Specification.
Domain name Configure as required for your site.

You must check to ensure the DNS Domain name (including case) matches the
server name if the server is added to a domain after configuration.

Licensing modes Select Per server licensing mode.

Accept the default five concurrent connections.
Network components Configure IP Address, WINS, DNS for one or two network cards as per

configuration. Contact Center does not support IPv6.
Network connections If the server has more than one NIC/adapter, ensure contact center subnet

appears first in the network adapter binding order.
Hard Disk Partitions Configure C: drive to be a primary drive. Configure the other drives on your server

to meet the requirements according to Avaya Aura® Contact Center Overview and
Specification for the server.

Perform this procedure on each server before you install Contact Center server software on the
server.

Procedure
1. Insert the Microsoft Windows Server 2012 R2 Standard or Data Center DVD into the DVD

drive.

2. Turn on the power to the server.

The server begins to boot up.

3. On the Windows Setup screen, select a Language to install from the list.

4. Select a Time and currency format from the list.

5. Select Keyboard or input method from the list.

6. Click Next.
7. Click Install now.

8. Depending on the DVD image that you use, you might need to select an operating system
from a list. Select a version of Windows Server 2012 R2 Standard or Data Center that
includes a Graphical User Interface (GUI). Install a version that includes “(Server with a
GUI)”.

9. Click Next.
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10. On the Enter the product key to activate Windows window, enter the operating system
product key.

11. Click Next.
12. On the Windows Setup screen, read the terms of the license agreement and select I

accept the license terms.

13. Click Next.
14. Select Custom: Install Windows only (advanced) to install a clean new installation of the

operating system.

15. Select the disk partition on which you want to install Windows Server 2012 R2.

Important:

You can use the partition management options to configure the partitions on your
server.

16. Click Next.

The installation proceeds and automatically restarts the server several times.

17. After completing the installation, log on to the server as Administrator. Enter and confirm
the Administrator password.

18. Select Set time zone and complete the information as required for your system.

19. Select Configure Networking and complete the information for your Network Interface
Card (NIC) with the server IP address.

20. Select Provide computer name and domain and complete the information for your server
name and network settings.

21. Change the DVD drive letter to E: to ensure the correct drive letters are free for the
Contact Center application and database hard disk drives and partitions.

22. Configure the hard disk drives and partitions for this server using the Windows Server
2012 R2 Computer Management - Disk Management utility. For more information about
hard disk drives and partitions, see Avaya Aura® Contact Center Overview and
Specification.

23. Install other required drivers for your hardware configuration.

Job aid: Hard disk drive partitions
Configure the hard disk drives and partitions. These are the minimum hard disk partition sizes. For
more information about hard disk requirements, including the recommended partition sizes, see
Avaya Aura® Contact Center Overview and Specification.

For each partition, specify a volume size in MBs that when formatted results in a disk partition that
is equal to or greater than the required minimum partition size.
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Hard disk drive Drive letter Minimum size
partition

Operating System drive

Including the 350 MB Windows boot loader System Reserved
partition.

C: 80 GB NTFS

Application drive D: 120 GB NTFS
DVD drive

For continuity and consistency, Avaya recommends using Drive
letter E: for the DVD drive. However, Contact Center supports any
DVD Drive letter, other than the Drive letters listed here for the
hard disk partitions.

E: —

Voice Contact Server database drive F: 200 GB NTFS
Database journal H: 100 GB NTFS

Navigating the Microsoft Windows Server 2012 R2 User
Interface

This section describes how to navigate between the main user interface screens of the Windows
Server 2012 R2 operating system.

The following table describes some of the main Microsoft Windows Server 2012 R2 user interface
screens.

Screen name Description
Start The Start screen contains shortcuts to the main administration interfaces of the

server. If you have an application that you access on a regular basis, you can
add it to the Start screen so that it's more immediately accessible. The Start
screen displays the currently logged on user and provides some basic server log
out and locking functions. This is the operating system default screen.

Apps The Apps screen contains shortcuts to the applications and utilities installed on
the server. The server applications and utilities are grouped into categories.
Third-party vendors and applications can also add custom, vendor or product
specific, categories to the Apps screen.

Desktop The Desktop screen contains the Windows start button, the Windows Taskbar,
Recycle Bin, and shortcuts to the Windows Explorer utility, among others. The
Taskbar displays the Windows Notification Area and System Tray. The
notification area is located on the right portion of the Taskbar next to the time.

Navigation tips:

• Use the up  and down  arrow icons to navigate between the Start and Apps screens.

• To display the Start screen, on the Desktop screen, click the Windows start button.
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• To display the Desktop screen, on the Start screen select the Desktop tile.

• To display the Desktop screen, on the Apps screen select the Desktop tile.

• To switch between the Start screen and the Desktop screen press the Windows start button
on your keyboard.

• To access the Control Panel, on the Apps or Start screen click on the Control Panel tile.

• To access the Administration Tools, on the Apps or Start screen click on the Administrative
Tools tile.

These screen navigation methods work when you are using the server’s keyboard and mouse
directly, or when you are using Remote Desktop to access the server.

Figure 17: Example of the Start screen, with the down arrow icon highlighted in a red box.
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Figure 18: Example of the Apps screen, with the up arrow icon highlighted in a red box.
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Figure 19: Example of the Desktop screen, with the Windows start button highlighted in a red box.

The following table describes some of the Taskbar sections of the Desktop screen.

Icon Name Description
Windows start button Use the Windows start button to navigate to the Start screen. Use this

button to switch between the Start screen and the Desktop screen.

Server Manager Use this button to access the Server Manager to configure the roles and
features to the server.

PowerShell Use the PowerShell button to start the Windows PowerShell console.
Windows PowerShell is a command-line shell that provides cmdlets
(pronounced command-lets) for server configuration and management.
PowerShell also provides scripting functions for task automation.

This PC Use this button to start the This PC Windows Explorer. Use this to
access and navigate the folders, files, and storage devices on the
server.
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The contents of your screens can vary depending on the roles, features, and applications installed
on your server.

For more information about the Windows Server 2012 R2 operating system, refer to the Microsoft
support website and Microsoft product documentation.

Installing the most recent supported operating system
service packs

Before you begin
• Access the Avaya hotfixes list on the website http://support.avaya.com.
• Install and configure Microsoft Windows Server 2012 R2 on your server.
• Review the specifications on operating system service updates in Avaya Aura® Contact

Center Overview and Specification.

About this task
Avaya recommends that you install the most recent supported operating system service packs.
You must download the supported operating system service pack from the Avaya hotfixes list to
ensure your Contact Center server software functions correctly with the supported operating
system patches.

Procedure
1. Review the Contact Center Service Packs Compatibility and Security Hotfixes Applicability

List to determine the most recent Avaya Aura® Contact Center supported patches or
service packs.

2. Download the appropriate Microsoft Windows Server 2012 R2 patches for the Avaya Aura®

Contact Center software installed on this server.

3. Install the most recent Windows Server 2012 R2 service pack that is validated with Avaya
Aura® Contact Center by following the Microsoft Installation instructions.

Connecting to the contact center subnet
About this task
Connect the Contact Center server to the contact center subnet. The contact center subnet is the
network on which the server software applications work together to route contacts and generate
reports.

Procedure
1. Locate the slot assigned to the contact center subnet network interface card for the server.

Make a note of the slot.
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2. Connect the cable from the contact center subnet to the contact center subnet network
interface card in the server in accordance with customer site networking guidelines.

3. Use the ping command to test the contact center subnet.

Adding a server to a domain
Before you begin

• Ensure that you have domain administrator privileges, or ask the Domain Administrator to
assign you a domain user account for remote access.

• On the server, configure a preferred Domain Name System (DNS) server on the Network
Interface Card (NIC).

About this task
Add the server to an existing domain.

Note:
Add the server to a Windows domain before installing Contact Center software. When joining
the domain, ensure the server time and domain controller time are synchronized to the same
time.

Ask your System Administrator to add a Domain Name System (DNS) static entry for this server.
Each Contact Center server in a domain requires a DNS static entry.
If your solution is going to use High Availability, ask your System Administrator to add one DNS
static entry for each managed name and associated managed IP address. A typical High
Availability campus solution with a pair of servers requires three DNS static entries; one DNS
static entry for the active server, one DNS static entry for the standby server, and one DNS static
entry for the managed name and associated IP address. Avaya Aura® Contact Center High
Availability solutions do not support Windows Server Dynamic DNS.

Procedure
1. Log on to the server.

2. On the Start screen, select Administrative Tools  > Server Manager.
3. In the left pane, select Local Server.
4. In the right pane, in the Properties section, double-click on the Domain value.

The System Properties dialog box appears.

5. In the System Properties dialog box, click the Computer Name tab.

6. Click Change.

7. In the Member of section, click the Domain option.

8. Type the domain name (you must provide the fully qualified domain name, which includes
the prefix and suffix).
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9. Click OK.

10. Type the domain administrator User name and Password.

11. Click OK.

12. Restart the server when you are prompted to do so.

Downloading the most recent Contact Center patches to
the server

Before you begin
• Download and install the most recent and supported updates for Microsoft Windows Server

2012 R2.
• Know the location at which you plan to install each Contact Center server software package.
• Ensure that you use one administrator account on your server to un-install and install

software updates.

About this task
To ensure that you have the most current software, download the most recent Contact Center
patches from http://support.avaya.com to the server you plan to install.

Procedure
1. Log on to the server using the administrator account.

2. Create a folder <Drive>:\Avaya-ProductUpdates\ to save the software updates. Where
<Drive> is the drive letter on which you want to save the Contact Center software updates.

3. Download the most recent service pack file. Save and unzip the file on the Contact Center
server in the Avaya-ProductUpdates folder.

4. If new patches are available for the latest service pack, download and save the patches on
the Contact Center server in the Avaya-ProductUpdates folder.

5. Read the Contact Center Release Notes for the most recent instructions.

Disabling unused Network Adapters
About this task
Disable all unused Network Adapters or Network Interface Cards (NICs) to improve network
communications and prevent the erroneous configuration of unused NICs during Contact Center
server commissioning.
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Procedure
1. Log on to the server.

2. On the Start screen, select Control Panel  > Network and Internet  > Network and
Sharing Center  > Change adapter settings.

3. Right-click on the unused Network Adapter, and select Disable.

4. Repeat this procedure for all unused Network Adapters.

Enabling Microsoft Remote Desktop connection
About this task
Enable Microsoft Remote Desktop connection as your remote access tool. Microsoft Remote
Desktop provides remote access for support on the server.

Procedure
1. Log on to the server with administrator privileges.

2. On the Start screen, select Control Panel  > System and Security.

3. In the System section, select Allow remote access.

4. Click the Remote tab.

5. Select Allow remote connections to this computer.
6. Click Apply.

7. Click OK.

Disabling Admin Approval Mode for Windows Server
administrators

About this task
Windows Server 2012 implements a security feature known as User Account Control (UAC). By
default, this feature causes applications run by local non built-in administrators to behave as if the
applications had been run by standard users. Perform this procedure to ensure that local
administrators get full privileges for running applications.

Note:
This procedure describes how to disable Admin Approval Mode on the Contact Center server
using one method only; there are additional methods available. For example, you can also
administer User Account Control settings for the Contact Center server using a group policy.
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Procedure
1. On the Start screen, select Administrative Tools  > Local Security Policy.

2. Under Security Settings, expand Local Policies.

3. Select Security Options.

4. In the policy pane on the right, double-click on User Account Control: Run all
administrators in Admin Approval Mode.

5. Click the Local Security Setting tab, and select Disabled.

6. Click OK.

If prompted, restart the server.

Disabling Windows Server 2012 Automatic Maintenance
About this task
Disable Windows Server 2012 R2 Automatic Maintenance while installing Contact Center
software. Windows Server 2012 Automatic Maintenance can occasionally interfere with the real-
time requirements for Contact Center deployment and configuration. You must therefore
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temporarily disable Automatic Maintenance to install and configure Contact Center software. You
re-enable Automatic Maintenance after deploying and configuring Contact Center.

Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.

5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows  > TaskScheduler.

6. In the Name column, right-click Idle Maintenance and select Disable.

7. In the Name column, right-click Regular Maintenance and select Disable.

8. From the File menu, select Exit.

Installing the Network Control Center Server software
Before you begin

• If you install Network Control Center server software with an AML Avaya Communication
Server 1000, ensure the PABX is configured. See Avaya Aura® Contact Center and Avaya
Communication Server 1000 Integration.

• If you install Network Control Center server software with an Avaya Aura® Unified
Communications platform, ensure the platform is configured. See Avaya Aura® Contact
Center and Avaya Aura® Unified Communications Integration.

• Download the most recent Network Control Center patches to the server.
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About this task
Install the Network Control Center server software to enable your contact center to route contacts
to available agents with the correct skills.

Procedure
1. Insert the Contact Center DVD into the DVD drive of your server.

2. If the installation does not automatically start, double-click Setup.exe.

3. Click Accept to install the Microsoft .NET Framework on the server.

If you are prompted to accept the Microsoft .NET Framework license agreement, click
Accept. If you are prompted to restart the server, click Yes and repeat step 2.

4. Contact Center software installer runs Operating System and hardware checks on the
server. If the installer returns a Fail, the software installation cannot proceed until you
correct the problem. Review any failures returned by the System Readiness Check and
consult Avaya Aura® Contact Center Overview and Specification to determine the actions
to resolve the issue.

You can ignore warnings if the potential impact to the operation of the contact center is
understood and not applicable.

5. The Contact Center software installer platform and server selection screen appears.

6. Select the type of Network Control Center server to install:

In an Avaya Communication Server 1000 (CS1000) based solution, in the Select Voice
Platform section, select Avaya Communication Server 1000 - AML.
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In a SIP-enabled solution, in the Select Voice Platform section, select Avaya Aura - SIP.

7. In the Select Server Installation Option section, select Network Control Center Server
Only.

8. Click Next.
9. Under Journal Database Drive, select the drive for the database journal.

10. Under Voice Contact Server Database Drive, select the drive for the database.

11. In the Service Packs section, browse to and select the Service Pack.

12. Click Install.
13. The AVAYA GLOBAL SOFTWARE LICENSE TERMS window appears.

14. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.
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• To print the license terms, click Print.
15. The MICROSOFT SOFTWARE LICENSE TERMS window appears.

16. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
17. The Progress window appears and displays the installation progress.

18. When the software is installed, you have the following options.

• To continue configuring the server installation data:

a. Select Launch Avaya Aura Contact Center Ignition Wizard.

b. Click Configure. This starts the Avaya Aura® Contact Center Ignition Wizard.

• To defer configuring the server installation data:

a. Clear Launch Avaya Aura Contact Center Ignition Wizard.

b. On the message box, click Yes.

c. On the main installer screen, click Close.

d. Follow the on-screen instructions and shut down the Contact Center server.

You must use the Ignition Wizard to initialize Avaya Aura® Contact Center, otherwise
Avaya Aura® Contact Center is not operational. For more information about the Ignition
Wizard, see the following procedures.

Configuring the Network Control Center Server software
Before you begin

• If you install Network Control Center server software with an AML Avaya Communication
Server 1000, ensure the PABX is configured. See Avaya Aura® Contact Center and Avaya
Communication Server 1000 Integration.

• If you install Network Control Center server software with an Avaya Aura® Unified
Communications platform, ensure the platform is configured. See Avaya Aura® Contact
Center and Avaya Aura® Unified Communications Integration.

• You must configure the required language and locale of the Contact Center server operating
system, if it is not a Latin-1 language, before configuring the Contact Center server using the
Contact Center Ignition Wizard. For more information about configuring language and locale
settings on the Contact Center server, see Avaya Aura® Contact Center Server
Administration.
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• Download the most recent Network Control Center patches to the server.

About this task
Configure the Network Control Center server software to enable your contact center to route
contacts to available agents with the correct skills.

Procedure
1. Log on to the Contact Center server using the Administrator account details.

2. On the Contact Center Ignition Wizard screen, click Next. If the Contact Center Ignition
Wizard is not visible, click the Ignition Wizard shortcut on the desktop.

3. On the End-User License Agreement screen, read the license agreement. Optionally,
click Print to generate a local soft copy (in OpenXPS Document format) of the license
agreement.

4. Select I Accept the Terms of the End-User License Agreement and click Next.
5. On the Configuration Data window, type the configuration details for each tab.

6. Select the Core tab, and configure the server details.

7. In the Site Name box, type the site name for the Contact Center server. The site name
must not contain spaces or non-alphabetical characters except hyphen (-) and underscore

Network Control Center Server software installation

July 2018 Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000 282
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000


(_). The first character must be a letter. The site name must be unique and can consist of 6
to 15 characters.

8. In the System Account Configuration section, in the Password box, type a password for
the Contact Center administration account. The password is not checked against the
server security policy for minimum password requirements. Avaya recommends that you
enter a password that conforms to your corporate password policy.

9. In the Confirm Password box, type the password.

10. Select the Licensing tab, and configure the licensing details.

11. From the License Type drop-down list, select Standard KRS.

12. Click Browse to locate and load your license file.

13. From the Licensing Package list, select the license type that you have purchased. Select
Nodal NCC for single-site contact centers. Select Corporate NCC for multi-site contact
centers.

14. From the list of Optional Packages, enable the licensed features that you have
purchased.

15. Select the Security Configuration tab, and configure the security details in the Security
Store Details section.
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16. If you do not want to enable security, select the Skip Security Configuration checkbox
and skip to step 35 on page 286.

Important:

A warning message appears. If you proceed without enabling security, you cannot fully
commission your solution. For example, in SIP-enabled contact centers that use Voice,
the SIP CTI link is disabled until you configure Contact Center TLS certificates to
communicate securely with Application Enablement Services.

17. In the Full Computer Name (FQDN) box, type the full FQDN of the server on which you
are creating the security store.

Important:

The FQDN must be the full machine name of the server that the Security Store resides
on. The FQDN name is case-sensitive.

18. In the Name of Organizational unit box, type the name of the department or division
within the company.

19. In the Name of Organization box, type the company name.

20. In the City or Locality box, type the name of the city or district in which the contact center
is located.
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21. In the State or Province box, type the state or province in which the contact center is
located.

22. In the Two Letter Country Code box, type the country code in which the contact center is
located.

23. In the Security Store password box, type a password for accessing the new security
store.

24. In the Confirm Store password box, confirm the password for accessing the new security
store.

Important:

Ensure you remember this password, because you need it when you log on to Security
Manager after install. If you forget the password, you cannot access Security Manager.

25. If you are implementing High Availability in the contact center, generate the security store
using Subject Alternative Names (SANs). In the Subject Alternative Name section, for
each SAN you want to add:

a. From the Type drop-down list, select DNS.

b. In the Value field, type the FQDN for the server.

c. Click Add.

For a High Availability system, add the current server FQDN and the Managed name for
the HA pair.

26. If you want to change the encryption setting, select the required encryption settings from
the Encryption Algorithm Level and Key Size drop-down lists.

The default value for Encryption Algorithm is SHA256 and the default value for Key Size
is 2048.

Contact Center displays a warning message if you select SHA1 or 1024. Contact Center
includes these values for backward-compatibility only, because these settings do not meet
the industry-recommended level of encryption.

27. Click Create Store.

28. You can now use the Security Configuration tab to create and save a Certificate Signing
Request (CSR) file.
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29. Click Create CSR File.

30. From the Save In drop-down list, select a shared location in which to save the CSR file
and click Save.

You must now send the Certificate Signing Request file to a Certificate Authority and
receive a signed certificate and root certificate to import to the security store.

31. In the Imported Trusted Certificate Authority Root Certificate(s) section, click Add to
import the Certificate Authority root certificate.

32. In the Open dialog box, browse to the location of the certificate and click Open.

33. In the Imported Identity Security Certificate section, click Add to import the Certificate
Authority signed certificate.

34. In the Open dialog box, browse to the location of the certificate and click Open.

35. Click Next.
36. Review and verify the summary information, and click Configure.

37. After the installation is complete, click Finish.

38. If prompted, restart the server.
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Enabling Windows Server 2012 Automatic Maintenance
About this task
Enable Windows Server 2012 R2 Automatic Maintenance after deploying and configuring Contact
Center software.

Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.

5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows > TaskScheduler.

6. In the Name column, right-click Idle Maintenance and select Enable.

7. In the Name column, right-click Regular Maintenance and select Enable.

8. From the File menu, select Exit.

Securing the Windows server
About this task
Apply optional security measures to your operating system to further secure your server.

Important:
Scanning software can degrade the performance and decrease the reliability of the system.
Install virus scanning software only if the system connects to an exposed network or to the
Internet.
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Important:
To maintain server performance, you must schedule virus scans during maintenance periods
or low usage hours only.

Procedure
1. Harden the operating system using defined site procedures.

2. Install antivirus software. If you install antivirus software, Avaya recommends that you
exclude some contact center files and folders from real-time and scheduled scans. For
more information, and for a list of files and folders to exclude, see Avaya Aura® Contact
Center Overview and Specification.

Network Control Center Server software installation

July 2018 Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000 288
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Aura® Contact Center DVD for Avaya Communication Server 1000


Part 3: Client Software installation
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Chapter 16: Agent Desktop client software
installation

This chapter describes how to install the Agent Desktop client software on each client computer in
your contact center. The Agent Desktop enables agents to handle contacts of all media types
enabled in your contact center from the start to the end of a contact. The Agent Desktop is part of
the Avaya Aura® Contact Center solution.

You install the Agent Desktop client application on the client computers. Download the client
software from the server by accessing a Web location on the server.

You must complete the procedures in this section in sequential order.

Agent Desktop client software installation prerequisites
Procedure

• Install Voice and Multimedia Contact Server software or Multimedia Contact Server software.

• Install one of the supported operating systems for Agent Desktop on the client computer.

• Install Internet Explorer.

Installing the Agent Desktop software prerequisites
About this task
Install the prerequisites for Agent Desktop client software. You must have administrator privileges
to install Agent Desktop prerequisites.

Procedure
1. Log on to the client computer using administrator privileges.

2. On the client computer, start Internet Explorer.

3. In the Address box, type http://<servername>/agentdesktop.

Where servername is the name of the server on which the Contact Center Multimedia
server software is installed.
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4. On the Agent Desktop page, click Install Prerequisites.

The client downloads the .NET Framework and C++ software from the server and installs
the application on the client.

Note:

Different client PC operating systems use different versions of MSI installer.
Information about the different versions of MSI is available at http://
www.microsoft.com/en-us/download/details.aspx?id=8483.

Installing the Agent Desktop client software
Before you begin

• Ensure that you have installed the prerequisites required for the Agent Desktop client
software. For more information, see Installing the Agent Desktop software prerequisites on
page 290.

About this task
Install the Agent Desktop client software on each client computer for which an agent logs on to
handle contacts using the softphone and multimedia toolbar.

Procedure
1. On the client computer, start Internet Explorer.

2. In the Address box, type http://<servername>/agentdesktop.

Where servername is the name of the server on which the Contact Center Multimedia
server software is installed.

Note:

The Agent Desktop installer does not use a secure HTTPS connection, even if Web
Services security is turned on.

3. Click Launch.

4. On the Application Install - Security Warning message box, click Install.

Installing the Agent Desktop client software
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Chapter 17: Agent Desktop client software
silent installation

This chapter describes how to install the Avaya Agent Desktop client software silently on each client
computer in your contact center. Contact Center agents use Agent Desktop software to handle
customer voice and multimedia contacts.

Note:

The Agent Desktop MSI installation package includes an integrated softphone. SIP-enabled
Contact Center supports this Agent Desktop integrated softphone. AML-based Contact Center
does not support this Agent Desktop integrated softphone. For AML-based solutions, when
installing Agent Desktop using the MSI file, disable the softphone option.

Agents can use Avaya one-X® Communicator coresident with Agent Desktop if you disable the
integrated softphone. If you plan for all agents to use Avaya one-X® Communicator, disable the
softphone option.

Installing software prerequisites for an Agent Desktop
silent install

Before you begin
• Download the most recent Service Pack and patches from the Avaya support website, http://

support.avaya.com.

About this task
Install the software prerequisites for Avaya Agent Desktop, so that you can install Agent Desktop
silently.
You can use the Windows Add\Remove programs utility to uninstall the Agent Desktop software
prerequisites.

Procedure
1. Log on to the Contact Center server using administrator privileges.

2. Browse to <Drive>:\Avaya-ProductUpdates\Install Software\CCMM
\AvayaCC_CCMM_<XXX>\AAAD Prerequisites, where <Drive> is the drive containing
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the most recent Service Pack, and <XXX> is the version number of the latest Service
Pack.

3. Copy the prerequisites folder to a location from which you can copy it to the client
computer.

For example, copy the AAAD Prerequisites folder to a USB memory stick or network
location.

4. Log on to the client computer using administrator privileges.

5. Copy the prerequisites folder to the client computer.

6. Install Microsoft .NET Framework 4.5.2. When you install Microsoft .NET Framework 4.5.2,
you also get .NET Framework 4.0 and 4.5.

7. Install Windows Installer 4.5 Redistributable.

8. Install Microsoft Visual C++ 2005 SP1 Redistributable Package ATL Security Update.

9. Install Microsoft Visual C++ 2008 SP1 Redistributable Package x86.

Installing Agent Desktop client software silently
Before you begin

• Download the most recent Service Pack and patches from the Avaya support website, http://
support.avaya.com.

About this task
Install Avaya Agent Desktop client software silently to install the software as a desktop application
with an All Users profile. This allows all agents that can log on to the client computer to run Agent
Desktop software. By default, the Agent Desktop software installs in the Program Files folder.

Note:
The Agent Desktop MSI installation package includes an integrated softphone. SIP-enabled
Contact Center supports this Agent Desktop integrated softphone. AML-based Contact Center
does not support this Agent Desktop integrated softphone. For AML-based solutions, when
installing Agent Desktop using the MSI file, disable the softphone option.
Agents can use Avaya one-X® Communicator coresident with Agent Desktop if you disable the
integrated softphone. If you plan for all agents to use Avaya one-X® Communicator, disable
the softphone option.

You can use the Windows Add\Remove programs utility to uninstall the Agent Desktop software.

Procedure
1. Log on to the Contact Center server using administrator privileges.

Installing Agent Desktop client software silently
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2. Browse to <Application Drive>:\Avaya\Contact Center\Multimedia Server
\Agent Desktop\Client\, where <Application Drive> is the drive on which you
installed the Contact Center software. By default, this is the D: drive.

3. Copy the AvayaAgentDesktopClient.msi installation file to a USB memory stick or
network location.

4. Log on to the client computer using administrator privileges.

5. Copy the AvayaAgentDesktopClient.msi installation file to the client computer.

6. Open a command prompt by clicking Start > All Programs > Run. Type cmd and press
Enter.

7. Use the Microsoft Windows Installer program (msiexec.exe) to install the software. For
example:

C:\AAAD>msiexec.exe /package AvayaAgentDesktopClient.msi /
quiet /log "products.log”  AAADSOFTPHONE=0
MMSERVERNAME=MyCCMMServer AAADUSEHTTPS=FALSE
Where:

• AAADSOFTPHONE — This parameter enables or disables the Agent Desktop
integrated softphone installation. For AML-based solutions, set this parameter to 0. For
SIP-enabled solutions, set this parameter to 1 to install the integrated softphone, or 0
not to install the integrated softphone.

• MMSERVERNAME — This parameter configures the name of the Contact Center
Multimedia (CCMM) server that the Agent Desktop application communicates with. This
parameter can be an IP Address or a server name.    

• AAADUSEHTTPS — This binary parameter (TRUE or FALSE) configures Agent
Desktop to communicate with the CCMM server using Hypertext Transfer Protocol
Secure (HTTPS). The default value is FALSE, do not use HTTPS.       

The Agent Desktop software installs silently.

8. Close the command prompt window.

Agent Desktop client software silent installation
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Chapter 18: Agent Desktop client software
installation using Remote
Desktop Services

This chapter describes how to use Remote Desktop Services on a Windows Server 2012 R2 server
to host and publish Agent Desktop.

Agent Desktop client software installation using Remote
Desktop Services prerequisites

Procedure
• Install the required Contact Center server software.
• Install and commission one or more Agent Desktop clients to confirm Agent Desktop

functionality.
• Deploy and integrate Windows Server 2012 Remote Desktop Services servers in your

solution. Deploy a RD Connection Broker, a RD Web Access, and a RD Session Host co-
resident or standalone.

• Install Agent Desktop software on the RD Session Host server, using the Agent Desktop MSI
installation package. Ensure that you disable the softphone option. For more information
about installing Agent Desktop using MSI installation package, see Agent Desktop client
software silent installation on page 292.

• Review the Agent Desktop client requirements for deployment using Remote Desktop
Services. See Avaya Aura® Contact Center Overview and Specification.

Publishing Agent Desktop client software using Remote
Desktop Services

About this task
Remote Desktop Services, formerly known as Terminal Services, allows a server to host multiple
simultaneous client sessions. In the Remote Desktop Services (RDS) environment, an application
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runs entirely on the Remote Desktop Session Host (RD Session Host) server. The RDS client
performs no local processing of application software.
Follow the procedure below to publish Agent Desktop client software using Remote Desktop
Services.

Procedure
1. Configure CCMM to support Agent Desktop on a Windows 2012 R2 operating system:

a. Log on to CCMA.

b. On the Launchpad, click Multimedia.

c. In the left pane, select the server to which you want to log on.

d. Click Launch Multimedia Client.
e. In the left column, select Agent Desktop Configuration.

f. Click User Settings.

g. Select Suppress OS not supported popup.

h. Click Save.

2. Log on to the RDS Session Host server with administrative privileges.

3. Using the Server Manager – Remote Desktop Services utility, select Collections >
QuickSessioncollection.

4. In the REMOTEAPP PROGRAMS section, from the TASKS drop-down list, select Publish
RemoteApp Programs.

5. From the RemoteApp Programs list, select Avaya Agent Desktop 7.0.

6. Click Next.
7. Click Publish.

8. From the REMOTEAPP PROGRAMS list, right-click Agent Desktop and select
Properties.

9. Configure the agent, user, and user group accounts to access the Agent Desktop
RemoteApp.

10. Log on to an agent client computer.

11. Use Internet Explorer to access the RD Web Access Interface. For example, access the
RD Web Access Interface using the following URL:

https://<RDS Server FQDN>/RDWeb
12. On the Work Resources page, enter the Windows domain account details for the agent

and click Sign in.

The web interface lists the RemoteApps available to the agent.

13. In the Current folder section, double-click Agent Desktop.

14. Log on to Agent Desktop and Go Ready.

Agent Desktop client software installation using Remote Desktop Services
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15. Verify that the Agent Desktop RemoteApp can handle routed customer calls, and continue
to verify the features your solution requires.

Next steps
Using the Server Manager Performance and Best Practice Analyzer, continue to monitor all the
resources of the RDS host servers, focusing on CPU, memory, and disk drive resources. Capture
the initial CPU and memory usage as baseline performance metrics.

Publishing Agent Desktop client software using Remote Desktop Services
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Chapter 19: Client software installation in a
Citrix deployment

This chapter describes how to configure and publish Avaya Aura® Contact Center software
applications in a Citrix deployment.

Client software installation prerequisites
Procedure

• Install the required Contact Center server software.

• Ensure that you have administrative privileges on the client.

• Install one of the supported operating systems on the client computer.

• Install Internet Explorer.

• If the contact center PABX is not an Avaya Communication Server 1000, on the contact
center domain create a Windows OU that contains all the agents’ desktop computers.

Publishing Agent Desktop client software on a Citrix
server

Before you begin
• Using the Agent Desktop MSI installer, install Agent Desktop on the Citrix server. For more

information about the MSI installer, see Agent Desktop client software silent installation on
page 292.

About this task
You can launch Agent Desktop client software on a client computer using a Citrix server. You must
configure your Citrix server to publish Agent Desktop as a published application before you can
launch Agent Desktop software on client computers. Publish Agent Desktop client software on a
Citrix Server by following the procedure below.
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Note:
The following example uses Citrix XenApp 6.5.

Procedure
1. On your Citrix server, open Citrix AppCenter.

2. In the left pane, right-click Applications and click Publish Application.

3. On the Name window, in the Display name box, type a name for the new published
application. For example, type Agent Desktop.

4. In the Application description box, type a description for the new published application.

5. Click Next.
6. On the Type window, under Application type, select Accessed from a server.

7. Click Next.
8. On the Location window, click Browse.

9. Navigate to the location on the Citrix server where the Agent Desktop client folder is
installed.

10. Select the CCAD.exe file and click OK.

Publishing Agent Desktop client software on a Citrix server
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11. Click Next.
12. On the Servers window, click Add.

13. On the Select Servers dialog box, select the Citrix server used to run the Agent Desktop
application and click Add.

14. Click OK.

15. Click Next.
16. On the Users window, click Add.

17. On the Select Users or Groups dialog box, select the users allowed to run the published
application. For example, select your Contact Center agents and click Add.

Client software installation in a Citrix deployment
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18. Click OK.

19. Click Next.
20. On the Shortcut presentation window you can select from a number of shortcut options

for display on the browser.

Note:

The Agent Desktop icon appears by default as an icon. You can also choose to create
a client application folder on each client computer that contains all published
applications, or add shortcuts to the client’s Start menu or desktop.

Publishing Agent Desktop client software on a Citrix server
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21. Click Next.
22. On the Publish immediately window, select Configure advanced application settings

now and click Next.
23. Continue clicking Next until the Limits window appears.

24. Select Allow only one instance of application for each user.

Client software installation in a Citrix deployment
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25. Click Next.
26. Click Finish.

27. On the client computer, agents can now launch Agent Desktop using one of the configured
shortcuts.

Publishing Contact Center Manager Administration on a
Citrix server as content

Before you begin
• Install a Voice and Multimedia Contact Server or Voice Contact Server.

About this task
You can access the Contact Center Manager Administration application on a client computer using
a Citrix server. You must configure your Citrix server to publish CCMA as published content.

Procedure
1. On your Citrix server, open Citrix AppCenter.

2. In the left pane, right-click Applications and click Publish Application.

3. On the Name window, in the Display name box, type a name for the new published
application. For example, type ccma.

Publishing Contact Center Manager Administration on a Citrix server as content
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4. In the Application description box, type a description for the new published application.

5. Click Next.
6. On the Type window, under Choose the type of application to publish, select Content.
7. Click Next.
8. On the Location window, type the Contact Center Manager Administration URL. For

example, type

http://<server name>
where <server name> is the name of the server CCMA is installed on.

9. Click Next.
10. On the Users window, select Allow only configured users.

11. Select Citrix User Selector as the directory type.

12. Click Add.

13. On the Select Users or Groups dialog box, select the users allowed to run the published
application. For example, select your Contact Center administrators and click Add.

14. Click OK.

15. Click Next.

Client software installation in a Citrix deployment
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16. Click Next.
17. Click Finish.

18. On the client computer, authorized users can now access CCMA using the Citrix client.

Publishing Contact Center Manager Administration on a
Citrix server as an installed application

Before you begin
• Install a Voice and Multimedia Contact Server or Voice Contact Server.

About this task
You can access the Contact Center Manager Administration application on a client computer using
a Citrix server. You must configure your Citrix server to publish CCMA as an installed application.

Procedure
1. On your Citrix server, open Citrix AppCenter.

2. In the left pane, right-click Applications and click Publish Application.

3. On the Name window, in the Display name box, type a name for the new published
application. For example, type ccma.

4. In the Application description box, type a description for the new published application.

5. Click Next.
6. On the Type window, under Choose the type of application to publish, select

Application.

7. Under Application Type, select Accessed from a server.

Publishing Contact Center Manager Administration on a Citrix server as an installed application
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8. Click Next.
9. On the Location window, click Browse.

10. Navigate to the location on the Citrix server of the Internet Explorer executable. For
example, navigate to C:\Program Files (x86)\Internet Explorer\iexplore.exe.

11. Ensure the location appears within quotation marks, and type the Contact Center Manager
Administration URL after the location. For example, type

“C:\Program Files (x86)\Internet Explorer\iexplore.exe” http://
<server name>
where <server name> is the name of the server CCMA is installed on.

12. Click Next.
13. On the Servers window, click Add.

14. On the Select Servers dialog box, select the Citrix server used to run the CCMA
application and click Add.

15. Click OK.

16. Click Next.
17. Click Next.
18. On the Users window, select Allow only configured users.

19. Select Citrix User Selector as the directory type.

Client software installation in a Citrix deployment
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20. Click Add.

21. On the Select Users or Groups dialog box, select the users allowed to run the published
application. For example, select your Contact Center administrators and click Add.

22. Click OK.

23. Click Next.
24. Click Next.
25. Click Finish.

26. On the client computer, authorized users can now access CCMA using the Citrix client.

Publishing Agent Desktop Displays client software on a
Citrix server

Before you begin
• Install Agent Desktop Displays (ADD) client software on the Citrix server. The Agent Desktop

Displays client folder is located on the server where CCMA is installed at D:\Avaya
\Contact Center\Manager Administration\Apps\ADD. For more information, see 
Installing Display client software on page 311.

Publishing Agent Desktop Displays client software on a Citrix server
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About this task
You can launch Agent Desktop Displays client software on a client computer using a Citrix server.
You must configure your Citrix server to publish ADD as a published application before you can
launch Agent Desktop Displays software on client computers. Publish Agent Desktop Displays
client software on a Citrix Server by following the procedure below.

Note:
The following example uses Citrix XenApp 6.5.

Procedure
1. On your Citrix server, open Citrix AppCenter.

2. In the left pane, right-click Applications and click Publish Application.

3. On the Name window, in the Display name box, type a name for the new published
application. For example, type ADD.

4. In the Application description box, type a description for the new published application.

5. Click Next.
6. On the Type window, under Application type, select Accessed from a server.

7. Click Next.
8. On the Location window, click Browse.

Client software installation in a Citrix deployment
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9. Navigate to the location on the Citrix server where Agent Desktop Displays is installed, for
example C:\Program Files (x86)\Avaya\ADD\.

10. Select the ADDTabular.exe file and click OK.

11. Click Next.
12. On the Servers window, click Add.

13. On the Select Servers dialog box, select the Citrix server used to run the ADD application
and click Add.

14. Click OK.

15. Click Next.
16. On the Users window, click Add.

17. On the Select Users or Groups dialog box, select the users allowed to run the published
application. For example, select your Contact Center administrators and click Add.

18. Click OK.

19. Click Next.
20. Click Next.
21. On the Publish immediately window, select Configure advanced application settings

now and click Next.
22. Continue clicking Next until the Limits window appears.

23. Select Allow only one instance of application for each user.

Publishing Agent Desktop Displays client software on a Citrix server
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24. Click Next.
25. Click Finish.

26. On the client computer, authorized users can now launch Agent Desktop Displays using
the Citrix client.

Client software installation in a Citrix deployment
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Chapter 20: Agent Desktop Displays
software installation

This chapter describes how to prepare and install the Agent Desktop Displays software on each
client in your Avaya Aura® Contact Center. The Agent Desktop Displays application provides real-
time skillset monitoring on agent desktops for supervisors or contact center agents.

Prerequisites to Agent Desktop Displays software
installation

Procedure
• Install a Voice and Multimedia Contact Server or a Multimedia Contact Server with a Voice

Contact Server.
• Ensure that you have administrative privileges on the client.
• Ensure that one of the supported operating systems for Agent Desktop Displays is installed

on the client. The supported operating systems are as follows:

- Windows 7
- Windows 8.1
- Windows 10

Installing Agent Desktop Display client software
Before you begin

• Configure a shared network directory on the Contact Center Manager Administration server.
• If you install Agent Desktop Displays on a Contact Center Manager Administration server that

uses proxy settings for Internet Explorer, for Agent Desktop Displays to function, ensure that
the proxy settings exception list includes the full computer name and IP address of the
Contact Center Manager Administration server.

• The IP multicast addresses that you select for Real-time Statistics Multicast (RSM) sending
and receiving must be within the 224.0.1.0 to 239.255.255.255 range. Ask your network
administrator for acceptable IP multicast addresses for your network.
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About this task
Install Agent Desktop Display software to provide skillset monitoring to Contact Center Manager
Server agents.
You can install both the standard English version and the multilanguage support version of the
Agent Desktop Display client software.

Procedure
1. Log on to the client PC with administrator privileges.

2. Browse to the shared network directory on the Contact Center Manager Administration
server at <install directory>: \Avaya\Contact Center\Manager
Administration\Apps\ADD\ADD Client.

OR

Insert the Contact Center DVD into the DVD drive of the client PC and browse to Install
Software, CCMA, Agent Desktop Displays Client

3. Double-click setup.exe.

4. In the Agent Desktop Displays - InstallShield Wizard dialog box, from the list, select the
language in which to install Agent Desktop Display.

5. Click OK.

6. In the Welcome to the InstallShield Wizard for Agent Desktop Displays dialog box,
click Next.

7. In the Customer Information dialog box, in the User name box, type a user name.

8. In the Organization name box, type your company name.

9. Select Anyone who uses this computer (all users).
10. Click Next.
11. In the Setup Type dialog box, select Complete to install all Agent Desktop Display

components in the default directory.

12. Click Next.
13. In the Ready to Install the Program dialog box, click Install.
14. If a Files in Use dialog box appears, click Retry.

15. In the Server Configuration dialog box, in Contact Center Manager Administration:
Active box, type the IP address or host name of the active Contact Center Manager
Administration server.

If Avaya Aura® Contact Center is configured for High Availability, enter the Managed IP
address for the Avaya Aura® Contact Center server with Contact Center Manager
Administration software installed.

16. In the Active Port box, type the port number for the active Contact Center Manager
Administration server.

Agent Desktop Displays software installation
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17. In the Contact Center Manager Server: Active box, type the IP address or host name of
the active Contact Center Manager Server.

If Avaya Aura® Contact Center is configured for High Availability, enter the Managed IP
address for the Avaya Aura® Contact Center server with Contact Center Manager Server
software installed.

18. If you install a standby Contact Center Manager Administration server, in the Contact
Center Manager Administration: Standby box, type the IP address or host name of the
standby Contact Center Manager Administration server.

If Avaya Aura® Contact Center is configured for High Availability, enter the Managed IP
address for the Avaya Aura® Contact Center server with Contact Center Manager
Administration software installed.

19. In the Standby Port box, type the port number for the standby Contact Center Manager
Administration server.

20. If you install a standby Contact Center Manager Server, in the Contact Center Manager
Server: Standby box, type the IP address or host name of the standby Contact Center
Manager Server.

If Avaya Aura® Contact Center is configured for High Availability, enter the Managed IP
address for the Avaya Aura® Contact Center server with Contact Center Manager Server
software installed.

21. Select the Active Contact Center Manager Administration server check box.

22. Select the Active Contact Center Manager Server server check box.

23. Click Save.

24. In the InstallShield Wizard Completed dialog box, click Finish.

Installing Agent Desktop Display client software
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Chapter 21: Orchestration Designer client
software installation

This chapter describes how to install the Orchestration Designer software on a client computer so
that you can create flows for routing voice and multimedia contacts in an offline mode to minimize
disruption within your Avaya Aura® Contact Center.

The Orchestration Designer software is also installed on the Voice and Multimedia Contact Server,
or on the Voice Contact Server, and you can use an offline mode to create scripts.

Installing the Orchestration Designer client software
Before you begin

• Ensure that you have enough free disk space on the C drive. See Avaya Aura® Contact
Center Overview and Specification.

About this task
Install the Orchestration Designer software on a client to allow your administrator to create scripts
for routing calls offline. You can then import the new scripts into your contact center when the new
scripts are tested and validated.

Procedure
1. From the client computer, log on to Contact Center Manager Administration.

Contact Center Manager Administration (CCMA) displays the date and time of your last
login and also the number of failed login attempts before a successful login.

2. On the Launchpad, click Scripting.

3. Select Orchestration Designer  > Launch Orchestration Designer.

Install any additional software, if a window opens with an installation request.

A VBScript window opens.

4. Click OK.

5. Click Run.

Follow the on-screen instructions to complete the Orchestration Designer client software
install.
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Chapter 22: Avaya Communication Server
1000 Data Extraction Tool
installation

This chapter describes how to install the Avaya Aura® Contact Center Avaya Communication Server
1000 Data Extraction Tool software. The CS 1000 Data Extraction Tool is a software application that
extracts information about resources such as Terminal Numbers (TNs), voice ports, Controlled
Directory Numbers (CDNs), Interactive Voice Response Automatic Call Distribution DNs (IVR ACD-
DNs), and routes from an Avaya Communication Server 1000 PABX. The tool saves this information
in Excel spreadsheets.

You can install the Avaya Communication Server 1000 Data Extraction Tool on a client PC or on the
Contact Center Manager Administration server.

Avaya Communication Server 1000 Data Extraction Tool
software installation prerequisites

Procedure
• Ensure that your client computer meet all requirements. For more information, see Avaya

Aura® Contact Center Overview and Specification.

• Install Microsoft Excel 97 or later on the client computer.

Installing the Avaya Communication Server 1000 Data
Extraction Tool software

About this task
Install the Avaya Communication Server 1000 Data Extraction Tool to allow an administrator to
extract information about resources such as Terminal Numbers (TNs), voice ports, Controlled
Directory Numbers (CDNs), Interactive Voice Response Automatic Call Distribution DNs (IVR
ACD-DNs), and routes from the Avaya Communication Server 1000.
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Procedure
1. Insert the Contact Center DVD into the DVD drive and browse to Install Software, CCMA,

CS1000 Data Extraction Tool.
2. Double-click CS1000 Data Extraction Tool.msi.
3. On the Welcome dialog box, click Next.
4. On the Destination Folder dialog box, click Next to accept the default folder for the Avaya

Communication Server 1000 Data Extraction Tool.

OR

Click Change to choose a new location.

5. On the Ready to Install the Program dialog box, click Install.
6. On the InstallShield Wizard Completed dialog box, click Finish.

Avaya Communication Server 1000 Data Extraction Tool installation
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Part 4: Software uninstall
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Chapter 23: Server software uninstallation

Remove any Avaya Aura® Contact Center server software from your server to prepare to move the
software component to another network server.

Caution:

Before you uninstall an Avaya Aura® Contact Center application, backup that application's
database. Avaya recommends that you backup application databases to a remote secure
network location.

Prerequisites for server software uninstallation
Procedure
Ensure that you have the uninstaller on the server or that you have the Contact Center server
installation DVD in the DVD drive.

Disabling Windows Server 2012 Automatic Maintenance
About this task
Disable Windows Server 2012 R2 Automatic Maintenance while uninstalling Contact Center
software. Windows Server 2012 Automatic Maintenance can occasionally interfere with the real-
time requirements for Contact Center. You must therefore temporarily disable Automatic
Maintenance to uninstall Contact Center software. You re-enable Automatic Maintenance after
uninstalling Contact Center.

Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.

5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows  > TaskScheduler.
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6. In the Name column, right-click Idle Maintenance and select Disable.

7. In the Name column, right-click Regular Maintenance and select Disable.

8. From the File menu, select Exit.

Removing the server software patches
Before you begin

• Ensure that you know the most recent patch.
• Temporarily stop Microsoft Windows Server 2012 Automatic Maintenance. For more

information, see Disabling Windows Server 2012 Automatic Maintenance on page 318.

About this task
Remove the most recent patches to ensure that you have your base software remaining to
remove.

Procedure
1. On the Apps screen, in the Avaya section, select Update Manager.
2. On the Avaya Contact Center Update Manager dialog box, click Remove.

3. Click Select all.
4. Click Remove Patch(es).
5. Click Remove.

6. Click Close.

7. Restart the server.

Next steps
Re-enable Microsoft Windows Server 2012 Automatic Maintenance. For more information, see 
Enabling Windows Server 2012 Automatic Maintenance  on page 321.

Removing the server software patches
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Removing the server software
Before you begin

• Remove all patches for the server software you want to remove.
• To maintain the database, ensure that you back up the database to another network location.
• Temporarily stop Microsoft Windows Server 2012 Automatic Maintenance. For more

information, see Disabling Windows Server 2012 Automatic Maintenance on page 318.

About this task
Remove all or parts of the server software to remove the software applications and corresponding
databases from the server.
You can remove the server software with the un-installer on the server or with the setup.exe file on
your Contact Center DVD.

Procedure
1. Log on to the Contact Center server.

2. Navigate to the following folder:

C:\Program Files (x86)\Avaya\UniversalInstaller
3. Double-click on UniversalInstall.

4. On the Select Remove Option window, select Remove All Avaya Contact Center
Server Software.

5. Click Next.
6. Follow the on-screen instructions.

7. If you are prompted, restart the server.

Next steps
Re-enable Microsoft Windows Server 2012 Automatic Maintenance. For more information, see 
Enabling Windows Server 2012 Automatic Maintenance  on page 321.

Removing the Multimedia Contact Server software
Before you begin

• To maintain the database, ensure that you back up the database to another network location.
• Temporarily stop Microsoft Windows Server 2012 Automatic Maintenance. For more

information, see Disabling Windows Server 2012 Automatic Maintenance on page 318.

About this task
To increase the number of active agents in your contact center solution, backup the Multimedia
database and then remove the co-resident Multimedia Contact Server software from this server. If

Server software uninstallation
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you remove the co-resident Multimedia Contact Server software, you must install a standalone
Multimedia Contact Server Only server in this solution.

Procedure
1. Log on to the Contact Center server.

2. Navigate to the following folder:

C:\Program Files (x86)\Avaya\UniversalInstaller
3. Double-click on UniversalInstall.

4. On the Select Remove Option window, select Remove Multimedia Contact Server
Software.

5. Click Next.
6. Follow the on-screen instructions.

7. If you are prompted, restart the server.

Next steps
Re-enable Microsoft Windows Server 2012 Automatic Maintenance. For more information, see 
Enabling Windows Server 2012 Automatic Maintenance  on page 321.

Enabling Windows Server 2012 Automatic Maintenance
About this task
Enable Windows Server 2012 R2 Automatic Maintenance after uninstalling Contact Center
software.

Procedure
1. Log on to the Contact Center server as Administrator.

2. On the Desktop screen, right-click Start and select Run.

3. In the Run text box, type Taskschd.msc.

4. Click OK.

5. On the Task Scheduler window, in the left pane, select Task Scheduler Library >
Microsoft > Windows > TaskScheduler.

6. In the Name column, right-click Idle Maintenance and select Enable.

Enabling Windows Server 2012 Automatic Maintenance
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7. In the Name column, right-click Regular Maintenance and select Enable.

8. From the File menu, select Exit.

Server software uninstallation
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Chapter 24: Client Software uninstallation

Remove any Avaya Aura® Contact Center client software from your client computer. In High
Availability (HA) solutions, you must uninstall the Agent Desktop client software downloaded directly
from the original server. You must then install the Agent Desktop client software from the Managed
IP or Managed Name of the Voice and Multimedia Contact Server or the Multimedia Contact Server
HA pair.

Removing the Agent Desktop client software
About this task
Remove Agent Desktop client software from a client computer. The software uninstall is completed
using the Windows Control Panel.

Note:
This example procedure is performed on a Windows 7 client.

Procedure
1. Log on to the Agent Desktop client computer.

2. Click the Start icon and select Control Panel.
3. Under Programs, click Uninstall a program.

4. From the Name list, select Avaya Agent Desktop and click Uninstall/Change.

5. On the Avaya Agent Desktop box, ensure Remove the application from this computer
is selected and click OK.

Removing the Agent Desktop Displays software
About this task
Remove Agent Desktop Displays software from a client computer. The software uninstall is
completed using the Windows Control Panel.
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Note:
This example procedure is performed on a Windows 7 client.

Procedure
1. Log on to the client computer.

2. Click the Start icon and select Control Panel.
3. Under Programs, click Uninstall a program.

4. From the Name list, select Agent Desktop Displays and click Uninstall.
5. Click Yes.

Removing the Orchestration Designer client software
About this task
Remove Orchestration Designer software from a client computer. The software uninstall is
completed using the Windows Control Panel.

Important:
Local data is preserved in Orchestration Designer after the Orchestration Designer software is
removed. If you reinstall Orchestration Designer software on the client computer, your
previous local data is available.

Note:
This example procedure is performed on a Windows 7 client.

Procedure
1. Log on to the client computer.

2. Click the Start icon and select Control Panel.
3. Under Programs, click Uninstall a program.

4. From the Name list, select Orchestration Designer - Contact Center Client and click
Uninstall.

5. Click Yes.

Client Software uninstallation
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